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About this guide

Purpose
The Applied Biosystems™ ViiA™ 7 Real-Time PCR System User Guide provides
reference information for the ViiA™ 7 Instrument. The guide describes how to prepare,
maintain, and troubleshoot a ViiA™ 7 System that is running QuantStudio™ Real-Time
PCR Software v1.6.1.

Audience

This user guide is written for laboratory staff who operate and maintain the ViA™ 7
System.

Assumptions

This guide assumes that your ViiA™ 7 Real-Time PCR System has been installed by a
Thermo Fisher Scientific service representative.

This guide also assumes that you have:
* Familiarity with Microsoft™ Windows™ operating system.
* Knowledge of techniques for handling and preparing DNA samples for PCR.
* A general understanding of data storage, file transfers, and copying and pasting.
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Getting started

Access the Help system by pressing F1, by clicking in the toolbar of the
QuantStudio™ Real-Time PCR Software v1.6.1 window, or by selecting
Help » Contents and Index.

About the ViiA™ 7 system

The Applied Biosystems™ ViiA™ 7 Real-Time PCR System uses fluorescent-based
polymerase chain reaction (PCR) reagents to provide:

¢ Quantitative research detection of target nucleic acid sequences (targets) using
real-time analysis.

¢ Qualitative research detection of targets using post-PCR (endpoint) analysis.

¢ Qualitative analysis of the PCR product (achieved by melt curve analysis that
occurs post-PCR).

Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security 11



Chapter 1 Getting started
About the VIIA™ 7 system

About data collection

The ViiA™ 7 Real-Time PCR System collects raw fluorescence data at different points
during a PCR, depending on the type of run that the instrument performs:

Run type Data collection point

Real-time runs The instrument collects data following each extension
e Standard curve step of the PCR.

* Relative standard curve

* Comparative C; (AACy)

* Melting curve

Post-PCR (endpoint) runs 1. Before the PCR. (For presence/absence experiments,
* Genotyping data collection before the PCR is optional, but
recommended.)

2. (Optional) During the PCR. The instrument can
collect data during the run (realtime); collecting data
during the run can be helpful for troubleshooting.

3. After the PCR.

* Presence/absence

Regardless of the run type, a data collection point, or read, on the ViiA"™ 7 Real-Time
PCR System consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission - The instrument optics collect the residual fluorescence emitted from
the wells of the reaction plate. The resulting image that is collected by the
device consists only of light that corresponds to the range of emission
wavelengths.

3. Collection - The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The QuantStudio™ Real-Time
PCR Software stores the raw fluorescent image for analysis.

After a run, the QuantStudio™ Real-Time PCR Software uses calibration data (RO,
background, uniformity, dye, and normalization) to determine the location and
intensity of the fluorescent signals in each read, the dye associated with each
fluorescent signal, and the significance of the signal.

12 Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security



Instrument filters and supported dyes

System dyes

Chapter 1 Getting started
About the ViIA™ 7 system

The ViiA"™ 7 Real-Time PCR System features a six-color filter set that supports all
Thermo Fisher Scientific dyes. The following figure shows the emission spectrum for
each dye, and the filter at which each dye is read.

x1-m1 x2-m2 x3-m3 x4-m4 x5-m5 x6-m6

Wavelength
(nm)

Emission
Spectra

Filters

00 ©O ©

() x1-m1 — FAM™, SYBR" Green
(@ x2-m2 — vIC™
(® x3-m3 — ABY™, NED", TAMRA™

(@ x4-m4 — JUN™, ROX™
(®) x5-m5 — Cy®5, MUSTANG PURPLE™

Filter wavelength (nm)[']
Peak filter Color Factory-calibrated dyes
Excitation Emission
x1-m1 Blue 470 + 15 520 + 15 FAM™, SYBR™ Green
x2-m2 Green 520 + 10 558 + 12 vic™
x3-m3 Yellow 550 + 10 587 + 10 NED", TAMRA™, ABY™
x4-m4 Orange 580 + 10 623 + 14 ROX™, JUN™
x5-m5 Red 640 + 10 682 + 14 MUSTANG gURPLE ’
Cy"5

x6-m6 Deep-Red 662 + 10 711 £ 12 None [2

' The central wavelengths are the optimized wavelengths.

[ This filter set currently does not support any dyes supplied by Thermo Fisher Scientific.

Custom dyes

The ViiA™ 7 Real-Time PCR System can run assays that are designed with custom
dyes (dyes that are not supplied by Thermo Fisher Scientific) that are excited
between 455 nm to 672 nm and read between 505 nm to 723 nm.

Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security 13



Chapter 1 Getting started
Specifications and layout

Specifications and layout

ViiA™ 7 Real-Time PCR System specifications

The figures below summarize the specifications and requirements for the ViiA™ 7
Real-Time PCR System. For more information, refer to the Applied Biosystems™ ViiA™
7 Real-Time PCR System Site Preparation Guide (Pub. No. 4445302).

ViiA" 7 Real-Time PCR System dimensions

(ug)wopgs

&
N
=~
(e}
3
&)
2
(U g7) wo g'gg |

|

‘ F—53.3cm (21in.) — ‘
162.56 cm (64 in.) |

P (‘U $°62) WO G'y9 %

Component Width Depth Height Weight
cm in cm in cm in kg Ibs
Instrument('] 53.3 21.0 63.5 25.0 64.5 25.4 60.7 133.5
Laptop 35.8 141 25.7 10.1 35.8 141 2.6 5.7
Computerl?
Desktop 18.7 7.3 44.5 17.5 41.0 16.1 10.9 24.0
Monitor 44.7 17.5 19.3 7.6 36.6 14.4 6.9 15.2
Keyboard 44.7 17.5 15.25 6.0 5.0 2.0 0.1 0.2
Total footprint 233 91.7 86 33.8 79.7 31.4 77.9 171.5

[ Weight varies depending on the sample block installed.
[l Computer properties differ depending on the computer ordered with the ViIA™ 7 System (laptop or desktop).
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Chapter 1 Getting started
Specifications and layout

Required clearance

The ViiA™ 7 Instrument requires the following additional clearances:

* Clearance on all sides — At least 15.2 cm (6 in) of clearance for ventilation,
service access, and cable routing.

* Vertical clearance — At least 30.5 cm (12 in) of unobstructed vertical clearance
above the ViiA"™ 7 Instrument to allow removal of the cover during service.

Instrument hot-air exhaust venting

The maximum thermal output of the ViiA™ 7 Instrument is 2731BTU/hr (800W) vented
directly into the room air from the hot-air waste port on the rear panel.

Electrical requirements

Note: We recommend placing the ViiA™ 7 Instrument and computer power
receptacle on an electrical circuit that is not shared with electrically noisy devices or
devices that can cause power surges, such as refrigeration units.

The following table provides electrical specifications for the instrument and
associated devices. For all indicated input voltages, a 15 A circuit is required.

Device Rated Rated power vlz’ftf;e frelze:::cy
current (A) (VA) (VAC) (Hz)
Instrument 12.5 950
Desktop 2.1 125 _
Computer 100 2;011 0 50/60
Laptop 1.5 90 °
Monitor 1.5 65

Note: The instrument, monitor, desktop computer, and laptop computer self-adjust
for 100v-240v input voltages of 50/60 Hz.

Environmental requirements

Requirement Description

Altitude Less than 2,000 m (6,500 ft) above sea level
15-30°C (59-86°F)

Temperature Do not place the ViiA™ 7 Instrument next to heaters, cooling
ducts, or in direct sunlight. Temperature fluctuations can affect
performance.

Humidity 20-80% relative humidity, noncondensing

Pollution Pollution Degree rating of 2!']
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Chapter 1 Getting started
Specifications and layout

(continued)
Requirement Description
For indoor use only
IMPORTANT! Do not locate the ViiA™ 7 Instrument next to:
Location . Vibration sources, such as a centrifuge, pump, or compressor.
Excessive vibration affects instrument performance.
. Electrically noisy devices, such as a refrigeration unit.

1 The ViiA™ 7 Instrument can be used in an environment that contains nonconductive pollutants only (dust
particles or wood chips). Typical environments with a Pollution Degree 2 rating are laboratories, sales, and
commercial areas.

ViiA™ 7 system layout and connections

The ViiA™ 7 System consists of the components shown in the following figure.

Component Description
3 VilA™ 7 Instrument Perform§ qu'orescence research detection and data collection of experiment
and calibration consumables.
()
Computer .
P Runs the software that is used to:
a Monitor e Calibrate the ViiA™ 7 Instrument.
* Set up experiments.
Keyboard P exp
* (Optional) Run experiments.
ﬁ Mouse * Analyze experiments.
Sl Scans the bar codes of consumables before and after they are loaded into
a1 Bar code reader T
the ViiA"~ 7 Instrument.
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Chapter 1 Getting started
VIIA™ 7 Real-Time PCR System hardware

Connection Description
A Power cables Supply power to the computer and the ViiA™ 7 Instrument.[1]
B LAN connection or Connects the ViiA™ 7 Instrument (Ethernet 1 port) to the Ethernet port on the
Ethernet cablel?! network interface card in the computer.
C DVI cable Connects the monitor to the computer (DVI port).
D Bar code reader cable | Connects the bar code reader to the computer (USB port).
E Keyboard cable Connects the keyboard to the computer (USB port).
F Mouse cable Connects the mouse to the computer (USB port).

' Supplies 115/230 V depending on the geographic location of the installation.
[l Supplied with the ViiA™ 7 System.

ViiA" 7 Real-Time PCR System hardware

Instrument components

The ViiA™ 7 System consists of the components shown in the following figures.

Front view

1
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Chapter 1 Getting started

VIiA™ 7 Real-Time PCR System hardware

Component Description
Provide USB communication with the ViiA™ 7 Instrument. Can be used to
transfer data to and from the instrument and to update the firmware.
USB ports Note: If multiple USB drives are plugged into the ViiA™ 7 Instrument, the

instrument mounts only the first drive that is installed, regardless of the USB
port used.

Instrument touchscreen

Provides access to the instrument functions. Can be used to run
experiments, transfer data, and operate the instrument functions without the
use of the computer.

Access door

Provides access to the instrument lamp, the heated cover, and the sample
block.

Lamp

llluminates the reaction plate or array card during a run.

Heated cover

Covers the plate or array card during a run to prevent condensation and
leakage through the consumable cover.

18

Sample block Heats the plate or array card during a run.
Side door Opens to allow extension of the tray arm.
Plate adapter Secures plates or array cards to the tray arm.
Conveys plates or array cards to and from the sample block in the interior of
Tray arm .
the instrument.
Rear view

-

Ethernet

Ethernet

2

: 1

= =
UsB UsB
1 > RS232
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Chapter 1 Getting started
VIIA™ 7 Real-Time PCR System hardware

Component

Description

Ethernet 1 port

An RJ45 port that provides Ethernet (Gigabit) communication with the
instrument.[1]

IMPORTANT! The Ethernet 2 port is for Thermo Fisher Scientific use only.

USB ports

Provide USB communication with the instrument. They can be used to
transfer data to/from the instrument and to update the firmware.

Note: If multiple USB drives are plugged into the ViiA™ 7 Instrument, the
instrument mounts only the first drive that is installed, regardless of the USB
port used.

RS232 port

Provides serial communication between the instrument and the computer.

IMPORTANT! The serial port is reserved for Thermo Fisher Scientific use
only.

Instrument fans

Cool the interior of the ViiA™ 7 Instrument.

IMPORTANT! The fans must be unobstructed to ensure adequate cooling
and proper function of the ViiA™ 7 Instrument.

On/Off switch

Power switch for the ViiA™ 7 Instrument, where the states are on (| ) or off
(O).

Fuse cover

Dual 12.5A, Time-Lag T, 250VAC, 5 x 20-mm electrical fuses that protect the
ViiA™ 7 Instrument from excessive electrical current.

7

Power port

The 100-240VAC port that provides power to the ViiA™ 7 Instrument.

[ Use the Ethernet cable supplied with the ViiA™ 7 System to connect the instrument (Ethernet 1 port) to the network interface card in the

computer.

Bar code reader

The Applied Biosystems™ ViiA™ 7 Real-Time PCR System can include a bar code
reader for data entry and plate recognition:

* A hand-held bar code reader for scanning plates manually.

The bar code reader uses 670 nm Class Il lasers to scan plates, and is capable of
reading Code 128 (alphanumeric), which supports 128 ASCII character bar codes.
The bar code reader is optional and available depending on the system configuration.
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Chapter 1 Getting started
VIIA™ 7 Real-Time PCR System hardware

N

About the hand-held bar code reader

WARNING! LASER HAZARD. Exposure to direct or reflected laser light can burn
the retina and leave permanent blind spots. Never look into the laser beam. Remove
jewelry and anything else that can reflect the beam into your eyes. Protect others
from exposure to the beam.

The optional hand-held bar code reader functions as an extension of the keyboard
that you can use to scan bar codes into the software.

To scan a bar code using the hand-held bar code reader:

1. Select the field in the software where you want to enter the bar code.

2. Hold the hand-held bar code reader 20 to 30 cm away from a plate and aim at
the center of the bar code, then press the trigger. Slowly move the scanning
beam across the bar code until the reader emits a high-pitched tone.

When the reader scans a bar code, it automatically:

* Transmits the alphanumeric equivalent of the bar code to the software. The
software enters the bar code text wherever the cursor is active.

* Transmits a carriage-return character (the equivalent of pressing the Enter key).

For more information on the hand-held bar code reader, see the bar code reader user
documentation shipped with the ViiA™ 7 System.
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Electrical protective devices

We recommend several protective devices to protect the ViiA™ 7 System in
environments with large voltage and power fluctuations.

Power line regulator

We recommend the use of a 1.5-kVA power line regulator in areas where the supplied
power fluctuates in excess of +10% of the normal voltage. Power fluctuations can
adversely affect the function of the ViiA™ 7 System.

Note: A power line regulator monitors the input current and adjusts the power
supplied to the ViiA™ 7 System or computer. It does not protect against a power
surge or failure.

Uninterruptible power supply (UPS)

We recommend the use of a 1.5-kVA uninterruptible power supply (UPS), especially
in areas prone to power failure. Power failures and other events that abruptly
terminate the function of the ViiA™ 7 System can corrupt data and possibly damage
the computer or the instrument.

IMPORTANT! UPSs provide power for a limited time. They are meant to delay the
effects of a power outage, not to serve as replacement power sources. In the event
of a power loss, power off the instrument and the computer, unless you expect to
regain power within the battery life of the UPS.

Surge protector

We recommend the use of a 10-kVA surge protector (line conditioner) in areas with
frequent electrical storms or near devices that are electrically noisy, such as
refrigerators, air conditioners, or centrifuges. Short-duration, high-voltage power
fluctuations can abruptly terminate the function of, and thereby damage the
components of, the computer and the ViiA™ 7 Instrument.

Note: A dedicated line and ground between the ViiA"™ 7 System/computer and the
building’s main electrical service can also prevent problems caused by power
fluctuations.

ViiA" 7 Real-Time PCR System software

The ViiA™ 7 Real-Time PCR System System includes a suite of software applications
that can be used to calibrate, run, automate, and integrate the ViiA™ 7 System into a
laboratory workflow. The basic installation of the QuantStudio™ Real-Time PCR
Software contains the components that are described below. Additional software
may be available for the ViiA™ 7 System. Go to www.thermofisher.com/viia7 for a
complete list of compatible software.

Note: For QuantStudio™ Real-Time PCR Software, go to thermofisher.com/
qpcrsoftware.
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Computer requirements

The requirements for the computer used to operate the ViiA" 7 Instrument can vary
depending on the version of the QuantStudio™ Real-Time PCR Software that you are
running. To determine the computer requirements for your ViiA™ 7 System, check the
software release notes at the following location:

1. Go to thermofisher.com/qpcrsoftware.

2. In the Real-Time PCR section, click Applied Biosystems™ ViiA™ 7 Real-Time
PCR System.

3. Click Read Me to download the release notes.

Software installation

The default installation of the ViiA™ 7 System partitions the computer hard drive to
create the logical drives shown below.

Drive Software Description

C drive | Microsoft™ Windows™ OS] Operating system files.

Used to calibrate and perform experiments

. on the ViiA™ 7 Instrument.
QuantStudio  Real-Time PCR

Software Stores the installation files, application data
CorD files, and user files (experiments, exports,
drive and imports).

Used to automate the creation of new
experiments and the export of existing
experiments.

ViiA™ 7 System Command-line
Utility

" We recommend that you do not install programs to the C drive.

Third-party software

Before you install third-party software to the computer running the QuantStudio™
Real-Time PCR Software, confirm that the software will not:

® Restrict Ethernet communication

* Interfere with QuantStudio™ Real-Time PCR Software operation (see below)

To confirm that third-party software does not interfere with the system:
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Install the third-party software to the computer that contains the QuantStudio™
Real-Time PCR Software.

Perform several test experiments using “dummy” plates (plates that do not
contain reagents).

Note: The goal of the test experiments is to run plates under conditions that
match normal instrument operation. Therefore, the characteristics of the test
experiments (plate layout and run method) must closely resemble your actual
experiments.

Confirm that the ViiA™ 7 System performs each test experiment without
producing errors.

If the ViiIA™ 7 System performs the tests successfully, perform experiments
normally. If the ViiA™ 7 System encounters errors during the test runs, the third-
party software may not be compatible with the QuantStudio™ Real-Time PCR
Software.

You can use this guide to calibrate, service, network, and administrate the ViiA™ 7
Real-Time PCR System.

This user guide contains the following information:

Chapter 2, “Calibration and maintenance” —Describes how to perform regular
maintenance of the ViiA™ 7 System, including calibrating the ViiA™ 7 Instrument
and verifying instrument performance.

Chapter 3, “Networking” —Describes how to install the ViiA™ 7 System to a local
area network for remote monitoring and control.

Chapter 4, “Security, audit, and electronic signature” —Describes how to
configure the security, audit, and e-signature functions of the QuantStudio™
Real-Time PCR Software.

Chapter 5, “Service” —Describes how to replace the user-serviceable parts of
the ViiA™ 7 Instrument and resolve infrequent problems that can occur during
normal use.

Appendix A, “Manual instrument operation” —Describes how to operate the ViiA™
7 Instrument manually using the touchscreen interface.

Appendix B, “Power on or off, store, and move the ViiA™ 7 system” — Describes
how to store, move, and reinstall the components of the system.

Appendix C, “Creating custom calibration plates and array cards” —Describes
how to create a background plate in the event that one is unavailable, and how
to create a dye plate that can be used to calibrate the system for a dye not
manufactured by Thermo Fisher Scientific.
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* Appendix D, “Parts and materials” —Describes how to order parts, accessories,
and consumables for the ViiA™ 7 System.

* Appendix E, “Software reference” —Describes how to use the QuantStudio™
Real-Time PCR Software command line application, and provides specifications
for files that the software imports, exports, and stores.
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Access the Help system by pressing F1, by clicking in the toolbar of the
QuantStudio™ Real-Time PCR Software window, or by selecting Help » Contents
and Index.

Note: After the system software is upgraded, the instrument must be calibrated
before starting a run with a 96-well plate block or a 384-well plate block.

After the system software is upgraded, the instrument does not need to be calibrated
before starting a run with a TagMan™ Array Card block.

Calibrate and maintain the ViiA™ 7 Real-Time PCR System

The ViiA™ 7 Real-Time PCR System requires regular calibration and maintenance to
ensure optimal instrument performance.

Recommended calibration and maintenance schedule

Note: After the software is upgraded to QuantStudio™ Real-Time PCR Software
v1.6.1, the instrument must be calibrated before starting a run with a 96-well plate
block or a 384-well plate block. The instrument does not need to be calibrated before
starting a run with a TagMan"" Array Card block.

IMPORTANT! Calibrate the ViiA™ 7 System at the same ambient temperature at
which you will run experiments. Extreme variations in ambient temperature can affect
the heating and cooling of the ViiA™ 7 System and, in extreme cases, influence
experimental results.

IMPORTANT! Do not use organic solvents to clean the ViiA™ 7 System.

Frequency User-performed maintenance task

Check the computer disk space. If necessary, archive or back up
your experiment files and instrument settings.

Power off the computer that controls the ViiA™ 7 System, then
Weekly after 30 seconds, power on the computer.

Clean the surface of the ViiA™ 7 System with a lint-free cloth.

Perform a ViiA™ 7 Instrument self test.

Monthly Check the lamp status. If necessary, replace the lamp.
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Calibrate and maintain the VIIA™ 7 Real-Time PCR System

(continued)

Frequency

User-performed maintenance task

Monthly

Perform a background calibration.["!

Run disk cleanup and disk defragmentation.

Semi-annually
(6 months)

Perform a regions of interest (ROI) calibration.

Perform a background calibration.

Perform a uniformity calibration.

Perform a dye calibration.

(TagMan™ Array Card block only) Perform a normalization
calibration.

Perform an instrument verification run.

As needed

Decontaminate the ViiA™ 7 System.

Replace the ViiA™ 7 System fuses.

Update the Windows™ operating system.

Update the QuantStudio™ Real-Time PCR Software and firmware.

' You can perform a background calibration to check for contamination. If any parts of the optics are replaced

or moved, you must perform all calibrations, including an RNase P instrument verification run.

Calibration with QuantStudio™ Real-Time PCR Software v1.6.1

QuantStudio™ Real-Time PCR Software v1.6.1 does not require a normalization
calibration for the 96-well plate blocks or the 384-well plate block. For this version of
the software, normalization calibration is only required for the TagMan™ Array Card

block.

After the software is upgraded, the instrument must be calibrated before starting a

run with a 96-well plate block or a 384-well plate block.

After the software is upgraded, the instrument does not need to be calibrated before

starting a run with a TagMan™ Array Card block.

The feature to override a calibration can only be used for a data file with compatible

calibration data.

* A data file generated with a previous version of the software cannot have the

calibration overridden after an upgrade to QuantStudio™ Real-Time PCR

Software v1.6.1.

* A data file generated with QuantStudio™ Real-Time PCR Software v1.6.1 cannot
have the calibration overridden if it is opened using a previous version of the

software.
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About the consumables

The ViiA™ 7 System uses a series of specialized consumables for calibration. The
calibration plates and array cards can be ordered from thermofisher.com. Use the
consumables appropriate for the sample block of your ViiA™ 7 System.

Sample block

Consumable

Reaction volume

96-well plate, 0.2 mL

* MicroAmp" Optical 8-Cap Strip
*  MicroAmp" 8-Tube Strips (0.2-mL)

* MicroAmp" Reaction Tubes without
Caps (0.2-mL)

*  MicroAmp" 96-Well Tray/Retainer Set

50 pL

* MicroAmp" Optical Adhesive Film

* MicroAmp" Optical 96-Well Reaction
Plate with Bar Code

50 L

96-well plate, 0.1 mL

*  MicroAmp" Optical Adhesive Film

*  MicroAmp" Optical 96-Well Fast
Reaction Plate with Bar Code

50 L

384-well plate

* MicroAmp" Optical Adhesive Film

* MicroAmp" Optical 384-Well Reaction
Plate with Bar Code

20 uL

TagMan™ Array Card

TagMan™ Array Card
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Observe the following guidelines when using tubes, plates, or array cards:

* Store the calibration plates or array cards in a dark place until you are ready to
use them. The fluorescent dyes in the wells of calibration consumables are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the
dyes.

¢ Do not allow the bottom of the tubes, plates, or array cards to become dirty.
Fluids and other contaminants that adhere to the bottoms of the consumables
can contaminate the sample block and cause an abnormally high background
signal.

¢ Confirm that the centrifuge you use is clean. Before centrifugation, wipe down
the bucket using a tissue.

* (Plates only) Vortex all calibration plates to ensure complete mixing, then
centrifuge them to ensure that all reagents are contained in the bottom of the
wells. The calibration plates must be well mixed and centrifuged before use.

* (Plates only) Do not discard the packaging for the calibration plates. Each plate
can be used to calibrate the ViiA"™ 7 System 3 times for up to 6 months if it is
stored in its packing sleeve.

* (Plates only) Handle the calibration plates with care to prevent contamination. Do
not place the plates on a lab bench, to avoid contaminating them. Always put
calibration plates back into their packaging sleeves.

* (96-well plates only) If you are using cap strips to seal your plates, firmly seal all
wells before running the plate. Partially seated caps can leak during the
experiment, causing evaporation.

* (Tubes only) Firmly seal all individual tubes and tube strips. Partially seated caps
can leak during the experiment, causing evaporation.

Perform regular data maintenance

Maintain the computer hard drives

Defragment and clean up the hard drive:
* At least once every month.
* When a message is displayed by the Windows™ operating system instructing
you to defragment.

For more information on maintaining the hard drives, see the Windows™ Operating
System Help, then search the Help to find information on the Disk Cleanup and Disk
Defragment utilities.

IMPORTANT! Do not run the disk management utilities and QuantStudio™
Real-Time PCR Software at the same time.
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Archive and back up experiment files

Archive experiment files regularly

To conserve space on the computer hard drive, older EDS files can be archived using
a data compression utility. Several commercial compression utilities are available to
store experiment files in the ZIP or ARC archive format.

Back up experiment files

We strongly recommend that you back up your experiments. Backing up data:

* Protects against potential loss of data caused by an unforeseen failure of the
computer or its hard drive(s).

¢ Conserves space on the hard drive and optimizes performance.

Develop a data management strategy
We recommend developing a strategy for managing data files.

Note: Real-time runs generate significantly more data than genotyping or
presence/absence experiments. During one day of real-time operation, the ViiA™ 7
System can generate more than 10 MB of data.

Check disk space

If you perform real-time experiments on your ViiA" 7 System, check the amount of
available space on your hard drive weekly. When the hard drive is within 20% of
maximum capacity, transfer the older data to another storage device.

Back up the instrument settings

You can use the ViiA™ 7 Instrument touchscreen to back up the instrument settings
(instrument name, icon, standby time-out, and cover idle temperature). In the event
that the ViiA™ 7 Instrument settings are reset, you can restore the settings from the
backup.

See “Back up and restore the instrument settings” on page 133 for more information.
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Fill the array cards

IMPORTANT! Perform the following procedure only if you are calibrating a ViiA™ 7
System with an array card sample block. Otherwise, go to “Perform the ROI
calibration” on page 34 to begin the calibrations.

Materials required

* ViiA™ 7 System Array Card Spectral Calibration Dye Kit:
— Array Cards, empty

- Array Card Spectral Calibration Dye Kit, including: FAM™ dye mix, VIC™ dye
mix, ROX™ dye mix, ROI dye mix, Background Buffer, FAM™/ROX™ dye mix,
and VIC"/ROX™ dye mix

* Array Card Staker/Sealer

¢ Centrifuge with array card buckets and array card carrier clips
* Permanent marker or pen

* Pipettor, 200-pL (with pipette tips)

* Powder-free gloves

¢ Safety glasses

Fill the calibration array cards

IMPORTANT! Wear powder-free gloves while creating the calibration array cards.

Note: This procedure explains how to create all of the array cards that are required
to calibrate the ViiA™ 7 System, but not all of them are required for monthly
maintenance. Before preparing array cards for calibration, see “Recommended
calibration and maintenance schedule” on page 25 to determine which calibrations
are required.

1. Remove the tubes of calibration solutions from —20°C, allow them to thaw, then
vortex the tubes to mix the contents well.

2. Remove the array cards from their box, then place them on a clean, dry surface.

3. Using a permanent marker, mark the

side of the empty array cards with: ) &&%&TW .
* Background @Aﬁ%&%ﬁ%&ﬁ?&&
aaAdndadafi
s FAM" adaladadadad
* ROl ﬁ%ﬁﬁ%ﬁﬁw
L4 ROXTM ~@Z&ﬁ@@’ Mark
o V| Cm here

e FAM™/ROX™
e VIC"/ROX™
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4. For each array card, pipette 100 uL of the appropriate calibration solution into
each of the eight reservoirs in the array card:

a. Place the array card on a lab bench, with the foil side down.

b. Load 100 pL of the calibration solution into a pipette.

c. Hold the pipette in an angled position (approximately 45°), then place the
tip into the fill port.

@ Fill port

(2 Vent port

d. Dispense the fluid so that it
sweeps in and around the fill
reservoir toward the vent port.

When pipetting the reagents into
the array card, pipette the entire
100-pL volume into the fill
reservoir, but do not go past the
first stop of pipettor plunger or
you can blow the solution out of
the port.

K
X
L
%
y

2

N
N4V

N«

N
=
ae
>
S
=

N«

N

B

IMPORTANT! Do not allow the tip to contact and possibly damage the
coated foil beneath the fill port.

5. Repeat step 4 to fill the remaining array card with the appropriate calibration
reagents.

6. Place the filled array card(s) into a
centrifuge array card carrier clip and
place empty array cards in the
remaining slots. Confirm that the
labels on the buckets and clips face
the same way.
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Fill the array cards

10.

11.

Place the filled carrier clips into the
centrifuge buckets. Ensure that the
array card fill reservoirs and bucket
and clip labels face outward when
loaded into the centrifuge.

IMPORTANT! You must run the
centrifuge with all four buckets in
place and each of the two carriers
that are filled with array cards. Place
empty array card into unfilled slots.

IMPORTANT! Balance the loads in opposite buckets in the centrifuge.

Close the centrifuge cover, then spin the array cards for 1 minute at 1,200 rpm.

When the run is finished, stop the centrifuge, then spin the array cards again for
1 minute at 1,200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The two
sets of ramps are important for a good fill into the array card.

When the second run is finished, open the centrifuge, then check that the fluid
levels in the reservoirs of each array card have decreased by the same amount.
Also, check for the formation of bubbles in all wells, then note possible
problems.

Correct fill Incorrect/partial fill
e @® |7 @ | & @

If needed, centrifuge the array cards for an extra minute to fill any unfilled wells.
Do not exceed three 1-minute runs or centrifuge the array card for longer than
1 minute at a time.

Seal the array card(s):

a. With the carriage (roller assembly)
of the Array Card Staker/Sealer in
the Start position, place a filled
array card into the fixture with the
foil side up so that the fill
reservoirs are the farthest away
from the carriage.
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b. Press down on all four corners of
the array card to ensure that it is
fully seated within the fixture.

c. Use the two alignment pins in the
fixture to position the array card
correctly.

d. Seal the array card by running the
carriage slowly over it. Run the
carriage over the array card in one
direction only. Do not apply
downward force on the carriage
as you move it forward over the
card.

e. Remove the sealed array card
from the fixture, then trim the fill
reservoirs from the array card
assembly using scissors. Trim the
foil array card so that the edge is
even with the plastic carrier.

IMPORTANT! Completely
remove the fill reservoirs from the
array card so that the edge is free
of residual plastic. The plastic
from the fill reservoirs that
extends beyond the edge of the
card can prevent the array card
from seating properly on the
sample block and can affect
amplification.
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Correct trim Incorrect trim

7@ @ fl @ @ fl

12. Repeat step 11 to seal the remaining array cards.

IMPORTANT! As you seal the remaining filled array cards, store them in a dark
place. Do not expose the array cards to light until you are ready to use them. The

dyes in the array cards are photosensitive. Prolonged exposure to light can diminish
the fluorescence of the dye.

IMPORTANT! If an array card is sealed improperly, the card can leak and
contaminate the sample block and/or it can cause the associated calibration or
RNase P experiment to fail.

Perform the ROI calibration

A regions of interest (ROI) calibration maps the positions of the wells on the sample
block of the ViiA™ 7 Instrument. The software uses the ROI calibration data to
associate increases in fluorescence during a run with specific wells on the plate. The
ViiA™ 7 Instrument uses a set of optical filters to distinguish the fluorescence
emissions gathered during runs. You must generate a calibration image for each
individual filter to account for minor differences in the optical path.

Materials required

96-Well plate sample block

* 96-Well Region of Interest (ROI) and Background Plates
* (Centrifuge with plate adapter

* Powder-free gloves

e Safety goggles

Note: Only the ROI plate is required for this calibration.

384-Well plate sample block

¢ 384-Well Region of Interest (ROI) and Background Plates
* (Centrifuge with plate adapter

* Powder-free gloves

* Safety goggles

Note: Only the ROI plate is required for this calibration.
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Array card sample block

Array Card filled with ROI Calibration Mix

Array Card Staker/Sealer

Centrifuge with centrifuge array card carrier clips and buckets
Powder-free gloves

Safety goggles

Pipettor, 200-pL (with pipette tips)

When to perform the calibration

Perform the ROI calibration:

Every 6 months, or as often as necessary, depending on instrument use.
After replacing the lamp.

IMPORTANT! After every ROI calibration, you must perform the following:

. Background calibration

. Uniformity calibration

. Dye calibration

. (TagMan"™ Array Card block only) Normalization calibration

. RNase P instrument verification

About the ROI calibration data

During the ROI calibration, the QuantStudio™ Real-Time PCR Software captures

images of the ROI calibration plate at each instrument filter. An ROI calibration
passes if the collected image for each filter shows all wells of the ROI plate or array

card. Each well in the image must be distinct and visible at the same luminosity

relative to the other wells in the image.

You can review the ROI calibration image for each filter set by selecting the desired

filter combination from the Filter Set menu of the ROI tab in the Instrument Manager.

Green circles appear around all wells
indicating that the wells calibrated
successfully. Each green circle indicates
that the region of interest for the well
position is sufficiently bright.

Figure 1 Passing Image
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Red circles appear around some or none
of the wells indicating that the wells did
not calibrate. The absence of a circle
indicates that the region of interest for
the well position is not sufficiently bright.

Figure 2 Failing Image

Prepare the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates
or array cards.

Prepare the ROI calibration consumable appropriate for your ViiA™ 7 Instrument:
* “Prepare the ROI calibration plate” on page 48

¢ “Fill the array cards” on page 30

Perform the calibration
1. In the Home screen of the software, click Instrument Console.

2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

3. After the instrument is added to your list, select it, then click Manage
Instrument.

4. In the Instrument Manager, start the calibration wizard:
a. Click Maintenance, then click ROL.

b. In the ROI Calibration screen, click Start Calibration.

5. Click Next, then perform the
calibration as instructed. When the
side door opens, load the ROI
calibration plate or array card.
Ensure that the plate or array card is
properly aligned in the holder.

* |Load 96/384-well plates with
the A1 position at the top-left
corner of the plate adapter.

o
[e]e}
[e]e}
[e]e}
[e]e}
[e]e}
Q0
[e]e}
(e]e}

* Load both plates and array cards with the bar code facing the front of the
instrument.
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IMPORTANT! Plates should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

6. After loading the plate or array card, start the calibration:

a. In the Setup tab, select Check the box when the ROI calibration plate
has been loaded, then click Next.

b. In the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.

7. When the run is complete and the Analysis screen displays, select each filter
from the Filter Set drop-down list, then verify that the corresponding ROI Image
displays a green circle around each well area

8. After you inspect all ROl images, verify the status of the calibration, where
passed indicates that the run produced viable calibration data, and failed
indicates that the run did not produce data or that the data it did collect is

unusable.
Analysis status Action
Click Next, then remove the plate or array card when the
Passed . .
instrument ejects the tray arm.
Failed Troubleshoot the failed calibration as described in
“Troubleshoot the ROI calibration” on page 39.

i: WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

IMPORTANT! If the instrument does not eject the plate, remove the plate as
explained in “Troubleshoot the ROI calibration” on page 39.
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9. Discard or store the plate or array card.

Consumable Action

Discard the array card if you do not plan to perform a
uniformity calibration soon.

Array card . . .
Note: You can reuse the array card if the ROl and uniformity
calibrations are performed on the same day.

Return the ROI calibration plate to its packaging sleeve. If you
plan to perform background and uniformity calibrations:

* During the next 8 hours, keep the ROI calibration plate at
room temperature. (The ROI calibration plate is used in
the uniformity calibration.)

Plate N

Another day, return the packaged plate to the freezer.

IMPORTANT! Do not discard the calibration plate. If the
plate is stored in its original packaging sleeve, you can use it
to calibrate a ViiA™ 7 System 3 times for up to 6 months after
you open it.

10. In the ROI Calibration screen, click Finish to complete the calibration, then click
Yes when prompted to save the results.
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Problem/symptom

Possible cause

Action

ROI calibration failed

ROl image is faint

The sample block or
heated cover may not
be seated correctly.

1.
2.

4.

Power off and unplug the ViiA™ 7 Instrument.
Wait for

15 minutes, then
open the access
door.

Firmly push the sample block and the heated cover toward the
back of the instrument to confirm that they are seated correctly.
IMPORTANT! Confirm that the arrows on the front handle of
the heated cover align as shown below. If the arrows do not
align, push the heated cover further into the instrument until
the handle locks into place.

IMPORTANT! Confirm that the indicator on the left side of
the sample block is positioned behind the red line on the
instrument rail. If the indicator is forward of the red line, push
the sample block into the ViiA™ 7 Instrument until it is seated
correctly.

If the ROI calibration continues to fail, check the status of the
halogen lamp within the ViiA™ 7 System, then replace the lamp
if necessary (see “Replace the halogen lamp” on page 114).
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(continued)
Problem/symptom Possible cause Action

Instrument does not | The adhesive cover 1. Power off the instrument.

eject the ROl plate | may have adhered 2. Wait for 15 minutes, then power on the instrument and eject the
the plate to the |

o plate.
heated cover within 3. Ifthe plate d . # and lug the |
the instrument. . If the plate does not eject, power off and unplug the instrument,
then open the access door.

4. Wearing powder-free gloves, reach into the instrument and
remove the plate from the heated cover, then close the access
door.

5. Perform a background calibration to confirm that the sample
block has not been contaminated.

Instrument Multiple possible Contact Technical Support.
malfunction causes

Perform the background calibration

During a background calibration, the ViiA™ 7 System:

* Performs reads of a background plate containing PCR buffer for 10 minutes at
60°C.

* Averages the spectra that are recorded during the run and extracts the resulting
spectral component to a calibration file.

The software then uses the calibration file during subsequent runs to remove
background fluorescence from the run data.

Materials required

96-Well plate sample block

* 96-Well Region of Interest (ROI) and Background Plates
* Centrifuge with plate adapter

* Powder-free gloves

* Safety goggles

Note: Only the background plate is required for this calibration.

384-Well plate sample block

* 384-Well Region of Interest (ROI) and Background Plates
¢ Centrifuge with plate adapter

* Powder-free gloves

¢ Safety goggles

Note: Only the background plate is required for this calibration.
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Array card sample block

* Array card filled with Background Mix or deionized water

* Array card Staker/Sealer

* Centrifuge with centrifuge array card carrier clips and buckets
* Powder-free gloves

* Safety goggles

* Pipettor, 200-pL (with pipette tips)

When to perform the calibration

Perform the background calibration:
* Monthly or as often as necessary, depending on instrument use.

* After replacing the lamp.

About the background calibration data

During the background calibration, the QuantStudio™ Real-Time PCR Software
captures a series of images of the background plate using each instrument filter. The
software compares the fluorescence from each well to the average for the plate. A
background calibration passes if the collected images for all filters are free of
abnormal fluorescence.

About the data

After the calibration, you can review the calibration data in the Background tab of the
Instrument Manager. The Analysis Data plot (left-side) displays the fluorescence data
in all filters. The Well Table tab (right-side) displays the data collected for the current
calibration. The QC tab displays a summary of quality check performed by the
QuantStudio™ Real-Time PCR Software on the calibration data.

Background fluorescence

Fluorescence data collected by the ViiA™ 7 Instrument includes a fluorescence signal
inherent to the system, referred to as “background fluorescence.” Background
fluorescence is a composite signal found in all spectral data that consists of
fluorescence from several sources, including:

* Background electronic signal
* Contaminants in the sample block
* The plastic consumable (plate or array card)
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Prepare the background plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates
or array cards.

Prepare the background calibration consumable appropriate for your instrument:
* “Prepare the background calibration plate” on page 42
* “Fill the array cards” on page 30

Prepare the background calibration plate

1. Remove the background plate from the freezer, then allow it to warm to room
temperature (approximately 5 minutes).

2. Remove the background plate from its packaging. Do not remove the optical
film.

IMPORTANT! Do not discard the packaging. You can use the background plate
to calibrate a ViiA™ 7 System 3 times for up to 6 months if it is stored in its
original packaging sleeve.

3. Vortex and centrifuge the background plate:
a. Vortex the background plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at less than 1,500 rpm.

IMPORTANT! The background plate must be well mixed and centrifuged.

¢. Confirm that the liquid in each well of the background plate is at the bottom
of the well. If not, centrifuge the plate again at a higher rpom and for a longer
period of time.

IMPORTANT! Do not allow the bottom of the plate to become dirty. Fluids
and other contaminants that adhere to the plate bottom can contaminate
the sample block and cause an abnormally high background signal.

OLLE 4

42 Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security




Chapter 2 Calibration and maintenance
Perform the background calibration

Perform the calibration

1.

In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

After the instrument is added to your list, select it, then click Manage
Instrument.

In the Instrument Manager, start the calibration wizard:
a. Click Maintenance, then click Background.

b. In the Background Calibration screen, click Start Calibration.

Click Next, then perform the
calibration as instructed. When the
side door opens, load the
background plate or array card.
Ensure that the plate or array card is
properly aligned in the holder.

* Load 96/384-well plates with
the A1 position at the top-left
corner of the plate adapter.

* |oad both plates and array cards with the bar code facing the front of the
instrument.

IMPORTANT! Plates should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

After loading the plate or array card, start the calibration:

a. In the Setup tab, select Check the box when the background calibration
plate has been loaded, then click Next.

b. In the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.
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7. When the run is complete and the QuantStudio™ Real-Time PCR Software
displays the Analysis screen, confirm the analysis status of the calibration, then
select the QC tab and review the quality check summary.

* Analysis Status —Indicates the success of the calibration, where passed
indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data, or that the data it did collect is unusable.

Note: Abnormal spectra or abnormally high background fluorescence can
indicate the presence of contamination on the plate, array card, or sample
block, which can cause the calibration to fail.

* QC Status—Indicates the quality of the calibration data, where passed
indicates that all wells produced data that passed the quality check, and
failed indicates that one or more wells produced spectra that deviate
significantly from the other wells on the plate.

Analysis status QC status Action

Click Next, then remove the plate or
Passed Passed array card when the instrument ejects
the tray arm.

Passed Failed Troubleshoot the failed calibration as
described in “Troubleshoot the
background calibration” on page 45.

Note: You can accept a calibration that
Failed Failed passes the Analysis Status check, but
fails the QC Status check. We
recommend using calibrations that yield
passing results for both status reports.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

IMPORTANT! If the instrument does not eject the plate, remove the plate as
explained in “Troubleshoot the background calibration” on page 45.
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8. Discard or store the plate or array card.

Consumable Action

Array card Discard the array card.

Return the background plate to its packaging sleeve, then
return the packaged plate to the freezer.

Plate IMPORTANT! Do not discard the calibration plate. If the
plate is stored in its original packaging sleeve, you can use it
to calibrate a ViiA™ 7 System 3 times for up to 6 months after
you open it.

9. In the Background Calibration screen, click Finish to complete the calibration,
then click Yes when prompted to save the results.

Troubleshoot the background calibration

Problem/symptom

Possible cause

Action

Background
calibration failed

One or more wells of
the background plate
produced spectra
that exceed the
maximum limit for the
ViiA™ 7 Instrument.

Repeat the calibration using the same background plate.

If the calibration fails again, repeat the calibration using a
different background plate.

If the calibration fails again, determine the source of the
contamination, as explained in “How to identify contamination”
on page 46.
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(continued)

Problem/symptom

Possible cause

Action

Instrument does not
eject the background
plate

The adhesive cover
may have adhered
the plate to the
heated cover within
the instrument.

1. Power off the ViiA™ 7 Instrument.

2. Wait for 15 minutes, then power on the ViiA™ 7 Instrument and
eject the plate.

3. If the plate does
not eject, power
off and unplug
the instrument,
then open the
access door.

4. Wearing powder-free gloves, reach into the instrument and
remove the plate from the heated cover, then close the access
door.

5. Perform a background calibration to confirm that the sample
block has not been contaminated.

Instrument
malfunction

Multiple possible
causes

Contact Technical Support.

How to identify contamination

Signals that exceed the limit of normal background fluorescence may indicate
fluorescent contaminants on the calibration plate or the sample block. Common
contaminants include ink residue from permanent pens, powder from disposable
gloves, and dust.

To determine the source and location of the contamination:

1. While viewing the background calibration data in the Analysis screen, select the
QC tab, then review the list of wells that failed the quality check.

2. Rotate the background plate 180°, then perform the background calibration
again.

3. Determine the location of the contaminated wells again.
If the position(s) of the contaminated well(s) in step 1 and step 2 are:

¢ Identical —The sample block is contaminated. Decontaminate the sample
block (see “Decontaminate the sample block” on page 111).

* Reversed—The background plate or array card is contaminated. Discard
the plate or array card, then perform the background calibration using a new
background plate or array card.
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4. If the calibration fails after you replace the background plate and decontaminate
the sample block:

a. Cover a plate or array card with a piece of black paper.

b. Perform the background run as explained in this chapter, substituting the
plate or array card covered with paper for the background plate or array
card.

c. After the run is complete and while viewing the calibration data, select all
wells in the Plate Layout tab, then view the Spectral plot for the peak(s). If
the peak associated with the contamination is:

* Visible—The optics of your ViiA" 7 System may be contaminated.
Contact Technical Support.

* Absent—The sample block is contaminated. Decontaminate the
sample block again and repeat the calibration.

Perform the uniformity calibration

The uniformity calibration generates data that allows the QuantStudio™ Real-Time
PCR Software to compensate for the physical effects of the ViiA™ 7 System filters.

Materials required

See “Perform the ROI calibration” on page 34 for a complete list of materials for the
calibration.

When to perform the calibration

Perform a uniformity calibration every 6 months, or as often as necessary, depending
on instrument use.

About the uniformity calibration data

During the uniformity calibration, the QuantStudio™ Real-Time PCR Software
captures a series of images of the ROI plate using each instrument filter. After the
calibration, you can review the data in the Uniformity tab of the Instrument Manager.
The Analysis Data plot (leftside) displays the fluorescence data in all filters. The Well
Table tab (right-side) displays the data collected for the current calibration in all well
positions. The QC tab displays a summary of quality check performed by the
QuantStudio™ Real-Time PCR Software on the calibration data.
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Prepare the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates
or array cards.

If you have an ROI plate or array card from a recent ROI calibration, go to substep 3b
(plates), or go to “Perform the calibration” on page 49 (array cards). Otherwise,
prepare the ROI calibration consumable appropriate for your ViiA™ 7 Instrument:

* “Prepare the ROI calibration plate” on page 48

¢ “Fill the array cards” on page 30

Prepare the ROI calibration plate

1. Remove the ROI calibration plate from the freezer, then allow it to warm to room
temperature (approximately 5 minutes).

IMPORTANT! Do not remove the calibration plate from its packaging until you
are ready to run it. The fluorescent dyes in the wells of the plate are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the
dye.

2. Remove the ROI calibration plate from its packaging. Do not remove the optical
film.

IMPORTANT! Do not discard the packaging for the ROI calibration plate. You
can use the plate to calibrate a ViiA™ 7 System 3 times for up to 6 months if it is
stored in its sleeve.

3. Vortex and centrifuge the plate:
a. Vortex the ROI calibration plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at less than 1,500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and
centrifuged.

c. Verify that the liquid in each well of the ROI calibration plate is at the bottom
of the well. If not, centrifuge the plate again at a higher rpom and for a longer
period of time.

OLL
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Perform the calibration

1. In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

3. After the instrument is added to your list of instruments, select it, then click
Manage Instrument.

4. In the Instrument Manager, start the calibration wizard:
a. Click Maintenance, then click Uniformity.

b. In the Uniformity Calibration screen, click Start Calibration.

5. Click Next, then perform the
calibration as instructed. When the
side door opens, load the ROI
calibration plate or array card.
Ensure that the plate or array card is
properly aligned in the holder.

* Load 96/384-well plates with
the A1 position at the top-left
corner of the plate adapter.

* |Load both plates and array cards with the bar code facing the front of the
instrument.

IMPORTANT! Plates should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

6. After loading the plate or array card, start the calibration:

a. In the Setup tab, select Check the box when the Uniformity Calibration
plate has been loaded, then click Next.

b. In the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the ViiA™ 7 Instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.
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7. When the run is complete and the QuantStudio™ Real-Time PCR Software
displays the Analysis screen, confirm the analysis status of the calibration, then
select the QC tab and review the quality check summary.

* Analysis Status —Indicates the success of the calibration, where passed
indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it did collect is unusable.

Note: A calibration can fail if wells produce spectra that deviate
significantly from the other wells of the plate, or if all wells produce
abnormally low spectra. Abnormal spectra can indicate the presence of
fluorescent contamination on the plate or array card or sample block.

* QC Status—Indicates the quality of the calibration data, where passed
indicates that all wells produced data that passed the quality check, and
failed indicates that one or more wells produced spectra that deviate
significantly from the other wells on the plate.

Analysis status QC status Action

Click Next, then remove the plate or
Passed Passed array card when the instrument ejects
the tray arm.

Passed Failed Troubleshoot the failed calibration as
described in “Troubleshoot the
uniformity calibration” on page 51.

Note: You can accept a calibration that
Failed Failed passes the Analysis Status check, but
fails the QC Status check. We
recommend using calibrations that yield
passing results for both status reports.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

IMPORTANT! If the instrument does not eject the plate, remove the plate as
explained in “Troubleshoot the uniformity calibration” on page 51.
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8. Discard or store the plate or array card.

Consumable

Action

Array card Discard the array card.
Return the ROI calibration plate to its packaging sleeve, then
return the packaged plate to the freezer.

Plate IMPORTANT! Do not discard the calibration plate. If the

plate is stored in its original packaging sleeve, you can use it
to calibrate a ViiA™ 7 System 3 times for up to 6 months after
you open it.

9. In the Uniformity Calibration screen, click Finish to complete the calibration,
then click Yes when prompted to save the results.

Troubleshoot the uniformity calibration

Problem/symptom

Possible cause

Action

Uniformity calibration
failed

Abnormally low 1. Confirm that you loaded an ROI plate or array card into the
spectra across all instrument. If not, perform the calibration again using the
wells of the plate or correct ROI plate or array card.
array card. 2. If you are using the correct plate or array card, perform the
calibration again using a different ROI plate or array card.
3. If the calibration fails again, contact Technical Support.
One or more wells 1. While viewing the calibration data in the Analysis screen, locate
produced spectra the well(s) with abnormal signal in the Plate Layout tab.
that .d.eV|ate 2. Rotate the calibration plate or array card 180°, then perform the
significantly from the calibration again
rest of the plate or . , . .
array card 3. Determine the location of the contaminated wells again. If the
' position(s) of the well(s) identified in step 1 and step 2 on
page 51 are:
* Identical—The sample block is contaminated.
Decontaminate the sample block (see “Decontaminate the
sample block” on page 111).
* Reversed—The ROI plate or array card is contaminated.
Discard the plate or array card, then perform the uniformity
calibration using a new ROI plate or array card.
4. If the calibration fails again, contact Technical Support.
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(continued)

Problem/symptom Possible cause Action
Instrument does not | The adhesive cover 1. Power off the ViiA™ 7 Instrument.
eject the ROI plate may have adhered 2. Wait for 15 minutes, then power on the instrument and eject the

the plate to the

o plate.

heated cover within 3. Ifthe plate d

the instrument. - It e.p ate does
not eject, power
off and unplug
the instrument,
then open the
access door.

4. Wearing powder-free gloves, reach into the instrument and
remove the plate from the heated cover, then close the access
door.

5. Perform a background calibration to confirm that the sample
block has not been contaminated.

Instrument Multiple possible Contact a local Thermo Fisher Scientific Field Service Office.
malfunction causes

Perform the dye calibration

During a dye calibration, the ViiA™ 7 Real-Time PCR System:
* (Collects spectral data from a series of dye standards.
¢ Stores the spectral information for the dye standards in a dye calibration file.

The QuantStudio™ Real-Time PCR Software uses the pure spectra data during
experiment runs to characterize and distinguish the individual contribution of each
dye in the total fluorescence collected by the ViiA™ 7 Instrument. After each run, the
QuantStudio™ Real-Time PCR Software receives data in the form of a raw spectra
signal for each reading. It determines the contribution of each fluorescent dye used in
the sample by comparing the raw spectra to the pure spectra calibration data. When
you save an experiment after analysis, the QuantStudio™ Real-Time PCR Software
stores the pure spectra with the collected fluorescence data for that experiment.

IMPORTANT! You must calibrate only those dyes that are present in the chemistries
that you intend to run on your ViiA™ 7 System.
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Materials required

96-Well plate sample block

* Spectral calibration plates

Block

Plate

96-well 0.2-mL block

QuantStudio™ 3/5 Spectral Calibration Plate 1
(FAM™, VIC™, ROX™, and SYBR™ dyes), 96-Well 0.2-mL

QuantStudio™ 3/5 Spectral Calibration Plate 2, 96-Well 0.2-mL
(ABY™, JUN™, and MUSTANG PURPLE" dyes)

QuantStudio™ 3/5 Spectral Calibration Plate 3, 96-Well 0.2-mL
(TAMRA™, NED"™, and Cy®5 dyes)

96-well 0.1-mL block

QuantStudio™ 3/5 Spectral Calibration Plate 1, (FAM™, VIC™, ROX™, and SYBR™ dyes),
96-well, 0.1 mL

QuantStudio™ 3/5 Spectral Calibration Plate 2 (ABY™, JUN™, MUSTANG PURPLE™ dyes),
96-well Fast (0.1-mL) Plate

QuantStudio™ 3/5 Spectral Calibration Plate 3 (TAMRA™, NED™ and Cy®5 dyes)
96-well Fast (0.1-mL) Plate

* (Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

384-Well plate sample block

® Spectral calibration plates

- QuantStudio™ 5 Spectral Calibration Plate 1, (FAM™, VIC™, ROX™
TAMRA™, and SYBR™ dyes), 384-well

- QuantStudio™ 5 Spectral Calibration Plate 2 (ABY™, JUN™, MUSTANG
PURPLE™, NED™, and Cy®5 dyes), 384-well

¢ Centrifuge with plate adapter
* Powder-free gloves
e Safety goggles

Array card sample block
* Array Cards filled with:
- FAM" Dye
- VIC" Dye
- ROX" Dye
* Array Card Staker/Sealer
* Centrifuge with centrifuge array card carrier clips and buckets
* Powder-free gloves
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* Safety goggles
® Pipettor, 200-uL (with pipette tips)

When to perform the dye calibrations

Perform a dye calibration every 6 months, or as often as necessary, depending on
instrument use.

IMPORTANT! You must calibrate only dyes that are present in the chemistries that
you intend to run on the ViiA™ 7 System. For example, if you intend to run a TagMan™
RNase P plate or array card to verify instrument performance (see “Verify the
instrument performance” on page 66), you must calibrate the FAM™ dye, TAMRA™
dye, and ROX™ dye because all three are present in the TagMan™ assay chemistry
present on the consumable.

IMPORTANT! You must perform a background calibration before every series of dye
calibrations. Because the age and use of instrument components can affect spectra
readings, we recommend performing a dye calibration at least every 6 months.

About the dye calibration
System dyes

The ViiA™ 7 Real-Time PCR System features a six-color filter set that supports all
Thermo Fisher Scientific dyes. The following figure shows the emission spectrum for
each dye, and the filter at which each dye is read.

Wavelength
(nm)

Emission
Spectra

x1-m1 x2-m2 x3-m3 x4-m4 x5-m5 x6-m6 Filters
(@ x1-m1 — FAM™, SYBR" Green (@) x4-m4 — JUN™, ROX"™
(@ x2-m2 — vIC™ () x5-m5 — Cy®5, MUSTANG PURPLE™

(® x3-m3 — ABY", NED", TAMRA"™
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Filter wavelength (nm)[']
Peak filter Color Factory-calibrated dyes
Excitation Emission
x1-m1 Blue 470 £ 15 520 + 15 FAM™, SYBR™ Green
x2-m2 Green 520 + 10 558 + 12 vic™
x3-m3 Yellow 550 + 10 587 + 10 NED", TAMRA™, ABY™
x4-mé4 Orange 580 + 10 623 + 14 ROX™, JUN™
x5-m5 Red 640 + 10 682 + 14 MUSTANG g URPLE",
Cy°5

x6-m6 Deep-Red 662 + 10 711 =12 None @

' The central wavelengths are the optimized wavelengths.
@l This filter set currently does not support any dyes supplied by Thermo Fisher Scientific.

Custom dyes

The ViiA™ 7 System can be used to run assays designed with custom dyes (dyes not
supplied by Thermo Fisher Scientific). Before using custom dyes with the ViiA™ 7
System, you must create and run a custom calibration plate. The QuantStudio™
Real-Time PCR Software uses the custom calibration plate to create a spectral
standard to distinguish the custom dye in the fluorescence data collected during the
run. See “Create a custom dye plate for calibration” on page 150 for information on
custom dye calibrations.

IMPORTANT! A custom dye must excite between 455 and 672 nm and read
between 505 and 723 nm.

About dye calibration data

The product of a dye calibration is a collection of spectral profiles that represent the
fluorescence signature of each dye standard. Each profile consists of a set of spectra
that correspond to the fluorescence collected from the wells of the spectral
calibration plate. The QuantStudio™ Real-Time PCR Software plots the resulting data
for each spectral profile in a graph of fluorescence versus filter.

When the software extracts the dye calibration data, it evaluates the fluorescence
signal that is generated by each well in terms of the collective spectra for the entire
calibration plate. Dye spectra are generally acceptable if they peak within the same
filter as their group but diverge slightly at other wavelengths (see below).

The software can compensate for some differences in a spectral profile by replacing
the spectra of unacceptable wells with the spectra of other wells on the reaction plate
(auto-repairing). The software allows only a few replacements, and it may reject the
calibration if the spectra between neighboring wells vary significantly.
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Note: Because the wells of a calibration plate contain identical concentrations of a
dye, the resulting signals for the wells should be similar. Variations in spectral
position and peak position are caused by minor differences in the optical properties
and excitation energy between the individual wells.

Acceptable spectra Unacceptable spectra

Spectra peak at the same wavelength and

do not diverge significantly Spectra peak at the different wavelengths

Prepare the calibration plates or array cards

Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used for the
calibration procedure with the QuantStudio™ Real-Time PCR Software v1.6.1.

IMPORTANT! Before performing a dye calibration, you must perform an ROI
calibration, a background calibration, and a uniformity calibration.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates
or array cards.

Prepare the dye calibration consumables appropriate for your instrument:
* Prepare the dye calibration plate (see page 56)

* Fill the array cards (see page 30)

Prepare the dye calibration plate

1. Remove the dye plates from the freezer, then allow them to warm to room
temperature (approximately 5 minutes).

IMPORTANT! Do not remove the dye plates from their packaging until you are
ready to run them. The dyes in the dye plates are photosensitive. Prolonged
exposure to light can diminish the fluorescence signal strength of the plates.
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Note: If you store dye plates in their original packaging and in the freezer, you
can use them to calibrate a ViiA™ 7 System up to 3 times for 6 months after
opening them.

2. Before using each dye plate, vortex the plate for 5 seconds, centrifuge it for
2 minutes at less than 1,500 rpm, then confirm that the liquid in each dye plate
is at the bottom of the wells. If not, centrifuge the plate again at a higher rpm
and for a longer period of time.

(Dea ¥

IMPORTANT! The dye plates must be well mixed and centrifuged.

Perform the calibration

IMPORTANT! The QuantStudio™ Real-Time PCR Software guides you through the
calibration of each dye separately. You must set up, run, and analyze each dye
independently.

1. In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

3. After the instrument is added to your list, select it, then click Manage
Instrument.

4. In the Instrument Manager, start the calibration wizard:
a. Click Maintenance, then click Dye.

b. In the Dye Calibration screen, select System Dye Calibration, then click
Start Calibration.

5. In the Dye Calibration screen, select the dye to calibrate from the Dye Name
dropdown list, then perform the calibration as instructed.
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6. Load the calibration plate or array card into the instrument:

a. Confirm that the dye plate or array card that you are about to load matches
the dye selected in the QuantStudio™ Real-Time PCR Software. The name
of the dye contained by the consumable is next to the bar code on the front
of the plate or array card.

b. Load the dye plate or array card
into the plate adapter. Ensure that
the plate or array card is properly

ST OUSESA
*000000000000

aligned in the holder. 1980000000000
000000000000
* |Load 96/384-well plates with 1636600666666
. 000000000000

the A1 position at the top-left | (L222000200000 j |

corner of the plate adapter.

® Load both plates and array
cards with the bar code
facing the front of the instrument.

IMPORTANT! Plates should be loaded and unloaded by operators who
have been warned of the moving parts hazard and have been adequately
trained.

7. After loading the plate or array card, start the calibration:

a. In the Dye Calibration screen, select Check the box when the dye
calibration plate has been loaded, then click Next.

b. In the Run screen, click START RUN.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.
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8. When the run is complete and the QuantStudio™ Real-Time PCR Software
displays the Analysis screen, confirm the grouping of the dye spectra:

a. Select the Plate Layout tab, then review the raw data. For each spectrum,
verify that the peak is:

* Within the detectable range for the ViiA™ 7 System.

* Free of irregular spectral peaks.

* Present at the correct filter for the dye (see the following table).

Filter wavelength (nm)['] —cali
Peak filter Color e —=ted
Excitation Emission dyes
x1-m1 Blue 470 = 15 520 + 15 FAM™, SYBR™ Green
x2-m2 Green 520 + 10 558 + 12 vic™
x3-m3 Yellow 550 + 10 587 + 10 NED", TAMRA ’
ABY
x4-mé4 Orange 580 + 10 623 + 14 ROX™, JUN™
x5-m5 Red 640 + 10 682 + 14 MUSTANG g URPLE",
Cy'5
x6-m6 | Deep-Red | 662 = 10 711 £ 12 None [

1 The central wavelengths are the optimized wavelengths.

2

This filter set currently does not support any dyes supplied by Thermo Fisher Scientific.

Note: Among wells containing the same dye, variations in spectral position
and peak position are caused by minor differences in the optical properties

and excitation energy between the individual wells.

b. Select the QC tab, then review the summary of wells that failed the quality

check (QC).

9. After you inspect the dye spectra, verify the status of the calibration:

* Analysis Status —Indicates the success of the calibration, where passed
indicates that the run produced viable calibration data, and failed indicates
that the run did not produce data or that the data it did collect is unusable.

* QC Status—Indicates the quality of the calibration data, where passed
indicates that all wells produced data that passed the quality check, and
failed indicates that one or more wells produced dye spectra that differ
significantly from the other wells on the plate.
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Analysis

QC status Action
status

1. Click Next.

2. Enter any comments you have in the
Comments field, click Finish, then click Yes

Passed Passed when prompted to save the results.

3. Remove the plate or array card when the
instrument ejects the tray arm.

Passed Failed Troubleshoot the failed calibration as described
in “Troubleshoot the dye calibration” on
page 61.

Note: You can accept a calibration that passes
the Analysis Status check but fails the QC Status
check. We recommend using calibrations that
yield passing results for both status reports.

Failed Failed

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

IMPORTANT! If the instrument does not eject the plate, remove the plate as
explained in “Troubleshoot the dye calibration” on page 61.

10. Discard or store the plate or array card:

Consumable Action

Array card Discard the array card.

Return the dye calibration plate to its packaging sleeve, then
return the packaged plate to the freezer.

IMPORTANT! Do not discard the calibration plate. If the
plate is stored in its original packaging sleeve, you can use it

to calibrate a ViiA™ 7 System 3 times for up to 6 months after
you open it.

Plate

11. Repeat the calibration and review (step 4 through step 10) to calibrate your ViiA™
7 System for the remaining dyes that are present in the chemistries that you will
be running.
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Troubleshoot the dye calibration

Problem/symptom

Possible cause

Action

One or more raw
spectra are at or
below the detectable
threshold for the
calibration

Dye calibration plate
was centrifuged
insufficiently.

Dye calibration plate
contains old or
insufficient reagents.

If you are running a
custom dye
calibration plate, the
dye may not be
present at a sufficient
concentration.

1. Unload the ViiA™ 7 Instrument and view the wells of the dye
calibration plate. If the liquid in the wells is not:

* At the bottom of the wells, centrifuge the plate for a longer
time, then repeat the calibration.

* FEquivalent in volume, the plate is not sealed and the
reagents have evaporated. Discard the plate and run
another.

2. If the dye calibration plate appears to be normal, discard the
plate and run another.

3. If the problem persists, contact Technical Support.
If you are running a custom dye calibration plate, create another

plate but increase the concentration of the dye that produced
insufficient signal.

Spectra contain
peaks in more than
one filters

Fluorescent
contaminants are
present on the
sample block or dye
calibration plate.

One or more raw
spectra exceed the
maximum limit for the
ViiA™ 7 System

If you are running a
custom spectral
calibration plate, the
dye may be too
concentrated.

Verify that contaminants are not present by performing a
background calibration (see “Perform the background calibration” on
page 40) If the background calibration does not show sample block
contamination, the dye calibration plate may be contaminated.

Note: If you are running a custom dye calibration plate, create
another plate but decrease the concentration of the dye that
exceeded the detectable limit.

Instrument does not
eject the dye plate

The adhesive cover
may have adhered
the plate to the
heated cover within
the instrument.

1. Power off the ViiA™ 7 Instrument.

2. Wait for 15 minutes, then power on the instrument and eject the
plate.

3. If the plate does
not eject, power
off and unplug
the instrument,
then open the
access door.

4. Wearing powder-free gloves, reach into the instrument and
remove the plate from the heated cover, then close the access
door.

5. Perform a background calibration to confirm that the sample
block has not been contaminated.

Instrument
malfunction

Multiple possible
causes

Contact a local Thermo Fisher Scientific Field Service Office.
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Perform the normalization calibration

IMPORTANT! Normalization calibration is only required for the TagMan™ Array Card
block. Normalization calibration is not required for the 96-well plate blocks or the
384-well plate block.

During the normalization calibration, the ViiA™ 7 System:
* Collects data from the normalization standards.
* Stores the information for the normalization standards in a normalization
calibration file.

The normalization calibration generates factors that the QuantStudio™ Real-Time
PCR Software uses when comparing data from multiple ViiA™ 7 Instruments within a
study.

Materials required

* Array Cards filled with:
- FAM™/ROX™ dye mix
- VIC"/ROX™ dye mix
* Array Card Staker/Sealer
* Centrifuge with centrifuge array card carrier clips and buckets
* Powder-free gloves
¢ Safety goggles
* Pipettor, 200-uL (with pipette tips)

When to perform the calibration

TagMan™ Array Card block, perform a normalization calibration every 6 months, or as
often as necessary, depending on instrument use.

About the normalization calibration data

62

During the normalization calibration, the QuantStudio™ Real-Time PCR Software
captures a series of images of each normalization plate using each instrument filter.
The normalization calibration yields a “Pass” or “Fail” result for each normalization
plate used.
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ion array card

IM

PORTANT!

. Normalization calibration is only required for the TagMan™ Array Card block.

Normalization calibration is not required for the 96-well plate blocks or the 384-
well plate block.

. Wear powder-free gloves and safety glasses when you prepare plates or array

cards.

. Before performing a normalization calibration, you must perform ROI, background,

uniformity, and dye calibrations.

Prepare the calibration array card (see “Fill the array cards” on page 30).

Perform the calibration

1.

In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

After the instrument is added to your list, select it, then click Manage
Instrument.

In the Instrument Manager, start the calibration wizard:
a. Click Maintenance, then click Normalization.

b. In the Normalization Calibration screen, click Start Calibration.

In the Normalization Calibration screen, select the reporter/passive dye
combination that you want to calibrate, then perform the calibration as
instructed.

Load the calibration array card into the ViiA"™ 7 Instrument:

a. Verify that the normalization array card matches the selection in the
QuantStudio™ Real-Time PCR Software. The name of the dyes contained
by each consumable appears next to the bar code on the front of the array
card.

b. Load the appropriate normalization array card into the plate adapter with
the bar code facing the front of the instrument.

IMPORTANT! Arrays cards should be loaded and unloaded by operators
who have been warned of the moving parts hazard and have been
adequately trained.
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7. After loading the array card, start the calibration:

a. In the Dye Calibration screen, select Check the box when the
normalization calibration plate has been loaded, then click Next.

b. In the Run screen, click START RUN to start the calibration.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.

8. When the run is complete and the QuantStudio™ Real-Time PCR Software
displays the Analysis screen, verify the status of the calibration. The analysis
status indicates the success of the calibration, where passed indicates that the
run produced viable calibration data, and failed indicates that the run did not
produce data or that the data it did collect is unusable.

Analysis status Action

Enter any comments you have in the Comments field, click
Passed Next, then remove the array card when the instrument ejects
the tray arm.

Troubleshoot the failed calibration as described in

Failed “Troubleshoot the normalization calibration” on page 65.

i: WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

IMPORTANT! If the instrument does not eject the array card, see “Troubleshoot
the normalization calibration” on page 65.

9. Discard the array card.

10. In the Normalization Calibration screen, click Finish to complete the calibration,
then click Yes when prompted to save the results.

11. Repeat step 4 through step 10 to perform the remaining normalization
calibration.
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Troubleshoot the normalization calibration

Problem/symptom

Possible cause

Action

Normalization Abnormally low 1. Confirm that you loaded an normalization array card into the
calibration failed spectra across all ViiA"™ 7 Instrument. If not, perform the calibration again using
wells of the array the correct normalization array card.
card. 2. If you are using the correct array card, perform the calibration
again using a different normalization array card.

3. If the calibration fails again, contact Technical Support.

One or more wells 1. While viewing the calibration data, locate the well(s) with
produced spectra abnormal signal in the Plate Layout tab.

that deviate 2. Rotate the calibration array card 180°, then perform the
significantly from the calibration again

rest of the array card. . . . ,

3. Determine the location of the contaminated wells again. If the
position(s) of the well(s) identified in both calibrations are:

* |dentical—The sample block is contaminated.
Decontaminate the sample block (see “Decontaminate the
sample block” on page 111).

* Reversed—The normalization card is contaminated.
Discard the array card, then perform the normalization
calibration using a new normalization array card.

4. If the calibration fails again, contact Technical Support.

Instrument does not | An adhesive cover 1. Power off the ViiA™ 7 Instrument.
eject the calibration | may have adhered 2. Wait for 15 minutes, then power on the instrument and eject the
array card the array card to the array card.
heated cover within 3. Ifth
the instrument. - Ifthe arraylcard
does not eject,
power off and
unplug the
instrument, then
open the access
door.

4. Wearing powder-free gloves, reach into the instrument and
remove the array card from the heated cover, then close the
access door.

5. Perform a background calibration to confirm that the sample
block has not been contaminated.

Instrument Multiple possible Contact a local Thermo Fisher Scientific Field Service Office.
malfunction causes
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Verify the instrument performance

Perform the RNase P instrument verification experiment to verify the performance of
an Applied Biosystems™ ViiA™ 7 Real-Time PCR System.

Materials required

96-Well plate sample block

* (Centrifuge with plate adapter

* Powder-free gloves

e Safety goggles

e TagMan™ RNase P Fast 96-Well Instrument Verification Plate

384-Well plate sample block

* (Centrifuge with plate adapter

* Powder-free gloves

e Safety goggles

e TagMan™ RNase P Fast 384-Well Instrument Verification Plate

Array card sample block

* Array Card Staker/Sealer

* Centrifuge with centrifuge array card carrier clips and buckets

* Powder-free gloves

¢ Safety goggles

® Pipettor, 200-uL (with pipette tips)

e TagMan™ RNase P Array Card Instrument Verification Reagents Kit:
- Array Card

- TagMan™ RNase P Array Card Instrument Verification Reagents Kit,
including tubes with reagent mix for each port (8 tubes total)

When to perform the RNase P instrument verification experiment

We recommend performing an RNase P instrument verification experiment:
e After moving the ViiA"™ 7 Instrument to another location.
* As needed to verify the function of the ViiA™ 7 System.

66 Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security



Chapter 2 Calibration and maintenance
Verify the instrument performance

About the RNase P kits

The instrument verification experiment uses one of two instrument verification kits
available from Thermo Fisher Scientific. The kits differ only in the consumable format
for which they are designed: a TagMan™ RNase P Instrument Verification Plate for
ViiA™ 7 Instruments with 96/384-well sample blocks and an Array Card RNase P Kit
for ViIA™ 7 Instruments with array card sample blocks.

About the TagMan™ RNase P fast 96/384-well instrument verification
plate

The RNase P plate is preloaded with the reagents necessary for the detection and
quantification of genomic copies of the human RNase P gene (a single-copy gene
encoding the RNase moiety of the RNase P enzyme). Each well contains: TagMan™
Fast Universal PCR Master Mix, RNase P primers, FAM™ dye-labeled probe, and a
known concentration of human genomic DNA template.

TheTagMan™ RNase P fast 96-well — =t % T T
instrument verification plate contains five A
replicate groups of standards (1250, B U”E%%";{‘ A
2500, 5000, 10000, and 20000 copies), c
two unknown populations (5000 and D NTC STD 1250 STD 2500
10000 copies), and a no template control el stosooo | sTD 10000 | STD 20000
(NTC). .

™ Unknown B
The TagMan ~ RNase P fast 384-well G (10000)

H

instrument verification plate contains five
replicate groups of standards (1250, — e
2500, 5000, 10000, and 20000 copies),
two unknown populations (5000 and
10000 copies), and a no template control
(NTC).

Figure 3 TagMan™ RNase P fast 96-well
instrument verification plate

Figure 4 TagMan" RNase P fast 384-
well instrument verification plate
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About the array card RNase P kit

The Array Card RNase P Kit includes one empty array card and eight tubes of
solution. Each tube contains reaction mix (TagMan'" Universal PCR Master Mix,
RNase P primers, and FAM™“-MGB dye-labeled probe) and a known concentration of
human genomic DNA template.

To perform an instrument verification run, e ls el el Tl i i i el i m Al pomT
each solution is loaded into the empty Noffempiate Controt !
array card in the arrangement shown : 1 .;:a;? — -
right. When complete, the array card 5 ,;'alr:m ;23‘ - Z
contains five replicate groups of : Standard 40 5
standards (200, 400, 800, 1600, and ® Standard 80 6
3200 copies), two of unknown v Standard 1600 7
populations (800 and 1600 copies), and . Standard 3200 8

one that serves as a no template control
(NTC).

About the analysis

The QuantStudio™ Real-Time PCR Software performs the same analysis of data from
an instrument verification run regardless of the type of consumable used (96/384-well
plate or array card).

After the run, the software:

1. Generates a standard curve from the averaged threshold cycle (C;) values of the
replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the ViiA™ 7 System performance:

[(CopyUnky) — 3(0copyunk2)] > [(CopyUnky) + 3(0copyunki)]
where:

* CopyUnky = Average copy number of unknown population A
Ocopyunki = Standard deviation of unknown population A
* CopyUnks, = Average copy number of unknown population B
OcopyUnke = Standard deviation of unknown population B
Note: Unknown population A refers to the 5000-copy population in columns 7
through 15 of the TagMan™ RNase P Plate or the 800-copy population in rows C
and D of the loaded array card. Unknown population B refers to the 10000-copy

population in the wells of the TagMan™ RNase P Plate or the 1600-copy
population in rows E and F of the loaded array card.
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Installation specification

The ViiA™ 7 System passes the installation specification if the inequality holds and
the ViiA™ 7 Instrument successfully distinguishes between unknown populations A
and B with a statistical confidence level of 99.7%.

As shown in the following table, you can omit a limited number of outlier wells from
the unknown populations to meet the installation specification.

Maximum number of outlier wells that can be removed
Sample block Unknown Unknown Standards No template
population Al'l | population B2 (STD) controls (NTC)
96-well plate 6 6 1031 0
384-well plate 10 10 28 0
Array card 4 4 43 0

[l 5000-copy population for 384-well plates; 800-copy population for array cards.
21 10000-copy population for 384-well plates; 1600-copy population for array cards.
Bl Maximum number of wells that can be removed from each standard population.

Prepare the TagMan™ RNase P plate or array card

IMPORTANT! When performing the RNase P instrument verification experiment:

. Perform all calibrations beforehand.

. Run the TagMan™ RNase P plate or array card soon after you allow the plate or
reagents to thaw. Minimizing the time that the prepared consumable sits on the
bench ensures optimal performance.

. Wear powder-free gloves and safety glasses when you prepare plates or array
cards.

Prepare the instrument verification consumable appropriate for your instrument:
* “Prepare the TagMan™ RNase P Instrument Verification Plate” on page 69

* “Prepare the array card for the instrument verification run” on page 70

Prepare the TagMan™ RNase P Instrument Verification Plate

1. Remove the TaqManTM RNase P Instrument Verification Plate from the freezer,
then allow the plate to warm to room temperature (for approximately 5 minutes).

IMPORTANT! Do not remove the plate from its packaging until you are ready to
run it. The fluorescent dyes in the dye plate are photosensitive. Prolonged
exposure to light can diminish the fluorescence signal strength of the plate.

2. Remove the RNase P plate from its packaging.

3. Briefly vortex and centrifuge the RNase P plate:
a. Vortex the plate for 5 seconds.
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b. Centrifuge the reaction plate for 2 minutes at less than 1,500 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

c. Verify that the liquid is at the bottom of each well of the reaction plate. If
not, centrifuge the reaction plate again at a greater rpm and for a longer
time.

IMPORTANT! Do not allow the bottom of the RNase P plate to become
dirty. Fluids and other contaminants that adhere to the bottom of the
reaction plate can contaminate the sample block and cause an abnormally
high background signal.

(Deo Y

Prepare the array card for the instrument verification run

IMPORTANT! Wear powder-free gloves while preparing the array cards.

1. Remove the Array Card RNase P Kit from the freezer, then allow it to thaw at
room temperature.

2. Remove an array card from its box and place it on a clean, dry surface.

3. Using a permanent marker, mark the
side of the empty array card with
RNase P. -
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4_ Transfer 100 UL Of each Solut|on |nto - 1.2 3 4 5 6 7 8.8 10[11[42[143 /14,15 16|17 18 18 |20 21 22|23 24 PORT
the appropriate port of the array : e -
card: Unknown B {1600) 3
For each transfer, do the following: . ”‘afr' ard 20 %
a. Place the array card on a lab Standard 89 2
bench, with the foil side down. . Standard| 1600 7
o Standard 3200 8

b. Load 100 pL of fluid into a
pipette.
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c. Hold the pipette in an angled position (approximately 45°) and place the tip
into the fill port.

(@ Fill port
(2 Vent port

IMPORTANT! Do not allow the tip to contact and possibly damage the
coated foil beneath the fill port.

d. Dispense the fluid so that it
sweeps in and around the fill
reservoir toward the vent port.

%

When pipetting the reagents into
the array card, pipette the entire
100-pL volume into the fill
reservoir, but do not go past the
first stop of pipettor plunger or
you may blow the solution out of
the port.

>
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<
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IMPORTANT! Do not allow the tip to contact and possibly damage the
coated foil beneath the fill port.

5. Centrifuge and seal the array card (see “Fill the calibration array cards” on
page 30).

6. Run the prepared array card as soon as possible after filling it. Store the array
card in a dark place until you are ready to run it.

IMPORTANT! Do not expose the array card to light until you are ready to run it. The
fluorescent dyes in the array card are photosensitive. Prolonged exposure to light can
diminish the fluorescence of the dye.

Run the experiment

1. In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security 71



Chapter 2 Calibration and maintenance
Verify the instrument performance

3. After the instrument is added to your list, select it, then click Manage
Instrument.

4. In the Instrument Manager, start the RNase P wizard:
a. Click Maintenance, then click RNase P Run.

b. In the RNase P Run screen, click Start RNase P Run.

5. Complete the calibration as
instructed by the wizard. When the
side door opens, load the RNase P
plate or array card. Ensure that the
plate or array card is properly
aligned in the holder.

* Load 96/384-well plates with
the A1 position at the top-left
corner of the plate adapter.

T
[e]e}
[e]e}
[e]e}
[e]e}
[e]e}
[e]e}
Q0
00

* Load both plates and array cards with the bar code facing the front of the
instrument.

IMPORTANT! Plates should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

6. After loading the plate or array card, start the calibration:

a. In the Overview screen, select Check the box when the RNase P
calibration plate has been loaded, then click Next.

b. In the Run screen, click START RUN to start the calibration.

IMPORTANT! Do not attempt to open the access door during the run. The door
is locked while the ViiA™ 7 Instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to
10 minutes) to allow the heated cover to reach temperature.

7. When the run is complete and the QuantStudio™ Real-Time PCR Software
displays the Analysis screen, verify the status of the run:

e Passed—The ViiA"™ 7 System passed the RNase P run. Go to step 12.

* Failed—The ViiA™ 7 System failed the RNase P run. Go to step 8 to review
the data for outliers.

If the run fails, the software may have included outliers that caused the initial
analysis to fail. Experimental error may cause some wells to be amplified
insufficiently or not at all. These wells typically produce C; values that differ
significantly from the average for the associated replicate wells. If included in the
calculations, these outlying data (outliers) can result in erroneous
measurements.
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In the Amplification Plot, select Ct vs. Well from the Plot Type menu, then verify

the uniformity of each replicate population on the reaction plate (controls,
standards, and unknowns) by comparing the groupings of C; values:

a. In the plate layout, select the wells containing Unknown Population A:

¢ 96-well plate—Select rows A through C (5000-copy population).
¢ 384-well plate—Select columns 7 through 15 (5000-copy population).
* Array card—Select rows C and D (800-copy population).

b. In the plot, verify that the C;s of the replicate population are equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the
reaction plate. Beginning with well A1, the wells are numbered from left-to-
right, and top-to-bottom.

. If an outlier is present in the selected population, select the corresponding

well of the plate layout, then click Omit to remove the well from the
analysis. If the total number of outliers for the replicate population exceeds
the limit in the table below, repeat the experiment using another RNase P
plate or array card.

Maximum number of outlier wells that can be removed
Sample block Unknov.vn UnknoYvn Standard No template
population population (STD) controls
Al Bl2l (NTC)
96-well plate 6 6 163 0
384-well plate 10 10 2Bl 0
Array card 4 4 413] 0

[l 5000-copy population for 96/384-well plates; 800-copy population for array cards.
2 10000-copy population for 96/384-well plates; 1600-copy population for array cards.
Bl Maximum number of wells that can be removed from each standard population.

. Repeat substep 8a through substep 8c for each replicate population

(unknowns, standards, and no template controls) on the plate or array card.

9. Review the Results Table for quality flags generated by the experiment:

a. Select the Results Table tab.

b. Review the Flag column for wells that generated quality flags.

c. Troubleshoot each well that generated a flag as explained in “Troubleshoot

the RNase P experiment” on page 75.
* AMPNC—Amplification in negative control
e BADROX"—Bad passive reference signal
* BLFAIL—Baseline algorithm failed
* CTFAIL—C; algorithm failed
e EXPFAIL—Exponential algorithm failed
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¢ HIGHSD—High standard deviation in replicate group
* NOAMP —No amplification

* NOISE—Noise higher than others in plate

* NOSIGNAL—No signal in well

* OFFSCALE—Fluorescence is offscale

¢ OUTLIERRG—Ouitlier in replicate group

* SPIKE—Noise spikes

* THOLDFAIL—Thresholding algorithm failed

10. If you omitted outliers, click Reanalyze to analyze the run.

If the status of the RNase P Run is “Failed” after performing step 8 through
step 10, repeat the RNase P experiment using a different RNase P plate. If the
problem persists, contact Technical Support.

11. Review the standard curve:
a. Select the Standard Curve tab.

b. Click the upper-left corner of the Plate Layout to select all wells.
c. Verify that the R2 value is greater than or equal to 0.990.

If the R2 value is less than 0.990, repeat the RNase P experiment using a
different RNase P plate. If the problem persists, contact Technical Support.

12. In the Analysis screen, click Next, remove the plate or array card when the ViiA™
7 Instrument ejects the tray arm, then discard the plate or array card.

it WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, be sure to wait until it
reaches room temperature.

IMPORTANT! If the instrument does not eject the plate, remove the plate as
explained in “Troubleshoot the RNase P experiment” on page 75.

13. Click Finish, then click Yes when prompted to save the experiment.
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Troubleshoot the RNase P experiment

Problem/symptom

Possible cause

Action

More than the
maximum number of
outliers are present in
RNase P data

Possible
contamination

Pipetting inaccuracy

Order a replacement TagMan™ RNase P plate or array card kit at
thermofisher.com. If the replacement RNase P plate or array card
fails, contact Technical Support for further assistance.

RNase P plate
verification run failed

Insufficient
centrifugation

Defective plate seal

& CAUTION! PHYSICAL INJURY HAZARD. During instrument
operation, the sample block can be heated to 100°C. Before
performing the following procedure, be sure to wait until the
sample block reaches room temperature.

1. Unload the RNase P plate or array card from the ViiA™ 7
Instrument.

/

Hold the plate or array card up to a light source, and
verify that all wells contain the same volume of fluid.

If there are differences in fluid volumes, check the heat
seal of the wells with lower volumes for signs of damage
or evaporation.

Also, compare the position of the wells that have lower
volumes with the outliers that you have removed from the
plate. If the well positions coincide, the heat seal on the
plate may be defective, resulting in the evaporation of the
associated samples.

3. Order a replacement TagMan™ RNase P plate or array
card kit at thermofisher.com. If the replacement RNase
P plate or array card fails, contact Technical Support for
further assistance.
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(continued)

Problem/symptom

Possible cause

Action

Instrument does not
eject the RNase P
plate

Adhesive cover may
have adhered the
plate to the heated
cover within the
instrument

Power off the instrument.

. Wait for 15 minutes, then power on the instrument and eject the

plate.

If the plate does
not eject, power
off and unplug
the instrument,
then open the
access door.

. Wearing powder-free gloves, reach into the instrument and

remove the plate from the heated cover, then close the access
door.

Perform a background calibration to confirm that the sample
block has not been contaminated.

Negative control well
displays the AMPNC
flag, indicating that
the well amplified

Contamination in one
or more PCR reaction
components
contained in the
negative control well

Order a replacement TagMan™ RNase P plate or array card kit at
thermofisher.com. If the replacement RNase P plate or array card
fails, contact Technical Support for further assistance.

Well displays the
BADROX" flag,
indicating the passive
reference signal is
unacceptable for the
normalization of the
reporter dye signal

* Droplets on the
sides of the wells

* Improper sealing
or seal leaks

* Condensation on
the reaction
plate

If a well is flagged, confirm the results:

. Select the flagged well(s) in the plate layout or well table.
. View the amplification plot (R, vs. Cycle), and review the data in

the C; region for abnormalities.

Examine the reaction plate to check for condensation and/or
inconsistent reaction volumes.

. Order a replacement TagMan™ RNase P plate or array card kit

at thermofisher.com. Repeat the experiment, and make sure
to properly seal and centrifuge the RNase P plate or array card.
If the replacement RNase P plate or array card fails, contact
Technical Support for further assistance.

Well displays the
BLFAIL flag,
indicating the
software cannot
calculate the best fit
baseline for the data

* Amplification too
late

¢ No amplification

If a well is flagged, confirm the results:

. Select the flagged well(s) in the plate layout or well table.
. View the amplification plot (R, vs. Cycle and DR, vs. Cycle) and

check for early, late, low, or no amplification.

. Order a replacement TagMan™ RNase P plate or array card kit

at thermofisher.com. Repeat the experiment, and make sure
to properly seal and centrifuge the RNase P plate or array card.
If the replacement RNase P plate or array card fails, contact
Technical Support for further assistance.
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Problem/symptom

Possible cause

Action

Well displays the
CTFAIL flag,
indicating the
software cannot
calculate the
threshold cycle (Cy)

Well displays the
EXPFAIL flag,
indicating the
software cannot
identify the
exponential region of
the amplification plot

* Amplification too
early

¢ Amplification too
late

* Low
amplification

¢ No amplification

If a well is flagged, confirm the results:

1.
2.

3.

Select the flagged well(s) in the plate layout or well table.

View the amplification plot (R, vs. Cycle and DR, vs. Cycle) and
check for early, late, low, or no amplification.

Order a replacement TagMan™ RNase P plate or array card kit
at thermofisher.com. Repeat the experiment, and make sure
to properly seal and centrifuge the RNase P plate or array card.
If the replacement RNase P plate or array card fails, contact
Technical Support for further assistance.

Well displays the
HIGHSD flag,
indicating the GC;
standard deviation for
the replicate group
exceeds the current
flag setting

¢ Droplets on the
sides of the wells

* Improper sealing
or seal leaks

* Condensation on
the reaction
plate

®* |nconsistent
volumes across
the plate

Well displays the
NOAMP flag,
indicating the sample
did not amplify

¢ Missing template

¢ Excitation source
in the instrument
stopped
functioning

Well displays the
NOISE flag, indicating
the well produced
more noise in the
amplification plot
than other wells on
the plate

¢ Droplets on the
sides of the wells

* Improper sealing
or seal leaks

* Condensation on
the reaction
plate

If a well is flagged, confirm the results:

1.

Select the flagged well(s) and the associated replication
group(s) in the plate layout or well table.

View the amplification plot (R,, vs. Cycle), and review the data
for abnormalities.

Hold the plate or
array card up to a
light source, and
check for
condensation or
evaporation.

If there are
differences in
fluid volumes,
check the heat
seal of the wells
with lower volumes for signs of damage or evaporation.

/

Order a replacement TagMan™ RNase P plate or array card kit
at thermofisher.com. Repeat the experiment, and make sure
to properly seal and centrifuge the RNase P plate or array card.
If the replacement RNase P plate or array card fails, contact
Technical Support for further assistance.
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(continued)

Problem/symptom

Possible cause

Action

Well displays the
NOSIGNAL flag,
indicating the well
produced very low or
no fluorescence
signal

Missing reaction mix
resulting from
pipetting error

If a well is flagged, confirm the results:

1. Consider omitting the well from the analysis.

2. Note the location for each flagged well, and check each
corresponding well in the reaction plate for evaporation or low
reaction volume.

3. Order a replacement TagMan™ RNase P plate or array card kit
at thermofisher.com. If the replacement RNase P plate or
array card fails, contact Technical Support for further
assistance.

Well displays the
OFFSCALE flag,
indicating the
fluorescence signal
for one or more dyes
in the well exceeds
the instrument’s
maximum detectable
range for one or more
cycles

* Fluorescent
contaminant on
the reaction
plate or sample
block

® Fluorescent
contaminant in
the reaction

1. Perform a background calibration. If you detect fluorescent
contamination, decontaminate the sample block.

2. Order a replacement TagMan™ RNase P plate or array card kit
at thermofisher.com. If the replacement RNase P plate or
array card fails, contact Technical Support for further
assistance.

Well displays the
OUTLIERRG flag,
indicating the C; of
the well deviates
significantly from G
values in the
associated replicate
group (only the outlier
is flagged)

* Contamination

* Improper sealing
or seal leaks

1. Decontaminate the work area and pipettors.

2. Order a replacement TagMan™ RNase P plate or array card kit
at thermofisher.com. Repeat the experiment, and make sure
to properly seal and centrifuge the RNase P plate or array card.
If the replacement RNase P plate or array card fails, contact
Technical Support for further assistance.

Well displays the
SPIKE flag, indicating
the ampilification
curve contains one or
more data points
inconsistent with the
other points in the
curve

* Bubbles in the
reaction

e Evaporation
during the
denaturation
step because of
improper sealing
or seal leaks

Order a replacement TagMan™ RNase P plate or array card kit at
thermofisher.com. Repeat the experiment, and make sure to
properly seal and centrifuge the RNase P plate or array card. If the
replacement RNase P plate or array card fails, contact Technical
Support for further assistance.
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(continued)
Problem/symptom Possible cause Action
Well displays the * Amplification too | If a well is flagged, confirm the results:
THOLDFAIL flag, sarly 1. Select the flagged well(s) in the plate layout or well tabl
indicating that the e Amplification too . Select the flagged well(s) in the plate layout or well table.
software cannot late 2. View the amplification plot (Rn vs. Cycle and DRn vs. Cycle),
calculate the L and check for early, late, low, or no amplification.
* Low - .
threshold I 3. Order a replacement TagMan * RNase P plate or array card kit
amplification .
o at thermofisher.com. If the replacement RNase P plate or
* No amplification array card fails, contact Technical Support for further
assistance.
Instrument Multiple possible Contact a local Thermo Fisher Scientific Field Service Office.
malfunction causes
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Networking

Access the Help system by pressing F1, by clicking in the toolbar of the
QuantStudio™ Real-Time PCR Software window, or by selecting Help » Contents
and Index.

IMPORTANT! This chapter does not provide adequate detail to integrate the ViiA™ 7
Real-Time PCR System into all possible network architectures. Because your network
may contain advanced features (such as a firewall or network domains), we
recommend that you consult a network administrator before connecting the ViiA™ 7
System to your laboratory network.

Networking overview

After installing the ViiA™ 7 System, you can connect the ViiA"™ 7 System to a local
area network to enhance its functionality.

This chapter describes how to:
* Set up the ViiA™ 7 System for use on a network.
® Set up a computer for remote monitoring.
* Test the network connection by engaging the remote monitoring feature.

Controlling and monitoring networked ViiA™ 7 instruments

80

When the ViiA™ 7 Instrument is connected to a network, computers on the network
that are running the QuantStudio™ Real-Time PCR Software can control or monitor it.
The QuantStudio™ Real-Time PCR Software can control up to 4 instruments and
monitor up to 15 instruments simultaneously. A networked ViiA™ 7 Instrument can be
controlled by only one computer at a time. A networked computer running the
QuantStudio™ Real-Time PCR Software can transfer experiments to and from an
instrument, begin or stop a run, and perform some maintenance functions. During a
run, the Remote Monitoring feature of the software can be used to view the run
status, temperature, and amplification data in real-time. See “Monitor the ViiA™ 7
instrument” on page 86 for more information on remote monitoring.

Note: Remote monitoring does not allow you to control the ViiA™ 7 System.
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About the ethernet 1 port

The ViiA™ 7 Instrument features a Gigabit Ethernet 1 port for direct communication
with the ViiA™ 7 System computer and for network communication. When the ViiA™ 7
System is connected to a network, computers on the network that run the software
can:

e Send and download experiments to/from the ViiA™ 7 System.
* Run experiments on the ViiA"™ 7 System.
* Remote monitor the ViiA™ 7 System as it performs runs.

The Ethernet 1 port of the ViiA™ 7 Instrument supports:

e Static IP network service with subnet mask, primary and secondary data
network service (DNS), and default gateway settings, or dynamic host
configuration protocol (DHCP) network service

* mDNS/DNS for local domains

Note: Because mDNS is limited to direct network connections, a ViiA" 7 System
set for mDNS may not be visible to other nodes that are separated by a router,
hub, or another network device.

* |Pv4 link-local (IPV4LL) in the RFC (also known as Automatic Private IP
Addressing [APIPA] or Internet Protocol Automatic Configuration [IPAC])

Note: When the ViiA™ 7 System is set for DHCP, APIPA is automatically enabled,
and the ViiA™ 7 System provides an IP address when no address is supplied by
the DHCP server.

Example network layouts

Example 1

In the following example, a one or more ViiA™ 7 Instruments, which have been
configured for dynamic host configuration protocol (DHCP) operation, are connected
to a network by their Ethernet 1 ports. In this layout, any computer on the network
can monitor or control the ViiA™ 7 Instrument. Experiments can be started remotely
from the networked computer or locally from the ViiA™ 7 Instrument touchscreen.

Note: A networked computer running the software can simultaneously control up to
4 instruments and monitor up to 15 instruments that have been connected to the
network.
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Example 2

The ViiA™ 7 System computer can be connected to the network. In the configuration
shown below, computers on the network can exchange experiment data with the
ViiA™ 7 System computer; however, the ViiA™ 7 Instrument can be neither monitored
nor controlled remotely because it is physically isolated from the network.

Networking guidelines and best practices

82

Consult a network administrator.

- We recommend that you consult a network administrator before connecting
the ViiA™ 7 System to your laboratory network.

— To enable the full functionality of the software, the computer requires a
network connection.

Limit remote monitoring to 10 computers.

Avoid using more than 10 computers to simultaneously monitor the ViiA™ 7
Instrument remotely. Although the ViiA™ 7 System supports remote monitoring
from multiple computers, each connection taxes the instrument microprocessor.
Too many connections can overburden the ViiA™ 7 System and result in
instrument errors.

Note: The effects of an overburdened ViiA™ 7 System are evident in the
Temperature Plot during a run. Symptoms can include extended hold times or
brief, unexpected plateaus in the instrument Temperature Plot.

Observe the restrictions to mDNS and Autodiscovery.

The ViiA™ 7 System supports mDNS but only when the ViiA™ 7 Instrument and
computer share a direct network connection and are within the same subnet.
Consequently, network computers that are separated from the ViiA"™ 7 System
by a router, hub, or another network device may not be able to access the ViiA™
7 Instrument by its host name.

Confirm the uniqueness of the instrument name.

The ViiA™ 7 Instrument does support name resolution but the instrument name
must be unique within the subnet. The software can automatically discover ViiA™
7 Instruments on the link-local network that are configured for Autodiscovery
(see “Define the network settings” on page 139).

Note: The ViiA" 7 System does not test the uniqueness of the instrument name
when it is set.

Name ViiA™ 7 Instruments using lower-case letters.

When you define the ViiA™ 7 Instrument settings (see “Define the instrument
settings” on page 137), enter the instrument name using lower-case letters only.
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Network setup workflow

1. Collect the required network information.
2. Connect the ViiA™ 7 Instrument to the network.
3. Connect the computer to the network.

4. Monitor the ViiA™ 7 Instrument (to test the network connection).

Collect the required network information

Obtain the following information from your network administrator:

* Network policy for obtaining IP addresses (DHCP or static IP).

IMPORTANT! When the ViiA™ 7 System is set for DHCP, APIPA is automatically
enabled and the ViiA™ 7 System will self assign an IP address when no address
is supplied by a DHCP server.

¢ [f the network requires static IP addresses, obtain the IP address, subnet mask,
and gateway address for the ViiA™ 7 Instrument.

Connect the ViiA"™ 7 instrument to the network

After deciding how to connect the ViiA™ 7 System to a network, set up the ViiA™ 7
System according to your network policies.

Materials required

Ethernet cable with RJ45 connectors (a CAT6 Ethernet cable for a 1000Mbit/s
network connection or a CAT5 for 100Mbit/s connection)

Define the ViiA™ 7 instrument internet protocol settings

1. Use the Ethernet cable to connect the Ethernet 1 port of the ViiA™ 7 Instrument
to the nearest network port.

IMPORTANT! Do not connect the Ethernet cable to the Ethernet 2 port on the
ViiA™ 7 Instrument. The second port is for Applied Biosystems™ use only.

2. Power on the ViiA™ 7 Instrument.

3. Use the ViiA™ 7 Instrument touchscreen to configure the network settings as
described in “Define the network settings” on page 139.
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Connect the computer to the network

After connecting the ViiA™ 7 Instrument to the network, connect the computer to the
network and install the QuantStudio™ Real-Time PCR Software for remote
monitoring.

Materials required

Ethernet cable with RJ45 connectors

Computer requirement

If you are connecting a computer that you provided to a network, confirm that the
computer contains a free network port.

Collect required information

Obtain the following information from your network administrator:
* Network policy for obtaining IP addresses (DHCP or static IP)

* |f the network requires static IP addresses, obtain the IP address, subnet mask,
and gateway address for the computer

Set up the computer

IMPORTANT! We recommend that you arrange for a network administrator to
connect your computer to the network. The following procedure does not provide
adequate detail for all network architectures.

1. Use the Ethernet cable to connect the computer to the nearest network port.

2. Power on the computer, then log in using a user account that belongs to the
Administrators user group.

3. In the computer desktop, right-click My Network Places, then select
Properties.

4. Right-click Local Area Connection, then select Properties.

5. Select Internet Protocol (TCP/IP), then click Properties.
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6. Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP
communication:

Network

. : Action
configuration

1. Select Obtain an IP address automatically.

2. Set the DNS address. If the computer obtains DNS
addresses:

DHCP ¢ Automatically — Select Obtain DNS server address
automatically.

e Statically — Select Use the following DNS address,
enter the address of the preferred and alternate
DNS servers if available.

Select Use the following IP address.
In the IP Address field, enter the static IP address.

Static IP If necessary, enter a subnet mask.

> W N2

If necessary, enter a static gateway address in the
Default Gateway™ field.

7. If your network requires advanced TCP/IP setup (such as WINS), define the
settings:

a. Click Advanced in the Internet Protocol (TCP/IP) Properties dialog box.

b. Define the IP Settings, DNS, and WINS tabs as instructed by your systems
administrator, then click OK.

8. Close all dialog boxes by clicking OK.

9. Restart the computer.
The computer is now visible to other computers on the network.

Install the QuantStudio™ Real-Time PCR Software

Note: If you are installing the software to a computer that does not contain a
previous installation, you must have a license file supplied by Thermo Fisher
Scientific. If you do not have a license file, obtain one as explained in “Manage
QuantStudio™ Real-Time PCR Software licenses” on page 120. If you are installing a
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software update, the update automatically acquires the software license from the
existing installation.

Note: You must install the QuantStudio™ Real-Time PCR Software to monitor the
ViiA™ 7 System over a network.

1. Go to thermofisher.com/gpcrsoftware.

2. In the Real-Time PCR section, Applied Biosystems™ ViiA™ 7 Real-Time PCR
System.

3. Click Download.

4. Install the QuantStudio™ Real-Time PCR Software according to the instructions
that download with the software.

5. (Optional) Install protective software to the computer.

Monitor the ViiA" 7 instrument

After connecting the ViiA™ 7 System and a computer to the network, you can enable
remote monitoring in the QuantStudio™ Real-Time PCR Software to observe the
instrument status remotely.

About remote monitoring

86

When the ViiA™ 7 System is connected to the network, any computer on the network
that is running the QuantStudio™ Real-Time PCR Software can:

e “Monitor the status of ViiA™ 7 instrument during a run” on page 87

e “Upload or download an experiment or template to a ViiA™ 7 instrument” on
page 87

¢ “Enable or change the calibration reminders” on page 88

Guidelines for remote monitoring
To ensure optimal performance of the remote monitoring feature, observe the
following guidelines:

* The software can monitor up to 15 instruments.

* We do not recommend that a ViiA™ 7 Instrument be monitored by more than
10 computers simultaneously.

* Unless you are sure that your ViiA™ 7 Instrument and computer exist on the
same subnet, we recommend that you use the IP address of the ViiA™ 7
Instrument to add it for remote monitoring.
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Monitor the status of ViiA™ 7 instrument during a run

1.

In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

Note: You must add an instrument to your list before you can manage it.

After the instrument is added to your list, select it, then click Manage
Instrument.

In the Instrument Manager, click Monitor, then click Information.

In the Monitor Instrument screen, click Monitor Running Experiment.

The QuantStudio™ Real-Time PCR Software displays the status, attributes,
calibration status, and plot data for the selected ViiA™ 7 System. If a
communications warning appears, contact your network administrator to
troubleshoot the problem.

You can lose the software connection to the ViiA™ 7 Instrument if you:

Change the ViiA™ 7 Instrument that is connected directly to your computer

Use the touchscreen to change the instrument name or IP address

Note: To reestablish the connection, restart the QuantStudio™ Real-Time PCR
Software.

Upload or download an experiment or template to a ViiA™ 7 instrument

Note: The ViiA™ 7 Instrument can store up to 100 gene expression experiments.

Before sending an experiment, confirm that the instrument contains sufficient storage

space.
1. In the Home screen of the software, click Instrument Console.
2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.
Note: You must add an instrument to your list before you can manage it.
3. After the instrument is added to your list, select it, then click Manage
Instrument.
4. In the Instrument Manager, click Manage Files, then click File Manager:
5. In the File Manager screen, transfer the file(s):

To upload a file to the instrument:

a. In the Folders field, select the folder to which you want to upload the file. To

create a new folder, click Create, then enter a name for the new folder.
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b. Click Upload, select the experiment or template file to send to the
instrument, then click Open.

To download a file from the instrument:

1. In the Folders field, select the folder that contains the files that you want to
download.

2. In the Experiments field, select the files that you want to download. To
select multiple files, Ctrl-click or Shift-click files in the list.

3. When you have selected the files that you want to download, click
Download.

4. In the Send experiment to instrument dialog box, select the folder to which
you want to download the selected file(s), then click Open.

Note: You can also use the Folders and Experiments fields to:
. Create or remove directories on the instrument

. Add, delete, or download experiments on the instrument

Enable or change the calibration reminders

The calibration reminders settings allow you to configure the QuantStudio™
Real-Time PCR Software to alert you by email when the ViiA™ 7 Instrument requires
calibration. The notifications settings feature is optional, and it does not affect
performance.

IMPORTANT! The QuantStudio™ Real-Time PCR Software transmits email only
while the ViiA™ 7 Instrument is monitored. If the network connection is interrupted,
the software stops transmitting updates.

Collect the required information

The software requires access to a Simple Mail Transfer Protocol (SMTP) server to
email calibration reminders. Contact your systems administrator or information
technology department for the following information:

* Network address of a SMTP server.
* A user name and password for the server, if required for access.
* The Secure Sockets Layer (SSL) setting of the server (on or off).

Define the mail server settings

1. In the software, select Tools » Preferences.

2. In the Preferences dialog box, select the SMTP Settings tab.
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3. In the SMTP Settings tab, define the settings for the SMTP server:

* Outgoing Mail Server (SMTP) field — Enter the network address of a
Simple Mail Transfer Protocol (SMTP) server. Optionally, you can specify the
transmission control protocol (TCP) port for the server by appending the
port number to the server name, separating the two using a colon (; ).

For example: smtp.mycompany.com:2023

Note: If a TCP port is not specified, the software uses the default port
number (25).

¢ Encryption Required? — Select if the mail server has SSL enabled.

* Authentication Required? - Select if the mail server requires a user name
and password.

* User Name and Password fields - If the mail server requires
authentication, enter the user name provided by your systems administrator.

4. Click OK.

Modify the notification settings for a monitored ViiA™ 7 Instrument

1. Open the Calibration Reminders screen for the ViiA™ 7 Instrument:
a. In the Home screen of the software, click Instrument Console.

b. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.
Note: You must add an instrument to your list before you can manage it.

c. After the instrument is added to your list, select it, then click Manage
Instrument.

d. In the Instrument Manager, click Maintenance, then click Calibration
Reminders.

2. In the Calibration Reminders Setting table, configure the notification settings for
the calibrations in interest. For each calibration that you want to monitor:

a. In the Expiry Interval column, enter the number of days that elapse before
the type of calibration expires on the instrument.

b. In the Send a Reminder column, select the check box to configure the
software to email a reminder to perform the calibration.

c. In the Reminder Interval column, enter the number of days that elapse
before the software emails recipients a reminder to perform the calibration.

3. In the Enter e-mail addresses for notifications field, enter the email address(es)
that you want to receive email notifications. Separate multiple email addresses
with commas (, ).

4. Click Apply to change the notification settings.
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Security, audit, and electronic
signature

Administrators overview

IMPORTANT! The Security, Audit, and Electronic Signature (SAE) module is
installed only with ViiA™ 7 Real-Time PCR Systems that were purchased with the SAE
module.

IMPORTANT! Enabling the Security, Audit, and Electronic Signature module alone
does not make the ViiA™ 7 System compliant with any particular standard. You must
modify the module settings according to your requirements to ensure compliance.

The Security, Audit, and Electronic Signature (SAE) module is an optional component
of the QuantStudio™ Real-Time PCR Software that can allow you to configure the
ViiA™ 7 System to meet specific requirements. The module provides the following
functionality:

Security— Controls user access to the software. A default Administrator user
account is provided, and additional user accounts and permissions can be user-
defined.

Note: The default password for the Administrator user account is Administrator;
however, the password can be changed during installation.

Note: You can enable or disable system security globally.

Auditing—Tracks changes made to library items, actions performed by users,
and changes to the Security, Audit, and Electronic Signature settings. The
software automatically audits some actions silently. You can select other items
for auditing and specify the audit mode. The Auditing function provides reports
for audited library items, Security, Audit, and Electronic Signature changes, and
actions.

Note: You can enable or disable auditing globally and by record type. It is
disabled globally by default.
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* Electronic signature (e-sig)—Determines if users are required to provide a user
name and password when performing certain functions. You can configure e-sig
so that a user can print a report or start a run only if the associated data are
signed. You can also configure each e-sig event to require multiple signatures
and to require users with specific permissions to sign.

Note: Electronic signature can be enabled or disabled globally. It is disabled
globally by default.

Example applications

You can configure the SAE module in a variety of ways. For example, you can:
* Require users to log in, and leave audit disabled.
* Allow only certain users to create or modify protocols.
* Allow only certain users to approve reviewed samples.

* Require experiments to be signed before users can run or print them.

Configure the security system

Access the security screen and enable or disable security

Use the Security screen to disable and enable security, control restrictions and
security policies for all user accounts, and set up notifications when certain security
events occur.

IMPORTANT! If you disable security, you inactivate audit and electronic signature
functions; however, no audit record is generated to indicate that audit and electronic
signature functions are disabled.

Note: Security is enabled by default.

To enable or disable security:

1. In the software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the System tab.

3. Select or deselect Enable Security. Note the following:
¢ Disabling Security inactivates Auditing and E-Signature.
* The enable commands are grayed when a run is in process.
* When security is disabled, the is not active in lower parts of the screen.

* The software requires you to enter your user name and password when you
enable security.
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4.

IMPORTANT! If you enable or disable the software security, auditing, and
electronic signature feature, you must similarly enable or disable the ViiA™ 7
Instrument security (see “Enable or disable instrument security” on page 141).
The software cannot connect to ViiA™ 7 Instruments that do not match security
settings.

Click Apply Settings.

Set account setup and security policies

Note: Security policies apply to all user accounts.

1.

2.

7.

In the software, select Tools » Security » Settings.

In Account Setup, specify User Name limits.

IMPORTANT! The software allows spaces in user names. Use spaces in user
names with caution. For information, see “Spaces in user names and/or
passwords” on page 93.

Specify User Password limits:
a. Specify the passwords length limits.

b. Specify password reuse. You cannot disable the password reuse restriction.

c. Specify the allowed characters in user passwords: spaces and alphabetical,
numeric, uppercase, lowercase, and special characters (commas, periods,
semicolons, dashes, underscores, and tildes).

In Security Policies, specify Password Expiration, Account Suspension, and
Session Timeout settings.

Note: A session times out while a run is in progress if the time-out period is
exceeded and there is no other user activity.

In the Open Non-Secure Data option, select Yes or No to determine whether
users can open experiments and templates that were created without security
settings.

Click Set Up Messaging Notification Settings to specify when and how the
software notifies the administrator of certain security events. For information,
see “Set up messaging notifications” on page 93.

Click Apply Settings.

The new settings are applied to the user account the next time that the user logs in.
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Spaces in user names and/or passwords

If you allow spaces in user names and/or passwords, be aware of the following
issues:

* |eading and trailing spaces in user names are difficult to detect on the screen or
in printed reports.

* The number of consecutive spaces in a user name is difficult to determine on the
screen or in printed reports.

Spaces in user names may cause confusion when a user searches for an audit record
associated with a user name. To find a record associated with a user name, specify
the user name exactly, including leading, consecutive, and trailing spaces.

Set up messaging notifications

1. In the software, select Tools » Security » Settings.

2. In the Security screen, click Set Up Messaging Notifications to display the
Setup Notifications dialog box.

3. Select the events for notification:

* System security enabled or disabled —Security has been enabled or
disabled.

¢ User did not enter correct password—A user attempts to log in with an
incorrect password. The message indicates the number of failed
authentications.

* User account suspended—The user exceeds maximum number of
allowed failed authentications (login attempts with an incorrect password).

* User session timed out—No activity occurred in a user account for the
specified period of inactivity.

4. Select the notification method:

* Notify Admin at Login—If an event triggers notification, the next time any
user with an Administrator role logs in, the software lists those events,
indicating the time each event occurred and the user who triggered the
event.

The Administrator has the option of acknowledging the event, which
removes it from the notification list.

¢ Email Notification—If an event triggers notification, the doftware sends an
email to the addresses in the adjoining Email Address column of the table.
The email notification displays the triggered event and displays the time that
the event occurred and the user who triggered the event.

5. Click OK.

Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security 93



Chapter 4 Security, audit, and electronic signature

Administrators

Manage user accounts

Create or edit a user account

The software includes a default Administrator user account with permissions (defined
by the account user role) to perform all functions in the software. You cannot modify
this account.

Create a user account

—

In the software, select Tools » Security » Settings.

In the Security Settings dialog box, select the Users tab.

Click Create to display the New User dialog box.

Enter user name, password, first name, middle initial (optional), and last name.

Click a field to display the field limits, which are specified in Security settings.

Note: First name, Ml (middle initial), and last name are used to create User Full
Name, which is displayed as the name of the logged-in user.

Note: You cannot change the user name after you save the user account.

Select Password Expires at First Login to require the user account to specify a
new password at first log in. The Password Expires On date is specified in
Security settings.

Select the user role (described in “Create or edit a user role” on page 95) and
the electronic signature state (determines if a user account has permission to
electronically sign objects).

Leave the status set to ACTIVE.
(Optional) Enter email (for information only), phone, and comments.

Click Save.

A grayed Save button indicates an invalid entry in a field. Click a field to display
the limits for the field, then enter a valid entry.

Edit a user account

1.

In the Users screen, select a user account, then click Edit.

Note: If you select multiple users, only Status and Role will be changed.
Edit settings as needed. You cannot edit the user name of an existing user.

Click Save.
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Activate a suspended user account

1. In the Users screen, select the user.
2. Click Edit.

3. Change the Status from SUSPENDED to ACTIVE, then click Save.

Disable (inactivate) a user account

IMPORTANT! You cannot delete a user, because user records are required for
auditing. To disable a user account, inactivate it as follows.

1. In the Users screen, select the user.
2. Click Edit.

3. Change the Status from ACTIVE to INACTIVE, then click Save.

Determine the name of the logged-in user

The title bar of the software window displays the name of the user.

Create or edit a user role

User roles determine the permissions associated with a user account. The software
includes three default user roles:

* Administrator (cannot be edited or deleted)
¢ Scientist
® Technician

You can modify the Scientist and Technician roles, and you can create your own roles
with customized settings as needed. To determine the permissions for a default role
or to edit it, select the role, then click Edit.

Create a user role

1. In the QuantStudio™ Real-Time PCR Software, select
Tools » Security » Settings.

2. In the Security Settings dialog box, select the Roles tab.
3. Click Create.

4. Enter a role name and (optional) description.
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5. Select permissions (see “Permissions and default user roles” on page 96). To
select all permissions in a category, select the check box next to the category.
Note: Operations not shown in the following table are available to all user roles.
6. Click Save Role.
Permissions and default user roles
The following table shows all user-configurable permissions and the settings for the
QuantStudio™ Real-Time PCR Software default user accounts.
Permissions Default user roles
Category Function Scientist Technician Administrator
Create and edit experiments or
experiment templates (includes Yes Yes Yes
running experiments)
Print, create slides, and print report Yes Yes Yes
Setup
Export experlmenltal resglts, audit Yes Yes Yes
reports and security settings
Cregte, edit, and import sample Yes Yes Yes
attributes
Perfo.rm a run using the Quickstart Yes Yes Yes
function
Run Start arun Yes Yes Yes
Stop a run Yes Yes Yes
Create targets Yes Yes Yes
Targets (Library) | Edit targets Yes Yes Yes
Delete targets Yes No Yes
Create anal}/3|s settings (includes Yes Yes Yes
default settings)
'(AI‘_?;IZSIT Settings Edit analysis settings (includes Yes Yes Yes
& default settings)
Delete analysis settings Yes No Yes
Run Methods Create a run method Yes Yes Yes
(Library) Delete a run method Yes No Yes
Create a custom dye Yes Yes Yes
Dye (Library) Edit a dye Yes Yes Yes
Delete a dye Yes No Yes
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(continued)
Permissions Default user roles
Category Function Scientist Technician Administrator
Crgate or edit a study (for gxample, Yes Yes Yes
edit a plate or analysis settings)
Study Add (transfer) experiments to a study Yes Yes Yes
Remove experiments from study Yes Yes Yes
Preferences Edit the system preferences Yes No Yes
Calibrations Perform calibrations Yes Yes Yes
RNaseP Perform an RNase P experiment Yes Yes Yes
Instrument Add or remove ViiA™ 7 Instrument
: . o No No Yes
Configuration from monitoring
Configure the security and audit No No Yes
feature
Security Log into user sessions that have
Configuration . 9 No No Yes
timed out
Perform E-Signing Yes Yes Yes
Manage Control L.|brary (add, edit, Yes Yes Yes
delete, delete all, import, or export)
Manage Sample Iflbrary (add, edit, Yes Yes Yes
delete, delete all, import, or export)
Manage SNP Assay Library (add,
. . edit, delete, delete all, import AlF, or Yes Yes Yes
Libraries
export)
Manage Target Library (add, edit,
delete, delete all, import AlF, or Yes Yes Yes
export)
Manage Analysis Settings Library Yes Yes Yes

(delete or delete all)

Edit a user role

1. In the Roles screen, select a user role, then click Edit.

2. Edit settings as needed. You cannot edit the Administrator user role.

3. Click Save Role.
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View and print a user report

1. In the software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the Users or Roles tab.
3. Click View Report.

4. In the Report screen, click tool bar options to manipulate the report as needed.
Place the mouse pointer over an item for a description of the item.

5. Click (Print) to print the report, or click  (Save) to save the report
electronically (PDF). Close the report.

Manage auditing

Access the audit screen and enable or disable auditing

Use the Audit screen to control the auditing state (enabled/disabled), the events that
are audited, and the reasons available to users when audit mode is set to Prompt or
Required. Auditing is disabled by default.

IMPORTANT! If you disable security, you inactivate audit functions. No audit record
is generated for the inactivation of audit and electronic signature functions when you
disable security.

1. In the QuantStudio™ Real-Time PCR Software, select
Tools » Security » Settings.

2. In the Security Settings dialog box, select the Audit tab.
3. Select or deselect Enable Audit.
4. Click Apply Settings.

Select objects to audit

1. Select the objects to audit and the mode for each enabled item.
* Experiments
¢ Experiment Templates
e Study
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2. Set the Audit Mode for each item you enable for auditing:

* Optional - The event is audited, a reason prompt is displayed, but the user
can cancel and continue without entering a reason.

* Required — The event is audited, a reason prompt is displayed, and the user
must specify a reason.

* Silent - The event is audited, no reason prompt is displayed.

3. Click Apply Settings.

Create audit reason settings

You can create, modify and delete the reasons that are available for selection in the
Audit Reason dialog box (displayed when a user performs an audited action).

1. To require users to select a pre-defined reason in the Audit Reason dialog box
(displayed when a user performs an audited action), enable Require users to
select a reason to change from the list. Users are not permitted to enter a
reason.

2. As needed, click Create, or select a reason from the list, then click Edit or
Delete.

Generate audit reports

You can use the software to generate reports of audit history from both the Security
Settings dialog box and open experiments, templates, or studies.

* “Display audit histories from the security settings dialog box” on page 99
* “Display audit histories for an experiment, template, or study” on page 103

Display audit histories from the security settings dialog box
Display audit histories

1. In the software, select Tools » Security » Settings.

2. In the Security Settings dialog box, select the Audit tab, then click View
Reports.

Note: To access the Audit Reports screen, the user role for an account must
specify the Configure SAE permission. Users without the Configure SAE
permission can view object audit histories for individual entries in the libraries by
selecting entries, then clicking View Audit History.

3. Select a tab to display:

¢ System Configuration History—Security, audit, and electronic signature
configuration records, including audit history for each user account.

¢ Action Record—System-specified audit events.
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4. (Optional) Select Filter by, then filter the table:
* Sort the table.

* Specify filters (date range, user name, action, object or record type, object
or record name, reason), then click Refresh.

Note: The Reason field in System Configuration History is not used.

® Select one or more records, then click View Report.

Review the system configuration history

The System Configuration History lists security, audit, and electronic signature
configuration records.

Record type Action Corresponds to...

Disable, enable, or modify security policies:

Security Settings Update session timeout settings.

Modify password settings, security policies
Account Settings Update | (password expiration and account suspension), or
user name settings

User Group Manager Update | Create, delete, or modify reason for change

Create Create user role

User Role Delete Delete user role

Update | Modify user role

Create Create new user account

User Account
Update | Edit or suspend a user account

Assign a different user role to an existing user
Delete

account
Role Assignment
Create a user account, or assign a different user
Update .
role to an existing account
Audit Settings Update | Enable or disable auditing
Audit Type Update | Modify audit settings

Function Management

Settings Update |Update function management

Function Access

Manager Update | Update function access management

Create Create function

Function Delete Delete function

Update | Update function
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Record type Action Corresponds to...
Create | Create a user rolel]
Role Permissions Delete | Delete a user rolel!

Update | Modify user role permissions

Audit Reason for Delete Create reason for change

Change Update | Delete or modify reason for change
Event Manager Update | Update the event manager
E-signature Manager Update |Enable or disable e-signature

Create |Create an e-signature meaning

E-signature Type Delete | Delete an e-signature meaning

Edit an e-signature meaning or an e-signature

Update action

E-signature Function Update | Edit an action requiring e-signature

[ Creates one role assignment record for each permission in a role.

Review the action log
The Action Record log lists system-specified audit events.

All items in the action log are audited silently, except for the items noted as
configurable. Configurable items may include comments in the action log.

* Audit Settings (Update)

* Auditing Event (Archive, Restore, Purge)

* Configuration (Import, Export)

* Data Audit (Archive, Restore, Purge)

® Login (Success, Failure)

* Logout (Success)

* Run (Start, Stop, Completed, Failed, Aborted, Error)
* User Account (Create, Update)

View and print audit reports
1. Select the System Configuration History tab.
2. Display the records of interest.

3. Filter the list to decrease the time required to generate reports.

IMPORTANT! You cannot cancel a report after you click a view button.
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4. Click View Report.

5. In the Report screen, click tool bar options to manipulate the report as needed.
Place the mouse pointer over an item for a description of the item.

* To print the report, click (Print).
* To save the report electronically (PDF), click  (Save).

6. Close the report.

Archive, purge, and restore audit records

The audit archive function makes a copy of audit records. Purge makes a copy of
audit records, and then deletes them. You can use the Restore function to restore
purged audit records.

Archive and purge

To selectively archive or purge (delete) system configuration or action audit records:

1. Select the System Configuration History tab.

2. Select records in the appropriate screen.

3. Click Archive or Purge.

4. If you select Archive, specify a location and name for the archive file (.asz).

Restore

To restore system configuration or action audit records, click Restore, then select the
ASZ file to restore.

Export audit records

You can export audit records to a TXT file for additional manipulation and reporting
outside the software.

1. Display the records of interest as described above.
2. Click Export.

3. Specify a name and location for the export TXT file, then click Save.

Note: If you export audit records for samples that are not in their original
location (samples have been deleted or moved), an error message is displayed.
Return sample data files to their original location, then export again.
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Display audit histories for an experiment, template, or study
Display the audit history
1. In the software, open an experiment (EDS), template (EDT), or study (EDM) file.

2. In the open experiment, template, or study, click Audit, then click Audit
Records.

3. (Studies only) Select the audit records of interest:
® Study to view the audit records for the study.
* The name of an experiment to view the audit records for the experiment.

4. (Optional) Filter the table:
To view fewer records:
a. Check the Filter by check box.

b. Enter criteria for the records of interest, such as a date range, a user name,
or a type of action.

c. Click Refresh.

To view details for a specific record:

1. Click the row in the list on the left to view the details of the record in the
table on the upper right.

2. Click any row to view details for individual records in the table on the
bottom right.

Export audit records

1. In the software, open an experiment (EDS) or template (EDT) file.

N

In the open experiment, template, or study, click Audit.

3. In the table on the left, select the records to be exported:
¢ Click in the table, then press Ctrl-A to select all the records in the table.
¢ Click and drag or press Shift to select continuous rows.

* Press Ctrl to select discontinuous rows.

4. Export the records:
* C(Click Export Summary to export only the records in the left-hand table.

¢ Click Export Details to export the records in the left-hand table and the
associated details.

5. Select a location for the export file, enter a name for the file, then click Save.

6. Click OK in the confirmation message.
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Print audit records

1. In the software, open an experiment (EDS) or template (EDT) file.
2. In the open experiment, template, or study, click Audit.
3. Click View Report to open the Print Preview dialog box.

4. Preview, save or print the report:

* (Click (Save) to save the report as a PDF or HTML file. Enter the file
name, select a location, select the file type, then click Save.

® C(Click  (Print) to send the report to the printer. In the Print dialog box,
select the printer and print options, then click OK.

5. Click to close the Print Preview dialog box.

Manage electronic signature

Access the e-Signature settings screen and enable or disable e-sig

IMPORTANT! If you disable security, you inactivate audit and electronic signature
functions. No audit record is generated for the disabling of audit and electronic
signature functions when you disable security.

1. In the software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the e-Signature tab.

3. Select or deselect Enable e-Signature.

IMPORTANT! Enabling the electronic signature feature can substantially
increase the size of experiment (EDS), template (EDT), and study (EDM) files.

4. Click Apply Settings.
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Configure the meanings of the electronic signatures

Use the Security Settings dialog box to add or remove electronic signature meanings
and to determine the data types to which they apply. The e-signature meanings are
the text that a user can select to describe a reason for an electronic signature.

The software is installed with the following default meanings.

Default data types
E-Signature definition
Plate setup Thlc-:;rrr:t%?giler Analysis Protocol | Analysis Results
Reviewed and Approved Plate Set Yes Yes No No
Up
Reviewed and Approved Results Yes Yes Yes Yes
Reviewed and Approved Template Yes Yes No No

Add a meaning

1. In the e-Signature tab of the Security Settings dialog box, click Add in the e-
Signature Meanings settings.

2. In the Create Meaning dialog box, enter a description of the e-Signature
meaning, then click OK.

3. Select what data is signed for the selected meaning.
4. Click Apply Settings.
Delete a meaning
1. Select the meaning from the e-Signature Meanings list, then click Remove.
2. Click Apply Settings.

Configure the e-signature rights for user roles

To determine the user roles that can perform an electronic signature:

1. In the e-Signature tab of the Security Settings dialog box, select the check box
next to the appropriate user roles in the User Role signature rights table.

2. Click Apply Settings.
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Select the actions that require signature

IMPORTANT! Do not change electronic signature settings during calibration.

1. In the Signature Required column, select the check box next to each action for
which you want to require electronic signatures (see below). This selection
causes the software to present an e-sig prompt if a user performs the action on
a data file that does not have the required sighatures. The data must be signed
before the user can perform the action.

Action The software requires e-signatures when a user...
Print Report Prints a report from an experiment or study
Start Run Initiates a run from the software or ViiA™ 7 Instrument

2. For each selected action, enter the number of e-signatures from each user role
that are required for each meaning before the software can execute the action.
For example, in the following figure, at least two users from the Administrator
user role must sign an experiment using the “Reviewed and Approved Plate Set
Up” meaning before a user can start the associated run.

Actions requiring signatures

Signature Required | Action

[l [print Repart | Meaning Administrator | Technician | Scientist

[Start Run | Revi d and Approved Plate Set Up 2 u] u]
Reviewed and Approved Results u] u] u]
Reviewed and Approved Template u] u] u]

3. Click Apply Settings.
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How the software prompts electronic signature

If the system is configured to check that data is signed before starting a run or
printing a report and the data is not signed, the software displays a message when
the user clicks Start Run or Print Report.

Example

The e-signature system is configured to require signatures from two users from the
user account named Administrator before a user can start a run. The experiment has
not been signed.

A user attempts to begin the run. The following message is displayed:

Before the run can start, two administrators must sign. If a user with an incorrect user
role signs, the message is displayed again.

Generate e-signature reports

You can use the software to generate reports of e-signature history from open
experiment (EDS) or template (EDT) files.

Display the e-sig records
1. In the software, open an experiment (EDS) or template (EDT) file.
2. In the open experiment or template, click Audit, then click E-Signatures.
3. (Optional) Click any row to view details for individual signatures.
Save or print e-sig records
1. In the software, open an experiment (EDS) or template (EDT) file.
2. In the open experiment or template, click Audit, then click E-Signatures.

3. In the table, select the record to be saved or printed.
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4. Save or print the record:

* (Click (Save), select a location for the export file, enter a name for the file,
then click Save.

or
e Click (Print).

5. Click OK in the confirmation message.

Save or print the table of e-signature events

1. In the software, open an experiment (EDS) or template (EDT) file.

2. In the open experiment or template, click Audit, then click Print E-
Signatures.

3. Save or print the record:

* (Click (Save), select a location for the export file, enter a name for the file,
then click Save.
or

® (Click  (Print).

4. Click OK in the confirmation message.

Export and import user, security, audit, and e-signature settings

Note: The export/import feature can be used to replicate identical security, audit,
and e-signature settings across multiple computers. The feature allows you to create
a standard security, audit, and e-signature settings “image” for the software that can
then be imported by other copies of the software to bypass manual setup.

Export

1. In any screen of the SAE module, click Export.

2. Select the items to export:
* All—Contains all settings.
¢ Custom—Contains select settings:
— Users & Roles—All user accounts with “Active” status and all user
roles and associated permissions (in case a user account specifies a
user role that does not exist on the system into which you import the
profiles).
— System & Roles—Contains all system settings and all user roles and
associated permissions.

3. Click Export or OK.

4. When prompted, specify the name and location for the exported file (DAT), then
click Save. A message is displayed when the export completes.
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Users

Import
1. In any screen in the SAE module, click Import in the navigation pane.

2. Select the DAT file to import, then click Open. A message is displayed asking if
you want to overwrite the current system configuration. Click Yes.

If any imported user accounts already exist on the system, you are prompted to
overwrite or skip each account.

Users

Users overview

The Security, Audit, and Electronic Signature (SAE) module is an optional component
of the software. The module provides the following functionality:

* System security— Controls user access to the software.

¢ Auditing—Tracks changes made to library items, actions performed by users,
and changes to the Security, Audit, and Electronic Signature settings.

¢ Electronic signature —Requires users to provide a user name and password
when performing certain functions.

Depending on the way that your administrator configures these features, you may see
the following dialog boxes and prompts when you use the software.

Security

Login

If security is enabled on your system, you must provide a user name and password to
access the software.

Your access to functions in the software is based on the permissions associated with
your user account. Functions for which you do not have permissions are grayed.

Note: If the software is configured for password expiration, you will periodically be
prompted to change your password.

Note: If the software is configured to monitor failed log in attempts, you will be
locked out of the software if you incorrectly enter your user name or password for a
specified number of times.

Permissions

If your user account does not have permission to perform any function in the
software, menu commands are grayed.
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Users

Audit

Change your password when it expires
When your password is about to expire, a message is displayed when you log in.

To change your password, select Tools » Change Password. Enter your current
password, then enter the new password two times, then click OK.

Account suspension

If the software is configured to suspend a user account for failed logins, and you
enter an incorrect user name and password for more than the allowed number of
times, your user account is suspended, and the Log In dialog box indicates that your
account is inactive.

There are two ways to activate a suspended account:
* You can wait until the suspension period ends.

* An administrator can change the account status from Suspended to Active.

Note: While a user is suspended, another user can click Reset, then log in and
replace the suspended user.

Session time-out

If the software is configured to time-out and there is no user activity for the specified
time, the Log In dialog box indicates that your user session has timed out. You must
enter your user name and password to access the software.

The administrator or another user with permission to log in to timed-out sessions can
click Reset, then log in.

If the software is configured for auditing, you may be prompted to specify a reason
when you make certain changes in the software.

Depending on your software configuration, you can either select a reason from the
list or enter a reason for change.

Electronic signature

If your system is configured for electronic signature, you may be required to have the
experiment signed by other users before you can print a report or start a run. If an
item is set to require multiple signatures, all approvers must sign the associated data
before the action can be completed.

If electronic signature is enabled for experiments, any of the following may apply:
* The Tools » Security » Sign Data menu option is enabled.

* You are prompted to sign as described in “How the software prompts electronic
signature” on page 107.
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Service

IMPORTANT! This chapter contains all user service procedures for the Applied
Biosystems™ ViiA™ 7 Real-Time PCR System. Procedures other than those described
in this document must be performed by a qualified Applied Biosystems™ service
engineer.

Decontaminate the sample block

Perform this procedure to eliminate fluorescent contaminants from the ViiA™ 7
System sample block. Contamination is generally evident in failed background
calibrations where one or more wells consistently exhibit abnormally high signals.

CAUTION! PHYSICAL INJURY HAZARD. Do not remove the ViiA™ 7 Instrument
cover. There are no components inside the instrument that you can safely service
yourself. If you suspect a problem, contact a Technical Support.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample
block can be heated to 100°C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

CAUTION! Before using a cleaning or decontamination method other than those
recommended in this guide, verify with Thermo Fisher Scientific that the proposed
method will not damage the equipment.

Materials required

* Bleach, 10% solution

* Tissue, lint-free

® (Cotton or nylon swabs and lint-free cloths
* FEthanol, 95% solution

e Safety glasses

* Pipette (100-pL) with pipette tips

* Powder-free gloves

® Screwdriver

* Deionized water
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How to handle the sample block

To prevent damaging or contaminating
the sample block, handle the assembly
as shown below. After the assembly has
been removed from the ViiA™ 7
Instrument, place the sample block on a
clean, dry surface or in its shipping
container.

Clean the sample block

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample
block and heated cover can be heated to 100°C. Before removing the sample block,
be sure to wait until it reaches room temperature.

IMPORTANT! Wear powder-free gloves when you perform this procedure.

1. Identify the contaminated wells of the sample block.
For more information, see “How to identify contamination” on page 46

2. Power off and unplug the instrument, then allow it to cool for 15 minutes.

3. Open the access door.

4. Firmly press down on the handle of
the sample block, then remove it
from the instrument. Place the
sample block on a clean, dry
surface.

5. Clean the contaminated wells of the
sample block using deionized water:

a. Pipette a small volume of deionized water into each contaminated well.

b. In each well, pipette the water up and down several times to rinse the well.
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c. Pipette the water to a waste beaker.
d. Using a cotton swab, scrub inside of each contaminated well.

e. Using a lint-free cloth, absorb the excess deionized water.

6. Load the sample block into the ViiA™
7 Instrument, then close the access
door.

IMPORTANT! After installing the
sample block, confirm that the
indicator on the left side of the
sample block is positioned behind
the red line on the instrument rail. If
the indicator is forward of the red
line, push the sample block into the
instrument until it is seated correctly.

7. Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The software
displays an error message if the door is not completely closed and latched, or if
the sample block is not seated correctly.

8. Plug in, then power on the ViiA™ 7 System.

9. Perform a background calibration to confirm that you have eliminated the
contamination.

10. If the contamination remains, repeat steps 2 through 5, then clean the
contaminated wells of the sample block using a 95% ethanol solution:

a. Pipette a small volume of 95% ethanol solution into each contaminated
well.

b. In each contaminated well, pipette the solution up and down several times
to rinse the well.

c. Pipette the ethanol solution to a waste beaker.
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11. Repeat steps 5 through 9 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with
bleach or ethanol solution.

12. If the contamination remains, repeat steps 2 through 5, then clean the
contaminated wells of the sample block using 10% bleach solution:

a. Pipette a small volume of 10% bleach solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times
to rinse the well.

c. Pipette the bleach solution to a waste beaker.

13. Repeat steps 5 through 9 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with
bleach or ethanol solution.

14. If the contamination remains, contact Technical Support.

Replace the halogen lamp

Replace the halogen lamp after approximately 2,000 hours of life.

WARNING! PHYSICAL INJURY HAZARD. The ViiA" 7 System and lamp are hot!
The lamp can become very hot while in use. Before handling the lamp, allow it to cool
for 15 minutes and put on protective, powder-free gloves.

CAUTION! PHYSICAL INJURY HAZARD. Wear disposable, powder-free gloves
when handling the lamp to prevent burns and to prevent shortening the life of the
replacement lamp.

WARNING! This ViiA™ 7 Instrument is designed for 12 V, 75 W halogen lamps only.
Replace with halogen bulbs supplied by Thermo Fisher Scientific.

Materials required

* Safety glasses
* Powder-free gloves
* Halogen bulb (12 V, 75 W)
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Halogen lamp warnings

The QuantStudio™ Real-Time PCR Software can display the following warnings
before or during a run:
* The lamp current is below the acceptable level at the start of the run.
You cannot proceed with the run until you replace the halogen bulb as explained
in “Replace the lamp” on page 115.
* The QuantStudio™ Real-Time PCR Software stopped the run because the lamp
current decreased below the acceptable level during the run.

You cannot proceed with the run until you replace the halogen bulb as explained
in “Replace the lamp” on page 115. Click OK in the message box, then replace
the lamp bulb.

* The lamp usage exceeds 2,000 hours at the start of a run.
Click Cancel Run, then replace the lamp, or click Continue Run.

Check the lamp status
1. In the Home screen of the software, click Instrument Console.

2. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments, then review the Lamp Life and Last Serviced readings in the
Maintenance Info pane.

If the lamp usage is greater than 2,000 hours, we recommend that you replace
the lamp (see “Replace the lamp” on page 115).

Note: The Lamp Life report displays the total number of hours that the halogen
lamp has been illuminated. The Last Serviced report displays the date that the
lamp was installed.

Replace the lamp

IMPORTANT! Wear powder-free gloves when you handle the lamp.

IMPORTANT! Do not touch the lamp without powder-free gloves. Finger prints
shorten the lamp life.

1. (Optional) Record the lamp installation:
a. Touch the ViiA™ 7 Instrument touchscreen to awaken it, then press

b. In the Main Menu, touch Tools, then touch Record Lamp Installation.

c. Touch the Name field, enter any relevant information (such as the make,
model, or serial number of the lamp), then touch Done.

d. Touch the Comments field, then enter any additional information that you
want to record (such as the make and model of the replacement lamp).

e. When you are finished, touch Record New Lamp, then touch OK.
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Note: The data that you enter for the new lamp appears in the instrument log.
2. Power off and unplug the instrument, then allow it to cool for 15 minutes.

3. Open the access door.

4. Remove the lamp from the
instrument:

a. Slide the lamp release lever
downward.

b. Firmly grasp the lamp and lift it
up and out of the slotted
mount.

5. Inspect the lamp for damage
(carbon usually coats the inside of a
failed lamp). If necessary, dispose of
the lamp and obtain a replacement.

IMPORTANT! Dispose of the lamp
in accordance with your local
municipal waste ordinances. Do not
dispose of the lamp as unsorted
municipal waste.

6. Install the new lamp into the
instrument:

a. Slide the lamp release lever
upward.

b. Firmly grasp the lamp, place it
into the slotted mount, then
carefully slide the lamp downward
into place.

7. Close the access door.

8. Plug in and power on the instrument.

IMPORTANT! Confirm that the
access door is completely closed. The
software displays an error message if
the door is not completely closed and
latched, or if the lamp is not seated
correctly.
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9. Start the QuantStudio™ Real-Time PCR Software, then perform an ROI
calibration.

While the ViiA™ 7 Instrument is running, look through grating of the access door
and verify that the lamp is illuminated.

¢ |f the lamp is illuminated, the lamp has been installed successfully.

* |f the lamp is not illuminated, the replacement halogen lamp may be
defective. Replace the lamp again. If the second lamp does not illuminate,
check the ViiA™ 7 Instrument fuses for failure (see “Replace the instrument
fuses” on page 117).

10. After replacing the lamp, perform the following calibrations in the specified
order:

a. Background calibration

b. Uniformity calibration

(2}

. Dye calibration

o

. (TagMan™ Array Card block only) Normalization calibration

Replace the instrument fuses

Replace the ViiA™ 7 System fuses when the fuses fail.

CAUTION! FIRE HAZARD. For continued protection against the risk of fire, replace
fuses only with listed and certified fuses of the same type and rating as those
currently in the ViiA™ 7 Instrument.

Materials required

* Fuses, 12.5A, Time-Lag T, 250VAC, 5 x 20-mm (2)
* Safety glasses

* Powder-free gloves

* Screwdriver, flathead
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Replace the fuses

1. Power off, then unplug the ViiA™ 7 Instrument. Allow it to cool for 15 minutes.

2. Using a flat-head screwdriver, unscrew and remove the fuse holder.

3. Remove each fuse from its fuse holder and inspect it for damage. Carbon
typically coats the inside of failed fuses.

Good Failed

4. Replace each failed fuse with a 12.5A, Time-Lag T, 250VAC, 5 x 20-mm Fuse.

Note: The voltage and amperage ratings are on the fuse holder.
5. Install the fuse holder.

6. Plug in, then power on the instrument. The installation is successful if the
instrument powers on.

Note: Fuse failure can result from fluctuations in the supplied power to the
instrument. To prevent further failures, consider installing an electrical protective
device, such as a UPS or a surge protector.

118 Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security



Chapter 5 Service
Update the Windows™ operating system

Update the Windows " operating system

Do not upgrade or update the Microsoft™ Windows™ operating system of the
computer running the QuantStudio™ Real-Time PCR Software without first consulting
the software release notes or thermofisher.com. Future versions and updates to the
Windows " operating system can conflict with the QuantStudio™ Real-Time PCR
Software.

To determine compatibility of an upgrade or update:

1. Go to thermofisher.com/qpcrsoftware.

2. In the Real-Time PCR section, click Applied Biosystems™ ViiA™ 7 Real-Time
PCR System.

3. Click Read Me to download the release notes.

If the release notes do not contain the information of interest, contact Technical
Support.

Update the system software

Thermo Fisher Scientific may release updates to the QuantStudio™ Real-Time PCR
Software that you can install without the aid of Thermo Fisher Scientific service
personnel. You can obtain updates directly from thermofisher.com/qgpcrsoftware.

Prepare for the software upgrade

To prepare for the software update, back up all data files and experiments by creating
a copy of the directory that you are using to store files. The default directories are:

¢ |Installation directory—<drive>:\Program Files (x86)\Applied
Biosystems\QuantStudio Real-Time PCR Software\

¢ Data directory—<drive>:\Applied Biosystems\AppData\QuantStudio
Real-Time PCR Software

* User files directory—<drive>:\Applied Biosystems\QuantStudio
Real-Time PCR Software\User Files

Note: The <drive> is the location where the software is installed.

Install the QuantStudio™ Real-Time PCR Software

Note: If you are installing the software to a computer that does not contain a
previous installation, you must have a license file supplied by Thermo Fisher
Scientific. If you do not have a license file, obtain one as explained in “Manage
QuantStudio™ Real-Time PCR Software licenses” on page 120. If you are installing a
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Update the VIIA™ 7 Instrument firmware

software update, the update automatically acquires the software license from the
existing installation.

Note: You must install the QuantStudio™ Real-Time PCR Software to monitor the
ViiA™ 7 System over a network.

1. Go to thermofisher.com/gpcrsoftware.

2. In the Real-Time PCR section, Applied Biosystems™ ViiA™ 7 Real-Time PCR
System.

3. Click Download.

4. Install the QuantStudio™ Real-Time PCR Software according to the instructions
that download with the software.

5. (Optional) Install protective software to the computer.

Update the ViiA" 7 Instrument firmware

You can use the ViiA™ 7 Instrument touchscreen to update the ViiA™ 7 Instrument
firmware. See “Update the firmware” on page 135 for more information.

Manage QuantStudio” Real-Time PCR Software licenses

You can use the License Central feature to monitor, activate, or install software
licenses.

Note: For the QuantStudio™ Real-Time PCR Software, licenses are only required for
the HRM Module and the SAE Module.

About software license keys and files

120

The QuantStudio™ Real-Time PCR Software HRM Module and the SAE Module
require the installation and maintenance of valid license files for continued operation.
The license files are generated by the Thermo Fisher Scientific website when a
license key is activated. Each file pairs a software license key with the computer from
which the key was activated. After a key is activated and a license file is generated,
the file cannot be transferred to another computer. To transfer a license between
computers, you must reactivate the license key using the software on the target
computer.

Note: The software licenses are valid for a limited time and they must be renewed
regularly. If a license has expired or is nearing expiry, the software displays a warning
when the software is started.

Note: License keys are supplied by Technical Support.
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Manage licenses

Monitor current licenses

Use the software to review the status and expiration date of the current licenses.

1. In the main menu of the software, select Tools » License Central.

2. In the License Central dialog box, review the status of your licenses.

The software displays the status of all installed licenses, where possible states
include Current and Expired, and the date at which it expires.

Note: The License Central dialog box lists the software modules on different
rows because the licenses are maintained separately.

3. (Optional) If necessary, save the license information to a text file:

a. Select the license that you want to export from the table, then click Save
License Request Info.

b. Navigate to the appropriate location, then click Save.
4. When you are done, click OK.

Activate or renew a license

If you have a valid licence key for a QuantStudio™ Real-Time PCR Software module,
or if your license file has expired, you can use the License Central feature to activate
the license as explained below.

IMPORTANT! An internet connection, a web browser, and a valid email account are
required to activate a software license. If the computer that contains the
QuantStudio™ Real-Time PCR Software is not connected to the internet or it lacks an
web browser application, contact Technical Support to request the license file.

1. In the main menu of the QuantStudio™ Real-Time PCR Software, select
Tools » License Central.

2. In the License Central dialog box, select the license of interest from the table,
click Renew License, then wait for the default web browser application to
connect to the Thermo Fisher Scientific website.

3. In the Thermo Fisher Scientific Software License Activation website, select the
license from the list of products, then activate the license as instructed.

After you successfully activate the license, the Thermo Fisher Scientific website
emails you the activated license file (LIC) to install on the computer.
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Install a license file

After you activate your license and receive an activated license file (LIC), install the
file as explained below to unlock the software module.

Note: Each license file is generated specifically for the computer that was used to
activate the license key.

1. Save the license (LIC) file to the computer that contains the QuantStudio™
Real-Time PCR Software.

2. In the main menu of the QuantStudio™ Real-Time PCR Software, select
Tools » License Central.

3. In the License Central dialog box, click Install License.

4. In the Open dialog box, navigate to and select the license file, then click Open.

o

Click OK to close the License Central dialog box.

Replace the sample block

Replace the sample block in the event of a hardware failure or to change the
consumable format of the ViiA™ 7 Instrument.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample
block and heated cover can be heated to 100°C. Before removing the sample block,
be sure to wait until it reaches room temperature.

Materials required

* Safety glasses
* Powder-free gloves
* Sample block
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How to handle the sample block

To prevent damaging or contaminating
the sample block, handle the assembly
as shown below. After the assembly has
been removed from the ViiA™ 7
Instrument, place the sample block on a
clean, dry surface or in its shipping
container.

Replace the sample block

IMPORTANT! If you are installing a sample block of a different format (for example,
96/384-well plate to array card), you must also change the plate adapter to match the
new consumable format.

1. Power off and unplug the ViiA™ 7 Instrument, then allow it to cool for 15 minutes.

2. Open the access door.

3. Firmly press down on the handle of
the sample block, then remove it
from the instrument. Place the
sample block on a clean, dry
surface.

4. Install the new sample block into the
instrument.

IMPORTANT! After installing the
sample block, confirm that the
indicator on the left side of the
sample block is positioned behind
the red line on the instrument rail. If
the indicator is forward of the red
line, push the sample block into the
instrument until it is seated correctly.
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10.

If you are installing a sample block of a different consumable format, replace the
heated cover and plate adapter if necessary to match the new consumable
format.

IMPORTANT! If you are installing a sample block of a different format, you
must also change the plate adapter to match the new consumable format.

Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The software
displays an error message if the door is not completely closed and latched, or if
the sample block is not seated correctly.

Plug in and power on the ViiA™ 7 System.

In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments, then review the Block Type field in the Instrument Properties pane.

The installation is successful if the instrument powers on and if the Block Type
field displays the correct type of sample block.

Note: The Block Type field displays the type of sample block installed to the
instrument.

Perform the following calibrations in the specified order:

ROI calibration
Background calibration
Uniformity calibration
Dye calibration

A R

(TagMan™ Array Card block only) Normalization calibration

Replace the heated cover

Replace the heated cover in the event of a hardware failure or if you want to change
the consumable format of the ViiA™ 7 Instrument.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample
block and heated cover can be heated to 100°C. Before removing the heated cover,
be sure to wait until it reaches room temperature.

Materials required
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Safety glasses
Powder-free gloves
Heated cover
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How to handle the heated cover

To prevent damaging or contaminating
the heated cover, handle the assembly as
shown below. After the assembly has
been removed from the ViiA™ 7
Instrument, place the heated cover on a
clean, dry surface or in its shipping
container.

Replace the heated cover

Note: Confirm that the replacement heated cover supports the consumable format
that you want to use. Some heated covers support more than one consumable type.

1. Power off and unplug the ViiA™ 7 System, then allow it to cool for 15 minutes.

2. Open the access door.

3. Unlock the heated cover by pinching
the handle together, then pull the
assembly from the ViiA™ 7
Instrument and place it on a clean,
dry surface.

4. |nstall the new heated cover into the
instrument.

N

S

IMPORTANT! When the heated cover is seated correctly, the arrows on the
front handle align as shown below. If the arrows do not align, push the heated
cover further into the instrument until the handle locks into place.

Correct Incorrect
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5. If you are installing a heated cover of a different consumable format, replace the
sample block and plate adapter if necessary.

IMPORTANT! If you are installing a heated cover of a different format, you
must also change the sample block and plate adapter to match the new
consumable format.

6. Close the access door.

Confirm that the access door is completely closed. The software displays an
error message if the door is not completely closed and latched, or if the sample
block is not seated correctly.

7. Plug in and power on the ViiA"™ 7 System.

8. In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

9. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments, then review the Heated Cover Firmware Version field in the
Instrument Properties pane.

The installation is successful if the ViiA™ 7 Instrument powers on and if the
Heated Cover Firmware Version field displays a version number.

10. Perform the following calibrations in the specified order:

ROI calibration
Background calibration
Uniformity calibration
Dye calibration

o~ n =

(TagMan™ Array Card block only) Normalization calibration

Replace the plate adapter

Replace the plate adapter in the event of a hardware failure or if you want to change
the consumable format of the ViiA™ 7 Instrument.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample
block and heated cover can be heated to 100°C. Before removing the heated cover,
be sure to wait until it reaches room temperature.

Materials required

* GSafety glasses
* Powder-free gloves
* Plate adapter
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IMPORTANT! If you are installing a plate adapter of a different format, you may also
be required to change the sample block to match the new consumable format.

1.

2.

Touch the instrument touchscreen to awaken it, then press

In the Main Menu, touch

When the tray arm opens, pull the
latch, then lift and remove the plate
adapter.

Attach the new adapter to the tray
arm, then pull the latch to allow the
adapter to lower into place. If
necessary, apply pressure as
indicated until the adapter snaps
into place.

In the Main Menu, touch

If you are installing a tray adapter of a different consumable format, replace the

sample block if necessary.
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Manual instrument operation

Note: This appendix describes how to operate the ViiA™ 7 Instrument manually using
the touchscreen interface. Although the ViiA"™ 7 Instrument can be used without a
physical attachment to a computer, the touchscreen allows you to perform only a
subset of the total instrument functions.

The ViiA™ 7 Instrument features a touchscreen interface that you can use to run
experiments, manage instrument settings, and configure the ViiA™ 7 Instrument for
network use. The touchscreen does not provide access to all instrument functions.
Features such as experiment analysis, instrument calibration, and remote notification
are available only through the QuantStudio™ Real-Time PCR Software.

Functions available from the instrument touchscreen

The following table summarizes the functions that are available from the ViiA™ 7
Instrument touchscreen. The table organizes the functions by user role, where
operational functions are for users that perform experiments, maintenance functions
are for users who maintain the instrument, and administration functions are for
systems administrators or for information technology personnel. The right-most
column indicates whether a function is available when the ViiA™ 7 Instrument is
operating in secure mode (see “Enable or disable instrument security” on page 141
for more information).

Available
User role Function in secure
mode?
Create experiments from templates
. Run experiments
Operational No
Transfer experiments, templates, and results
to/from a USB drive
Back up and restore the instrument settings
Maintenance Perform an instrument self test
Update the ViiA™ 7 Instrument firmware Yes
Define the date and time
Administration
Define the instrument settings
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(continued)
Available
User role Function in secure
mode?

Define the network settings

Define the maintenance reminders

Define the system shortcuts
Administration Yes
Enable or disable instrument security

Review the instrument statistics

View the ViiA™ 7 Instrument log

Operate the instrument from the touchscreen

The touchscreen provides limited control of the ViiA™ 7 Instrument to run experiments
and transfer data. You can perform the following functions from the touchscreen to
operate the ViiA™ 7 Instrument without using the software:

* “Create an experiment from a template” on page 129
* “Run an experiment” on page 130
* “Transfer experiments, templates, and results data” on page 131

Note: If the ViiA™ 7 Instrument is operating in secure mode (see “Enable or disable
instrument security” on page 141), users can only open and close the side door.

Create an experiment from a template

1. If necessary, download the experiment template to the ViiA"™ 7 Instrument as
described in “Transfer experiments from a USB drive” on page 132.

2. If the instrument is in standby, touch the ViiA"™ 7 Instrument touchscreen to
awaken it, then press

3. In the Main Menu, touch View Templates.

4. Inthe View Templates screen, create the experiment:
a. Touch , then touch the folder that contains the desired template.

b. Touch the desired template.
c. Touch  Create Experiment.

To view the parameters of a template, select the desired template, then touch
View. When finished, touch  to return to the View Templates screen.

Note: You cannot modify the experiment parameters of a template.
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5. In the Create New Experiment screen, touch each field to set the:
* Experiment name
* Folder to receive the experiment
* Reaction volume
* Barcode

* Any additional information to save to the experiment

6. When finished, either:
* Touch Save & Exit, then touch to return to the Main Menu.
or
* Touch  Save & Start Run to proceed to the Start Run screen.

Run an experiment

1. If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then press

2. In the Main Menu screen, then touch

3. When the side door opens, load the
appropriate plate or array card.
Ensure that the consumable is
properly aligned in the holder.

* |Load 96/384-well plates with
the A1 position at the top-left
corner of the plate adapter.

* Load both plates and array
cards with the bar code facing
the front of the instrument.

4. |n the Main Menu, touch Browse Experiments.

5. In the Experiments screen, touch the desired experiment, then touch either:

. Start Run to start the run immediately, then go to step 10.
or

d View/Edit to view or edit the experiment before starting the run.
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6. Modify the experiment parameters as needed. To:

* Add a stage or step to the thermal profile, touch the stage or step to the left
of where you want to add the stage or step, then touch afiiz Add

e Add a melt curve to the end of the thermal profile, touch | ¥ Add Melt
Curve.

* (Change the time or temperature of a stage or step, touch the
time/temperature field of the stage or step, modify the settings as desired,
then touch Close.

* Change the cycle parameter of a stage, touch the cycle field, modify the
setting as desired, then touch Close.

* Delete a stage or step from the thermal profile, touch the stage or step you
want to remove, then touch T#E Delete.

7. When finished modifying the parameters, touch ~ Save.

8. In the Save Experiment screen, touch each field to set the experiment, name,
reaction volume, bar code, and any additional information to save to the
experiment

9. When finished, touch Save & Start Run to start the experiment.

10. In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch Start Run Now to start the experiment.

Note: When the run is complete, touch  to unload the plate. You can
download the experiment results to a computer if the ViiA™ 7 Instrument is
connected to a network, or you can copy the data to a USB device (see
“Transfer experiments, templates, and results data” on page 131).

Transfer experiments, templates, and results data

You can transfer experiments, templates,
and results data to/from the ViiA™ 7
Instrument using a USB flash drive.
Before transferring data, you must plug
the drive into one of the USB ports
behind the right side of the ViiA™ 7
Instrument touchscreen.

i
!

IMPORTANT! Do not use the USB ports on the rear panel of the ViiA™ 7 Instrument.
The rear USB ports are for use by Thermo Fisher Scientific personnel only.
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Transfer templates from a USB drive

1. Plug a USB drive into the USB port on the right side of the touchscreen.

2. If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then press

3. In the Main Menu, touch View Templates.

4. In the Browse Experiments screen, select the template:
a. Touch , then touch USB.

b. Touch the desired template, then touch

5. In the Save Experiment As screen, set the name for the file.
a. Touch the New Template Name field, then enter a name for the copied file.

b. Touch the Save to Folder field, then select the folder to receive the file.
c. Touch Save.
6. Touch to return to the Main Menu.
7. Unplug the USB drive.
Transfer experiments from a USB drive
1. Plug a USB drive into the USB port on the right side of the touchscreen.

2. If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then press

3. In the Main Menu, touch Browse Experiments.

4. Inthe Browse Experiments screen, select the experiment:
a. Touch , then touch USB.

b. Touch the desired experiment, then touch

5. In the Save Experiment As screen, touch the experiment that you want to
transfer to the USB drive, then touch Save.

6. Touch to return to the Main Menu.

7. Unplug the USB drive.
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Copy experiment results to a USB drive

1. Plug a USB drive into the USB port on the right side of the touchscreen.

2. If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then press

3. In the Main Menu, touch Collect Results.

4. In the Collect Results screen, touch the desired experiment, touch ¢ Copy to
USB.

5. In the Copy Results To USB screen, touch § Copy to USB.
6. Touch to return to the Main Menu.
7. Unplug the USB drive.

Note: After the results from a completed run have been collected, the corresponding
experiment displays “Collected” and it can be deleted.

Maintain the instrument from the touchscreen

The ViiA™ 7 Instrument touchscreen provides access to several maintenance
functions that cannot be accessed remotely from the software. The following local
instrument functions are performed as part of regular instrument maintenance:

* “Restore the instrument settings” on page 134
* “Perform an instrument self test” on page 135
* “Update the firmware” on page 135

Note: The touchscreen does not provide access to all instrument functions. Features
such as instrument calibration and remote notification are available only through the
software.

Back up and restore the instrument settings

You can use the ViiA™ 7 Instrument touchscreen to back up the instrument settings
(icon, standby time-out, and cover idle temperature), and some network settings (the
Autodiscovery and Smart Monitoring options). In the event that the instrument
settings are reset, you can restore the settings from the backup.

The ViiA™ 7 Instrument backs up to and
restores instrument settings from a USB
flash drive. Before backing up or
restoring settings, you must plug the
drive into one of the USB ports behind
the right side of the instrument
touchscreen.

i
?
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IMPORTANT! Do not use the USB ports on the rear panel of the instrument. The
rear USB ports are for use by Thermo Fisher Scientific personnel, only to service the
instrument.

Note: The backup feature can be used as an administrative tool to manage ViiA™ 7
Instruments. You can use the feature to create a standard “image” for a ViiA™ 7
Instrument that can then be restored on other instruments to bypass the manual
setup process.

Back up the ViiA™ 7 instrument settings

1. Plug a USB drive into the USB port on the right side of the ViiA™ 7 Instrument
touchscreen.

2. |If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then touch

3. In the Main Menu, touch Tools, then touch Back Up Settings.
4. In the Backup Settings screen, touch § Backup.

5. Touch to return to the Main Menu.

6. Unplug the USB drive.

Note: For administrative purposes, you can reuse the instrument settings saved to
the USB drive to configure more than one ViiA™ 7 Instruments. Note that you must
configure the network settings for each instrument individually.

Restore the instrument settings

1. Plug the USB drive that contains the instrument settings into the USB port on
the right side of the ViiA™ 7 Instrument touchscreen.

2. If the instrument is in standby, touch the ViiA™ 7 Instrument touchscreen to
awaken it, then press

3. In the Main Menu, touch Tools, then touch Restore Settings.

4. In the Restore Settings screen, select the settings to restore:
a. Touch the settings that you want to restore from the list.

b. Touch ¢ Restore to upload the instrument settings from the USB drive.

IMPORTANT! Do not remove the USB drive from the ViiA™ 7 Instrument until
you are instructed to do so.

Note: Alternatively, touch Restore Default Settings to restore the ViiA™ 7
Instrument to the factory settings.

5. After the ViiA"™ 7 Instrument reboots, unplug the USB drive.
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Perform an instrument self test

You can use the ViiA™ 7 Instrument touchscreen to perform a comprehensive self test
of the ViiA™ 7 Instrument subsystems. After the self test is complete, the ViiA™ 7
Instrument generates two files that provide a detailed summary of the instrument
condition and function. In the event of a problem, you can save the results files to a
USB drive and email them to Technical Support for a diagnosis.

Note: We recommend running the self test as part of regular maintenance to ensure
optimal performance of the instrument.

1.

5.

Update the firmware

1.

If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

In the Main Menu, touch Tools, then touch Run Self Test.
In the Self Test screen, touch Start Self Test, then wait for the test to complete.

(Optional) When the ViiA™ 7 Instrument completes the self test, save the results
to a USB drive:

a. Plug a USB drive into the USB port on the right side of the instrument
touchscreen.

b. Touch Save to USB.

IMPORTANT! Do not remove
the USB drive from the instrument
until instructed to do so.

c. When the instrument finishes
writing the results to the USB
drive, touch OK, then remove the USB drive.

Touch to return to the Main Menu.

Download the firmware update:
a. Go to thermofisher.com/gpcrsoftware.

b. In the Real-Time PCR section, select ViiA™ 7 Real-Time PCR System.
c. In the Software Downloads page, click Updates - Patches.

d. Download the firmware to a USB drive.
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Plug the drive into the USB port on
the right side of the ViiA™ 7
Instrument touchscreen.

If the instrument is in standby, touch
the ViiA™ 7 Instrument touchscreen
to awaken it, then press

i
!

In the Main Menu, touch Tools, then touch Upgrade Firmware.
In the Upgrade Firmware screen, select the update package, then touch
Upgrade Firmware. Allow the instrument to complete the upgrade.

IMPORTANT! Do not remove the USB drive from the ViiA™ 7 Instrument until
you are instructed to do so.

After the upgrade is complete and the instrument restarts, confirm the upgrade
success:

a. Unplug the USB drive.

b. Touch Settings, then touch About this instrument to view the software
version number to confirm that the firmware has been upgraded.

Administrate the instrument from the touchscreen

The touchscreen provides access to several administrative functions that you can use
to integrate the ViiA™ 7 Instrument into a laboratory workflow. The following functions
are available from the touchscreen and can be used after installation to customize the
ViiA™ 7 Instrument settings and configure it for network use.

“Define the date and time” on page 137

“Define the instrument settings” on page 137
“Define the maintenance reminders” on page 138
“Define the network settings” on page 139

“Define the system shortcuts” on page 140
“Review the instrument statistics” on page 141
“Enable or disable instrument security” on page 141
“View the instrument log” on page 142

Note: The touchscreen does not provide access to all instrument functions. Features
such as instrument calibration and remote notification are available only through the
software.
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Define the date and time

1. If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch [.-] Settings, then touch Set Date & Time.

3. In the Set Date & Time screen:
a. Touch the Time zone field, then touch the correct time zone from the list.

b. Touch the Date field, enter the current date, then touch Done.

c. Touch the Date Format dropdown list, then select the format for your
region.

d. Touch each Time field, enter the appropriate time units, then touch Done.
e. Touch 12 Hour or 24 Hour to select the appropriate time format.
f. Touch Save to save the settings, then touch OK when prompted.

4. Touch to return to the Main Menu.

Define the instrument settings

1. If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch Settings, then touch Configure the Instrument.

3. Touch the Instrument Name field, enter up to a 16-character name for the ViiA™
7 Instrument, then touch Done.

The instrument name is the alphanumeric string used to identify the ViiA™ 7
Instrument on the network.

IMPORTANT! To connect the ViiA™ 7 Instrument to a network, the name must
be unique.

IMPORTANT! The instrument name cannot include spaces or special
characters (such as; : “<>*+=\|?,).

4. Upload the instrument icon:

The instrument icon is the graphic
used to represent the ViiA™ 7
Instrument in the software
Instrument Console.

a. Save the replacement graphic
to a USB drive, then plug the
drive into the USB port on the
right side of the instrument touchscreen.
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b. Touch Upload Icon, select the desired graphic file, then touch Done.

Note: The replacement graphic must be a maximum of 48 x 48 pixels and
be stored in the portable net graphic (PNG) format.

¢. Unplug the USB drive.

5. Define the standby time-out setting:
a. Select Standby Time-out to activate the feature.

b. Touch the Standby Time-out field.

c. Enter the number of minutes (1-300) that the instrument should remain idle
until it enters standby mode, then touch Done.

Note: When in standby mode, the instrument powers off the LCD screen
backlight and enters low-power mode.

6. Define the heated cover temperature setting:
a. Select Cover Idle Temperature to activate the feature.

b. Touch the Cover Idle Temperature field.

c. Enter the temperature (50-110°C) that the heated cover should maintain
when the instrument is idle, then touch Done.

7. Touch Save to save the settings, then touch OK when prompted.

8. Touch to return to the Main Menu.

Define the maintenance reminders

You can use the ViiA™ 7 Instrument touchscreen screen to:
* Set the expiration period for the instrument calibrations and lamp replacement.

* Activate, deactivate, or change the frequency of the maintenance reminders
displayed by the ViiA™ 7 Instrument.
Set the reminders

1. If the instrument is in standby, touch the ViiA"™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch [.-] Settings, then touch Set Maintenance Reminders.

3. Configure the maintenance reminders. For each maintenance reminder:

a. Touch the Calibration expires after field, enter the number of days or hours
that should elapse until the association calibration expires, then touch
Done.
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b. Touch the check box to activate or deactivate reminders for the associated
calibration.

c. Touch the Display reminders before field, enter the number of days before
the associated calibration expires that the ViiA™ 7 Instrument should start
displaying warnings of the impending expiration, then touch Done.

4. Touch Save to save the settings, then touch OK when prompted.

5. Touch to return to the Main Menu.

Define the network settings

1. If the instrument is in standby, touch the ViiA"™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch [-] Settings, then touch Set Network Information.

Note: The Set Network Information screen displays the Media Access Control
(MAC) address of the ViiA™ 7 Instrument below the Autodiscovery and Smart
Monitoring check boxes. The MAC address can be used to uniquely identify the
ViiA™ 7 Instrument on the network.

3. Touch Autodiscovery to make the ViiA™ 7 Instrument discoverable by
computers that are running the software.

4. Touch Smart Monitoring to enable the feature on the ViiA™ 7 Instrument.

The Smart Monitoring feature allows Thermo Fisher Scientific service personnel
to monitor the status of the ViiA™ 7 Instrument remotely through an internet
connection. Smart Monitoring employs multiple layers of security, including a
Secure Sockets Layer (SSL) and Lightweight Directory Access Protocol (LDAP)
authentication, to provide real-time troubleshooting and problem resolution for
the instrument. For a detailed description of the Smart Monitoring Service, see
the Smart Monitoring Service Product Bulletin: Leveraging the power of the
Internet while maintaining system security (Pub. No. 121PB07-03).
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5. Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP
communication.

Network service Action

DHCP Touch Obtain an IP address automatically, then touch Save.

1. Touch Use the following IP address.

2. Touch the IP Address field, enter the IP address using
the keypad, then touch Done.

3. Repeat List item. to assign the:

¢ |P addresses for the DNS Servers (primary and

Static IP
secondary)

* Subnet Mask setting

¢ Default Gateway setting

4. Touch Save to save the settings, then touch OK when
prompted.

6. Touch to return to the Main Menu.

Define the system shortcuts

You can use the ViiA™ 7 Instrument touchscreen to map the shortcut buttons that
appear in the Main Menu. You can configure shortcuts to automatically open specific
files and folders so that you can access data quickly and easily without having to
navigate to it.

Define the shortcuts

1. If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, access shortcut settings:

* Touch Edit.
or

* Touch [-] Settings, then touch Set Up Shortcuts.

3. Configure the shortcuts as desired:
To add a shortcut:
a. Touch the shortcut of interest, then touch Set Shortcut.

b. Touch From Templates to link to a specific template file or touch From
Folders to link to a folder.

¢. Touch the desired template file or folder to configure the shortcut.
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To delete a shortcut, touch the shortcut of interest, then touch Remove
Shortcut, or touch Remove All to delete all shortcuts.

4. When you are finished configuring the shortcuts, touch  to return to the Main
Menu.

Review the instrument statistics

You can use the ViiA™ 7 Instrument touchscreen to view usage statistics on the
heated cover, halogen lamp, and other system components.
View the statistics

1. If the instrument is in standby, touch the ViiA"™ 7 System touchscreen to awaken
it, then press

2. Inthe Main Menu, touch  Tools, then touch Show Statistics.

3. When you are finished, touch to return to the Main Menu.

Enable or disable instrument security

The ViiA™ 7 Instrument features a secure mode that can be enabled to restrict local
instrument functionality. When security is enabled, use of the touchscreen is
restricted to administrative functions that change the instrument settings. After the
instrument is secured, you must enter an administrator password to modify the
instrument settings, use the firmware tools, or deactivate the secure mode.

IMPORTANT! If you enable or disable the ViiA™ 7 Instrument security, auditing, and
electronic signature feature, you must similarly enable or disable the software
security (see “Configure the security system” on page 91). The software cannot
connect to ViiA™ 7 Instruments that do not match security settings.

Note: Secure mode limits the number of feature that are available from the ViiA™ 7
Instrument touchscreen. Secure mode does not provide user authentication
functionality through the instrument touchscreen.

Enable or disable security

1. If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch Settings, then touch Set Administrator Options.

3. In the Set Administrator Options screen, touch Secure Environment to enable
(checked) or disable (unchecked) system security.

4. (Optional) To change the administrator password:
a. Touch Change Password.
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b. Enter the current password, then touch Done.
c. Enter the new password, then touch Done.
d. Reenter the password when prompted.
e. Touch OK when prompted.

Note: The default password for the ViiA™ 7 Instrument touchscreen is
password; however, the password can be changed during installation.

5. Touch Save.

6. Touch the Administrator Password field, enter the administrator password, then
touch Done.

7. Touch to return to the Main Menu.

View the instrument log

You can use the ViiA™ 7 Instrument touchscreen to view a log that summarizes
instrument activity from the last 6 months. For each recorded activity, the activity log
provides a description of the activity and the date/time when it occurred.

View the log

1. If the instrument is in standby, touch the ViiA™ 7 System touchscreen to awaken
it, then press

2. In the Main Menu, touch Tools, then touch View Log.

3. In the View Log screen, configure the settings to display the records of interest:
* Select an option from the drop-down menu to filter the log.

* Select Earliest First or Latest First to determine the order to sort the
records.

4. Touch to return to the Main Menu.
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Place the ViiA" 7 system on standby

If left unattended, the ViiA™ 7 Instrument automatically enters standby mode to
conserve power. To enter standby mode manually, touch  on the ViiA™ 7
Instrument touchscreen.

Power on the ViiA™ 7 System

To power on the ViiA™ 7 System from a powered-off state:

1. Toggle the power button on the rear of the ViiA™ 7 Instrument, then wait for it to
boot.

Note: The ViiA™ 7 Instrument is ready to use when the touchscreen displays the
Main Menu.

2. Power on the monitor.

3. Power on the ViiA™ 7 System computer:
a. Press the power button of the computer, then wait for it to boot.

b. When the Login screen appears, enter your user name and password, then
click OK.

4. Start the QuantStudio™ Real-Time PCR Software.

a. On the desktop, double-click QuantStudio™ Real-Time PCR Software(or
select .

Note: If the shortcut is not present on the desktop, select Start » All
Programs » Applied Biosystems » QuantStudio Real-Time PCR
Software to start the software.

IMPORTANT! If the software does not start, confirm that no other
instances of the software are open. If any instance of the software is open,
close it before starting the software.

b. If the QuantStudio™ Real-Time PCR Software login appears, enter your user
name and password, then click Log In.
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Power off the ViiA" 7 Real-Time PCR System

The ViiA™ 7 Real-Time PCR System operates in low-power mode when not in use.
However, the ViiA™ 7 System can be powered off completely so that the components
draw no power.

Note: If the system will be inactive for extended period of time, prepare it for storage
as explained in “Store the ViiA™ 7 system” on page 144.

To power off the ViiA™ 7 System components:

1. Power off the ViiA™ 7 Instrument:

a. If the ViiA™ 7 Instrument touchscreen is not blank, touch  to place the
ViiA™ 7 Instrument into stand-by mode.

b. Toggle the power button on the rear of the instrument.

2. Power off the ViiA™ 7 System computer:
a. In the desktop, select Start » Shut Down.

b. In the Shut Down Windows™ dialog box, select Shut Down, then click OK.

3. Power off the monitor.

Store the ViiA" 7 system

The Applied Biosystems™ ViiA™ 7 Real-Time PCR System can be powered off and
stored for extended periods of time. The length of the period of inactivity determines
the method you use to power off the ViiA™ 7 Instrument.

Materials required

MicroAmp™ Optical 96/384-Well Reaction Plate or array card (unused)

Prepare the ViiA™ 7 instrument

1. If you plan to store the ViiA™ 7 System for more than a week or you plan to move
it, load an unused plate or array card into the ViiA™ 7 Instrument:

Note: The empty plate protects the internal components of the ViiA™ 7 System
during transport or during periods of inactivity lasting more than a week.

a. Touch the ViiA™ 7 Instrument touchscreen to awaken it, then touch

b. Touch I to eject the tray arm, place a plate or array card onto the plate
adapter, then press [ again to load the plate.

c. Touch to place the ViiA™ 7 Instrument into stand-by mode.

2. Toggle the power button on the rear of the ViiA™ 7 Instrument.
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3. Power off the computer:
a. Select Start » Shut Down.

b. In the Shut Down Windows™ dialog box, select Shut Down, then click OK.

4. Power off the monitor.

Move the ViiA™ 7 system

Perform this procedure to safely move the ViiA™ 7 System short distances (for
example, between laboratories of the same building).

C CAUTION! PHYSICAL INJURY HAZARD. Do not attempt to lift the ViiA™ 7
Instrument or any other heavy objects unless you have received related training.
Incorrect lifting can cause painful and sometimes permanent back injury. Use proper
lifting techniques when lifting or moving the ViiA™ 7 Instrument. At least two people
are required to lift it.

IMPORTANT! Moving your ViiA" 7 System can create subtle changes in the
alignment of the instrument optics. Recalibrate the instrument if necessary.

Materials required

None

How to handle the sample block and heated cover

To prevent damaging or contaminating the sample block or the heated cover, handle
the assemblies as shown below. After you remove each assembly from the
instrument, place them on a clean, dry surface or in its shipping container.
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Prepare for the ViiA™ 7 system components
1. Power off the ViiA™ 7 Instrument and computer.

2. When the ViiA™ 7 System and computer are powered off, disconnect all ViiA™ 7
System components and package the cabling for the move.

3. Prepare the ViiA™ 7 Instrument for the move:

a. Open the ViiA" 7 System access
door.

b. Firmly press down on the sample
block handle, pull the sample
block from the ViiA™ 7 Instrument,
then place it on a clean, dry
surface.

c. Pinch the handle of the heated
cover together, then pull the
assembly from the ViiA™ 7
Instrument and place it on a
clean, dry surface.

d. Package the sample block and
heated cover assemblies in a
clean, dust-free container for the
move.

Move the ViiA™ 7 system

Move the ViiA™ 7 System according to the following guidelines:

e Verify that the surface on which you will place the ViiA™ 7 System can support at
least 60.10.6 kg (132.5+0.13 Ibs).

* Verify that the path to transport the ViiA™ 7 Instrument is clear of obstructions.
* Enlist at least one other person to lift and carry the ViiA™ 7 Instrument.

* Keep your spine in a good neutral position.

* Bend at the knees and lift with your legs.

¢ Do not lift an object and twist your torso at the same time.

¢ Coordinate your intentions with your assistant before lifting and carrying.
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Move the VIiA™ 7 system

Reinstall the ViiA™ 7 System

1. Reconnect the components of the
ViiA™ 7 System. Use the Ethernet i
cable supplied with the ViiA™ 7 Ethernet
System to connect the ViiA™ 7 1
Instrument (Ethernet 1 port) to the ———0ss5=
network interface card in the
computer.

=

IMPORTANT! Do not use a
standard Ethernet cable to connect
the ViIA™ 7 Instrument to the
computer.

IMPORTANT! Do not connect the Ethernet cable to the Ethernet 2 port on the
ViiA™ 7 Instrument. The second port is for Thermo Fisher Scientific service use
only.

2. Install the sample block and heated cover assemblies.

3. Perform a RNase P instrument verification run. If the run:
Passes—Do not recalibrate the ViiA" 7 System. No further action is necessary.
Fails —Perform the following calibrations in the specified order: ROI,
background, uniformity, dye, then normalization calibrations.

1. ROI calibration
Background calibration
Uniformity calibration

Dye calibration

© 2 0 T p

(TagMan™ Array Card block only) Normalization calibration
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Creating custom calibration plates

and array cards

Create a background plate or array card

Whenever possible, use a Background Plate or the TagMan™ Array Background
Buffer that is included with the spectral calibration kit. The plates/array cards
supplied in the kit contain a buffer that accurately simulates the reagents used for
PCR, and, therefore, produces high-quality calibration data. If a background plate or
array card from a spectral calibration kit is not available, you can create one as
described below.

Materials required

96/384-Well plate sample block

Applied Biosystems™ Optical 96/384-Well Reaction Plate
Safety glasses

Optical Adhesive Cover or Optical Flat Caps

Pipettor, 200-pL (with pipette tips)

Powder-free gloves

Deionized water

Array card sample block

Applied Biosystems™ Array Cards

Applied Biosystems™ Array Card Staker/Sealer

Centrifuge with array card buckets and array card carrier clips
Permanent marker or pen

Pipettor, 200-pL (with pipette tips)

Powder-free gloves

Safety glasses

Deionized water
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Appendix C Creating custom calibration plates and array cards
Create a background plate or array card

Create a background plate

IMPORTANT! Wear powder-free gloves while creating the background plate.

1.

Remove an 96/384-Well Optical Reaction Plate from its box and place it on a
clean, dry surface.

Aliquot 20 pL deionized water to each well of the reaction plate.
Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration as you would a background plate from
the spectral calibration kit.

Create a background array card

1.

Remove an Applied Biosystems™ Array Card from its box and place it on a
clean, dry surface.

Using a permanent marker, write

“ " i (Vv 7%/ >
Background” on the side of the Aﬁﬁﬁﬁﬁﬁ&d%
empty card. i S22
Pipette 100 pL of deionized water sRadaRaLadatals
into each of the eight reservoirs in ‘@@%@%&&@W
the card: ”.@,@’ I 4 Mark
here

a. Place the array card on a lab
bench, with the foil side down.

b. Load 100 L of the solution into a pipette.

c. Hold the pipette in an angled position (approximately 45°) and place the tip
into the fill port.

>

—

U

(@ Fill port
(2 Vent port
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Appendix C Creating custom calibration plates and array cards
Create a custom dye plate for calibration

d. Dispense the fluid so that it
sweeps in and around the fill
reservoir toward the vent port.

When pipetting the reagents into
the array card, pipette the entire
100-pL volume into the fill
reservoir, but do not go past the
first stop of pipettor plunger or
you may blow the solution out of
the port.

o
>

N

N«

s
>

N
%

IMPORTANT! Do not allow the tip to contact and possibly damage the
coated foil beneath the fill port.

4. Centrifuge and seal the array card as explained in “Fill the array cards” on
page 30.

Create a custom dye plate for calibration

TheViiA™ 7 Real-Time PCR System can be used to run assays designed with custom
dyes (dyes not manufactured by Thermo Fisher Scientific). Custom dyes must excite
between 455 nm and 672 nm and read between 505 nm and 723 nm.

Before you use custom dyes

Before using custom dyes with the ViiA™ 7 System, you must:
¢ Determine optimum dye concentration.
¢ Create a custom dye plate.
* Add the custom dye to the software.
* Perform a dye calibration.

Materials required

150

¢ Centrifuge with plate adapter

* Custom dye(s)

* Safety glasses

* Powder-free gloves

* MicroAmp" Optical 96/384-Well Reaction Plate
® Optical Adhesive Cover

* Pipettors and pipette tips (200-puL and 1000-pL)
® Tubes (2-mL and 10-mL)

® Deionized water
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Appendix C Creating custom calibration plates and array cards
Create a custom dye plate for calibration

Determine optimum dye concentration

Note: Wear powder-free gloves while creating the dye plate.

1. Prepare, then load the custom dye plate:

a.

b.

C.

In the center of a 96/384-well plate, prepare a dilution series of the custom
dye (for example, 25, 50, 100, 200, 400, 800, 1,600, and 3,200 nM) using
20-pL volumes for a 96/384-well plate.

Seal the reaction plate using an optical adhesive cover.

Load the prepared reaction plate.

2. Start the calibration wizard:

a.

b.

In the Home screen of the software, click Instrument Console.

In the Instrument Console, select your ViiA™ 7 Instrument, then click Add to
My Instruments.

. Select the ViiA™ 7 Instrument, then click Manage Instrument.

In the Instrument Manager, click Maintenance, then click ROL.
In the ROI Calibration screen, click Start Calibration.

In the ROI dialog box, click Next until prompted to load the ViiA™ 7
Instrument. When the side door opens, load the sealed plate. Ensure that
the plate/array card is properly aligned in the holder.

. In the ROI dialog box, select Check the box when the ROI calibration

plate has been loaded, click Next twice, then click START RUN to start
the calibration.

3. When the run is complete, inspect the ROl images:

a.

b.

Select the first filter from the Filter dropdown list.

Record the coordinate of the well that contains the lowest concentration of
dye and that is encircled by a ring. This well contains the optimal
concentration of the custom dye at the given filter.

Repeat steps 3a and 3b for the remaining filters.

After you determine the optimum concentration for each filter, determine
the optimum concentration for the custom dye. Compare the results from
all filters, then select the concentration that yields the highest possible
signal in all filters.
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Appendix C Creating custom calibration plates and array cards
Create a custom dye plate for calibration

4. Discard the plate.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, wait until it reaches
room temperature.

5. In the ROI dialog box, click Finish to complete the calibration, then click No
when prompted to save the results.

Create a custom dye plate

IMPORTANT! Wear powder-free gloves while creating the dye plate.

1. Prepare 2 mL of the custom dye at the concentration determined in “Determine
optimum dye concentration” on page 151.

2. Pipette 20 pL of the diluted custom dye to all wells of an optical reaction plate.
3. Seal the wells of the reaction plate using an optical adhesive cover.

4. Centrifuge the plate for 2 minutes at less than 1,500 rpm.

Note: The custom dye calibration plate must be well mixed and centrifuged.

5. Verify that the liquid in each well of the plate is at the bottom of the well. If not,
centrifuge the plate again at a higher rpom and for a longer period of time.

(Dea ¥

Add the custom dye to the QuantStudio™ Real-Time PCR Software

1. Start the dye calibration:

a. In the Home screen of the QuantStudio™ Real-Time PCR Software, click
Instrument Console.

b. In the Instrument Console, select your ViiA™ 7 Instrument from the list of
instruments on the network, then click Add to My Instruments.

c. Select the instrument, then click Manage Instrument.
d. In the Instrument Manager, click Maintenance, then click Dye.

e. In the Background Calibration screen, click Start Calibration.
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Appendix C Creating custom calibration plates and array cards

Create a custom dye plate for calibration

2. In the Dye window, select a custom dye from the list or create the custom dye:

a. Click New Dye.

b. In the Dye Library dialog box, click New.

c. Complete the New Dye dialog box, then click OK.

Field/option

Action

Name

Enter a name for the custom dye.

Wavelength

Enter the wavelength at which the dye fluoresces.

Type

Select:

* Reporter if the dye works in conjunction with a
quencher dye to report an increase of PCR product.

* Quencher if the dye suppresses the fluorescence of a
reporter dye until amplification of PCR product.

* Both if the dye reports an increase of PCR product
without the aid of a quencher dye.

d. Click Close.

3. In the Dye window, enter a temperature setting for the calibration. Set the
temperature to match the temperature at which you intend to collect data. For
example, the temperature for all Thermo Fisher Scientific system dyes is 60°C
because data collection for TagMan™ reagents occurs during the 60°C extension

step of the PCR.

4. Load the appropriate dye plate into the plate adapter, select Please check the
box when the dye calibration plate has been loaded, click Next twice, then
click START RUN to start the calibration.

5. When the run is complete and the instrument ejects the plate, remove and
discard the plate or array card.

ii WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the
plate can be heated to 100°C. Before removing the plate, be sure to wait until it
reaches room temperature.

6. In the Dye dialog box of the QuantStudio™ Real-Time PCR Software, click Next.

7. Verify the grouping of the dye spectra:
a. In the plate layout, select the wells of the plate.

b. Inspect the raw data. For each spectrum, verify that the peak is:
* Within the detectable range for the ViiA™ 7 System.

* Free of irregular spectral peaks.

* Present at the correct filter for the dye.
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Appendix C Creating custom calibration plates and array cards
Create a custom dye plate for calibration

Note: Among wells containing the same dye, variations in spectral position and
peak position are caused by minor differences in the optical properties and
excitation energy between the individual wells.

8. Verify the status of the calibration. If the calibration:
Passed—If all spectra are acceptable, finish the calibration:
a. Click Next.

b. Enter any comments you have in the Comments field, click Finish, then
click Yes when prompted to save the calibration results.

Failed —Create another custom dye plate using the next dye concentration
greater than the concentration determined in “Determine optimum dye
concentration” on page 151, then perform the calibration again.
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How to order

Parts and materials

You can order materials and accessories directly from thermofisher.com.

Note: Product availability and pricing may vary according to your region or country.
Online ordering through thermofisher.com is not available in all countries. Contact
your local Thermo Fisher Scientific representative for help.

To order through the website or the QuantStudio™ Real-Time PCR Software:

* Confirm that your computer has an Internet connection.

* We recommend the following browsers and Adobe™ Acrobat™ Reader versions
to use thermofisher.com:

Microsoft™ ™ — Adobe™
. Apple Mozilla ™
Operating system Internet 0 . ™ Acrobat
™ Safari Firefox
Explorer Reader
MI.CrOSOﬁW v6.x or Later Nonel'!
Windows
v2.x or Later | v4.0 or Later
Macintosh™ Nonel'l v2.0.4 or
Later

[ Browser not available for this platform.

Note: Confirm that cookies and JavaScript are turned on for the website to function

correctly.

How to order from the QuantStudio™ Real-Time PCR Software

1. To find your assay, complete the Find Assay pane in the QuantStudio™
Real-Time PCR Software:

a. Enter a gene name in the Enter Gene Name field, then click Find Assay.

b. In the Find Assay Results dialog box, select your assay.

c. Click Apply Assay Selection. The selected assay is added to your

shopping list.
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Appendix D Parts and materials

Accessories

2. Check that the Experiment Shopping List contains the desired materials, other
than the assay selected in the previous step, and that the quantities are correct,
then click Order Materials in List.

3. In the Order Materials - Login dialog box, enter your user name and password
for thermofisher.com, then click Log In and Submit.
Note: If you do not have an account with thermofisher.com, click Register
Now to create an account.
When you are connected to the thermofisher.com, follow the prompts to
complete your order.

Accessories

The following accessories are to be used with the Applied Biosystems™ ViiA™ 7 Real-
Time PCR System.

System accessories Part number
ViiA™ 7 System 384-Well Plate Adapter 4457087
ViiA™ 7 System 384-Well Sample Block 4453553
ViiA™ 7 System 384-Well/Array Card Heated Cover 4453555
ViiA™ 7 System 96-Well Heated Cover 4453560
ViiA"™ 7 System 96-Well Plate Adapter 4459845
ViiA™ 7 System 96-Well Sample Block 4453556
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Appendix D Parts and materials
Calibration and verification consumables

(continued)
System accessories Part number

ViiA™ 7 System 96-Well Tube Adapter 4462077
ViiA™ 7 System Array Card Plate Adapter 4454166
ViiA™ 7 System Array Card Sample Block 4453554
ViiA™ 7 System Fast 96-Well Heated Cover 4459838
ViiA™ 7 System Fast 96-Well Plate Adapter 4459846
ViiA™ 7 System Fast 96-Well Sample Block 4453559
ViiA"™ 7 System Fast 96-Well Tube Adapter 4462078
Array Card Staker/Sealer 4456102
Array Card Bucket/Clip Set 4452205
Replacement Lamp for OptiFlex System 4443978

Calibration and verification consumables

Note: For reagent or consumable shelf-life expiration date, see the package label.

96-well 0.2-mL consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used
for the calibration procedure with QuantStudio™ Real-Time PCR Software v1.6.1.

0.2-mL (TAMRA™, NED", and Cy®5 dyes)

Shelf life at
Consumable Cat. No. Storage storage
temperature
QuantStudio™ 3/5 10-Dye Spectral Calibration Kit,
96-Well 0.2-mL A26343
(Contains all 3 spectral calibration plates listed below)
Use the
QuantStudio™ 3/5 Spectral Calibration Plate 1 A26331 consumable by
(FAM™, VIC™, ROX™, and SYBR™ dyes), 96-Well 0.2-mL -25°C to -15°C the expiration
QuantStudio™ 3/5 Spectral Calibration Plate 2, 96-Well date on the
uantStudio pectral Calibration Plate 2, 96-We A26332 packaging.
0.2-mL (ABY *, JUN ', and MUSTANG PURPLE " dyes)
QuantStudio ~ 3/5 Spectral Calibration Plate 3, 96-Well A26333
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Appendix D Parts and materials
Calibration and verification consumables

(continued)
Shelf life at
Consumable Cat. No. Storage storage
temperature
Region of Interest (ROI) and Background Plates, 96-Well Use the
4432364
0.2-mL (2 plates) consumable by
N -25°C to -15°C the expiration
TagMan ~ RNase P Instrument Verification Plate, 96-Well 4439382 date on.the
0.2-mL packaging.

96-well 0.1-mL consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used
for the calibration procedure with QuantStudio™ Real-Time PCR Software v1.6.1.

Well

Shelf life at
Consumable Cat. No. Storage storage
temperature
QuantStudio™ 3/5 10-Dye Spectral Calibration Kit,
96-well, 0.1-mL A26342
(Contains all 3 spectral calibration plates listed below)
QuantStudio™ 3/5 Spectral Calibration Plate 1, A26336
(FAM™, VIC™, ROX™, and SYBR" dyes), 96-well, 0.1 mL
QuantStudio™ 3/5 Spectral Calibration Plate 2 (ABY ™", Use the
JUN™, MUSTANG PURPLE" dyes), 96-well Fast (0.1-mL) A26337 consumable by
Plate -25°C to -15°C the expiration
date on the
QuantStudio™ 3/5 Spectral Calibration Plate 3 (TAMRA", A26340 packaging
NED™ and Cy®5 dyes) 96-well Fast (0.1-mL) Plate
Region of Interest (ROI) and Background Plates, Fast
96-Well 0.1-mL (2 plates) 4432426
TagMan * RNase P Instrument Verification Plate, Fast 96- 4351979
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Calibration and verification consumables

384-well consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used
for the calibration procedure with the QuantStudio™ Real-Time PCR Software v1.6.1.

Shelf life at
Consumable Cat. No. Storage storage
temperature
QuantStudio™ 5 10-Dye Spectral Calibration Kit, 384-
well A26341
(Contains the 2 spectral calibration plates listed below)
QuantStudio™ 5 Spectral Calibration Plate 1,
(FAM™, VIC™, ROX™ TAMRA"™, and SYBR™ dyes), 384- A26334 Use the
well consumable by
” » -25°C to -15°C the expiration
QuantStudio * 5 Spectral Calibration Plate 2 (ABY date on the
JUN™, MUSTANG PURPLE", NED", and Cy®5 dyes), A26335 packaging.
384-well
Region of Interest (ROI) and Background Plates, 384-well 4432320
TagMan ~ RNase P Instrument Verification Plate, 384- 4455280
well
Array card sample block consumables
Shelf life at
Consumable Cat. No. Storage storage
temperature
ViiA™ 7 Array Card Spectral Calibration Kit
™ ™ ™ Use the
Includes FAM "~ Dye, VIC Dye, ROX Dye, ROI Dye, 4432314 consumable by
FAM™/ROX"™ Dye, VIC"/ROX™ Dye, and Background -25°C to -15°C the expiration
Buffer date on the
o L . packaging.
ViiA~ 7 Array Card RNaseP Verification Kit 4432265
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Empty plate and array card consumables

Empty plate and array card consumables

Note: For consumable shelf-life expiration date, see the package label.

The following consumables are to be used with the Applied Biosystems™ ViiA™ 7

Real-Time PCR System.

Consumable Part number
Empty Az’akaard Kit, 4334812
Array Cards, 8-Port (Empty) P
Empty Array Card Kit 4351471
MicroAmp™ Fast 8-Tube Strip, 0.1-mL 125 strips 4358293
MicroAmp™ Fast Optical 96-Well Reaction Plate with Bar Code, 10 plates 4346906
0.1-mL 200 plates 4366932
10 plates N8010560
MicroAmp"™ Optical 96-Well Reaction Plate, 0.2-mL
500 plates 4316813
10 plates 4306737
MicroAmp™ Optical 96-Well Reaction Plate with Bar Code, 0.2-mL
500 plates 4326659
MicroAmp™ Optical 384-Well Reaction Plate, 1000 plates 4343370
1000 plates 4343814
MicroAmp™ Optical 384-Well Reaction Plate with Bar Code 500 plates 4326270
50 plates 4309849
MicroAmp™ Optical 8-Cap Strip 300 strips 4323032
MicroAmp™ Optical 8-Tube Strip, 0.2-mL 1000 tubes 4316567
MicroAmp™ Optical Adhesive Film 4311971
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Software reference

Software command-line application

The QuantStudio™ Real-Time PCR Software includes a command-line application
that allows you to generate and export batches of experiment files from an MS DOS
prompt or a batch file. The application is intended for advanced users who choose to
create or export experiments using a scripting language.

IMPORTANT! After you use the command-line application to generate experiment
files, validate the contents of the files by opening them in the QuantStudio
Real-Time PCR Software.

Command-line workflows

The command-line interface supports the workflows in the following figure. For each
workflow, the figure shows both the required and optional supporting files.

C d-li ™ icati
S omrlr;?)r:Jt ine —_— ViiA™ 7 Application —| EDS

B D O [ e

Experiment Document  SDS Setup Sample-to-Well AIF/X File Barcode
Template [.edt) File (.txt) File (.txt) [.txt/xml)

Figure 5 Single Experiment File Creation Workflow

v

Command-line ™ N
S—b Input —_— ViiA™ 7 Application R‘i:s_t'us
e

Experiment Document
Single (.eds) |:| Required

Figure 6 Export Workflow
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Software command-line application

Supporting files for experiment creation

The file generation function (cmdlineutil.exe —-expgen) can use the files shown
below. The command does not require all input files.

File Description

A tab-delimited or XML data file for each TagMan " assay ordered
from Thermo Fisher Scientific. For some products, assay
information files are available for download from the Thermo
assay information Fisher Scientific website following delivery. The file, which

file (AIF or AIX) contains data describing the assay, can be imported into the
software for use in related experiments.

See “Assay information file” on page 178 for more information.

A user-created, line-separated text file that contains the bar code

of each consumable for which you want to create an experiment
barcode file (TXT) file.

See “Bar code file format” on page 178 for more information.

A QuantStudio™ Real-Time PCR Software file that contains all
information about a particular plate or array card consumable,

experiment . ) including metadata (name, bar code, comments), plate setup (well

document single file o .

(EDS) contents, assay definitions), .run method (thermal cycling .
protocol), run results, analysis protocol, analysis results, audit
records, and other plate-specific data.

A QuantStudio™ Real-Time PCR Softwaree file used as a template
experiment to create experiment files. The file can contain plate setup (well
document template | contents, assay definitions), run method (thermal cycling
file (EDT) protocol), run results, analysis protocol, and other plate-specific

data.

A user-created, tab-delimited text file that describes the layout of
a consumable for an experiment to be run on the ViiA™ 7 System.
plate setup file (TXT) | The file defines the arrangement of assays and samples on the
consumable.

See “Plate setup file format” on page 170 for more information.

A user-created, tab-delimited text file containing sample data that
. can be imported into the QuantStudio™ Real-Time PCR Software
sample file (TXT) for use in related experiments.

See “Sample file format” on page 177 for more information.
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Precedence rules for experiment file generation

When generating experiment files (EDS), the software command-line interface relies
on a set of precedence rules to resolve conflicts that arise from the data supplied by

some input files. Assay information files (AIF or AlX), plate setup files (TXT), and

template files (EDT) can contain data used to populate the same fields of new
experiment files. For example, both template and plate setup files can contain
location data for samples and assays.

Files used for experiment
file (.eds) creation

Precedence rule

Template file (EDT)

The values in the template take precedence except for:

¢ Experiment Name—Determined by the File Name Convention preference.

¢ Bar Code—Determined by the bar code, if present. Otherwise, the value is null.

¢ Experiment File Name—Determined by the File Name Convention preference.

* Template file (EDT)

* Assay information file
(AIF/AIX)

All values in the template file take precedence, except for:
® Gene Expression Targets/Assay Definition
* Genotyping Assay/SNP Definition
* Passive Reference

If any conflicts exist between the assay information file and the template for the
attributes above, then the assay information file values always take precedence.

e Template file (EDT)
* Plate setup file (TXT)

All values in the template file take precedence, except for:
* Target/Assay/SNP to Well Assignment
* Sample to Well Assignment
* Task to Well Assignment
¢ Biological Group to Well Assignment
¢ Well Quantity to Well Assignment
e Sample Color
¢ Biological Group Color
* Target Color
* Gene Expression Targets Definition
* Genotyping Assay Definition

* Passive Reference
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(continued)

Files used for experiment

. . P d I
file (.eds) creation recedence ruie

All values in the template take precedence, except for the following.

The following assay information file values take precedence over Plate Setup and
Template:

* Gene Expression Targets/Detectors Definition
* QT Assay/Marker Definition
* Passive Reference

¢ Template file (EDT) The following Plate Setup values take precedence over the template:
* Plate setup file (TXT) * Block Type
* Assay information file * Target/Assay/Marker to Well Assignment
(AIF/AIX) * Sample to Well Assignment
® Task to Well Assignment
* Biological Group to Well Assignment
*  Well Quantity to Well Assignment
* Sample Color
* Biological Group Color
* Target Color

Running the command-line application from a command prompt

Running the application

1. In the desktop, select Start » Run.
2. In the Run dialog box, enter cmd in the Open field, then click OK.

3. In the DOS prompt, change to the installation directory and enter the command:
a. Enter cd D:\applied biosystems\ViiA7\, then press Enter.

b. Enter cmdlineutil.exe, followed by -expgen or -export, then all applicable
parameters and arguments. See “Command syntax and arguments” on
page 165 for a complete list of command-line parameters.

Viewing the command-line help

The command-line application includes a help function that provides the information
in this chapter. To view help for:

* The entire application, enter cmdlineutil.exe -help

* A particular function, enter cmdlineutil.exe —expgen -help to view the file
generation help, or cmdlineutil.exe —export -help to view the file export help.
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Command syntax and arguments

Batch file creation

The command used to create batches of files uses the following syntax:

cmdlineutil.exe -expgen [ parameters |

The following table lists the acceptable parameters that can be included in any order.
See “Examples” on page 167 for an example of the experiment creation command.

IMPORTANT! Enclose file paths in double quotes to allow spaces in the string.

Note: The <drive> is the location where the software is installed.

Parameter Description

(Optional) Specifies the path and name (<filepath>) of the assay information file (AIF or
-a <filepath> AlX) that the software uses to create new experiment files.

Example:-a “<drive>:\assayfiles\assayfile.aif”

(Optional) Specifies the path and name (<filepath>) of the bar code file that the
. software uses to create new files. If the - parameter is not used, then the software
-b <filepath> creates the number of experiment specified by the —n parameter.

Example:-b “<drive>:\barcodefiles\barcodefile.txt”

(Optional) When the —f parameter is included, specifies the alphanumeric string that
, the software includes in the file names of the new experiments. If no value is supplied,
-¢ <string> “custom” is used as the default value.

Example:-c “Batch001 ”

(Optional) Specifies the convention that the software uses to name the new files. The
convention can consist of all or some of the following interchangeable arguments, in
any order:

® Custom Name Field—The alphanumeric string specified by the —c parameter.
-f <option> ¢ ID—The bar code of the plate specified in the bar code file specified by the -b
parameter.

Example:-f “Custom Name Field ID”

If the —f parameter is used without arguments, then the software names files
according to the following convention: *Custom Name Field ID”

(Required) Specifies the path of the directory (<dirpath>) to which the software saves
the new files.

Example:-1 “<drive>:\Applied Biosystems\QuantStudio Real-Time

-1 <dirpath>
PCR Software\experiments”

Before creating experiment files, the software confirms whether the export location
exists and aborts if the location does not exist.
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(continued)
Parameter Description

(Optional) Specifies the path and name (<filepath>) of the sample file that the software

-m <filepath> uses to create new files.
Example:-m “<drive>:\samplefiles\samplefile.txt”
(Optional) If the -b parameter is not included, specifies number of experiments

‘ (<integer>) that the software will create. If no value is supplied, the software

—n <integer> creates 25 experiments by default.
Example:-n 31
(Optional) Specifies the path and name (<filepath>) of the setup file that the software

-s <filepath> uses to create new files.

Example:-s “<drive>:\setupfiles\setupfile.txt”

(Required) Specifies the path and name (<filepath>) of the ViiA™ 7 Software template

file that the software uses to create new files.
-t <filepath>
Example:-t “<drive>:\Applied Biosystems\QuantStudio Real-Time

PCR Software\experiments\templatefile.edt”

(Optional) Configures the software to operate in verbose mode, where the software
displays each operation as it is performed.

Results export

The command used to export the results from experiment files uses the following
syntax:

cmdlineutil.exe -export [ parameters ]

The following table lists the acceptable parameters that can be included in any order.
See “Examples” on page 167 for and examples of the experiment export command.

IMPORTANT! Enclose file paths in double quotes to allow spaces in the string.

166 Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security



Appendix E Software reference
Software command-line application

Note: The <drive> is the location where the software is installed.

Parameter Description

(Required) Specifies the path to the directory (<dirpath>) that contains the experiment

files (EDS) for which the software exports data.
-e <dirpath>
Example:-e “<drive>:\Applied Biosystems\QuantStudio Real-Time

PCR Software\experiments\”

(Required) Specifies the format of the exported data (see “Export formats and file
specifications” on page 179 for the export file specifications):

* ViiA7—Exports data in a format compatible with the ViiA™ 7 System.

-f <option> * SDS23—Exports data in a format compatible with the Applied Biosystems™
7900HT Real-Time PCR System.

* RDML—Exports data in the real-time data markup language (RDML) format.

Example:-f “RDML”

(Optional) Specifies the path (<path>) of the directory to which the software saves the
-1 <path> exported files.

Example:-1 “<drive>:\exports\”

(Optional) Specifies the data spanning option (<option>) that determines how the

software exports data from multiple experiments:
-s <option> ¢ single—Exports data for all experiments into one contiguous data file.

* multiple—Exports data for each experiment to a separate data file.

Example:-s “multiple”

(Required) Specifies the file format of the exported file:
e ViiA™ 7 export format: TXT, XLS, or XLSX

-x <filepath> ® SDS23 export format: TXT

e RDML export format: RDML

Example:-x “rdml”

Examples

Batch file creation

The following example uses all parameters described in “Command syntax and
arguments” on page 165 (required and optional) to generate a set of experiment files.

cmdlineutil.exe -expgen -t “<drive>:\Applied Biosystems\QuantStudio Real-Time PCR
Software

\experiments\templates\standard curve.edt” -a “D:\Applied

Biosystems\QuantStudio Real-Time PCR Software\experiments\examples\AIF

\AIF 820629.txt"

-s “<drive>:\Applied Biosystems\QuantStudio Real-Time PCR Software\experiments
\examples\Plate

Setup Files\SDS 820629.txt"“ -m “<drive>:\Applied Biosystems\QuantStudio Real-Time
PCR Software\experiments\examples\SampleNames\SampleFileNames.txt”

-c “alloptionsused” -f “Plate Barcode Custom Name Field”
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-b “C:\QuantStudio Real-Time PCR Software\barcodes - v12.txt” -1 “C:\QuantStudio
Real-Time PCR Software\Experiment“

Note: The <drive> is the location where the software is installed.

For this example, the command-line application:
* Imports assay definitions from the AIF 820629. txt assay information file.
* Imports sample names from the SampleFileNames. txt sample file.
* Generates an experiment for each bar code in the bar codes - v12.txt bar

code file, where each new experiment uses the settings found in the
standard_curve.edt template file and the SDS_820629. txt setup file.

Note: The setup file links the information from the ATF 820629.txt and
SampleFileNames.txt to each new experiment file.

* Saves all generated files using the following naming convention:
<barcode>_alloptionsused

* Saves all generated files to:
C:\QuantStudio Real-Time PCR Software\Experiment\<date/time>

Note: The command-line application automatically creates a time-stamped
folder at the export location for each batch operation. For example, the folder
created for files generated on April 7, 2010 at 12:48:35 would be: 2010-04-07
124835

Results export

The following example performs a real-time data markup language (RDML) export of
experiments in the QuantStudio™ Real-Time PCR Software experiments directory to
the exports directory of the C drive. The software generates an RDML file for each
individual experiment file.

cmdlineutil.exe -export -—-e “<drive>:\Applied Biosystems\QuantStudio Real-Time PCR
Software\experiments\” —-f “SDS23” -1 “C:\exports\” -s “single” -x “rdml”

Note: The <drive> is the location where the software is installed.

Import formats and file specifications

168

The software supports several import file formats that can be used to automate
experiment creation and assay and sample data import. The files can be used with
the command-line application (see “Software command-line application” on

page 161) or the software application programming interface (API) to integrate the
ViiA™ 7 System into a laboratory information management system (LIMS). For a
detailed explanation of the API, or for information on integrating the ViiA™ 7 System
into a laboratory workflow, see the Applied Biosystems™ ViiA™ 7 Real-Time PCR
System Robotics User Guide (Pub. No. 4442663).

Note: The file specifications listed in this appendix are subject to change. For
updated information, review the software release notes available at the software
download page (thermofisher.com/qpcrsoftware).
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About the import file formats

File format Description See...

A user-created, tab-delimited text file that
describes the layout of a consumable for
an experiment to be run on the ViiA™ 7
System. The file defines the arrangement of “Plate setup file
assays and samples on the consumable, format” on page 170
and provides other experiment data, such
as the thermal profile and data collection
settings.

Plate setup file (TXT)

A user-created, tab-delimited text file

) containing sample data that can be “Sample file format”
Sample file (TXT) imported into the software for use in on page 177
related experiments.
A tab-delimited or XML data file for each
TagMan™ assay ordered from Thermo
Assay information Fisher Scientific. The file, which contains “Assay information
file (AIF or AIX) data describing the assay, can be imported | file” on page 178

into the software for use in related
experiments.

A user-created, text file containing the bar
codes of consumables for which you want “Bar code file

to create experiment files using the format” on page 178
command-line utility.

Bar code file (TXT)

Conventions

The following conventions are used in the rest of this section:
* normal—Normal text must be entered exactly as it appears.

* Jjtalic>—Italicized text between brackets must be substituted with custom
values.

* [ required text ]—Textappearing between brackets is required
information. All information inside the brackets must be present for the software
to import it.

* { optional text }—Textappearing between braces is optional.

* Unless noted otherwise, separate all fields in a row using a tab character (U
+0009).

* Unless noted otherwise, end all rows using a carriage-return character (U+000D).
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Plate setup file format

170

You can use plate setup files to automatically populate setup information into an
open experiment in the software or into new experiments created by the command-
line application (see “Software command-line application” on page 161). A plate
setup file is a tab-delimited ASCII text file (TXT) that contains data that describes the
location experiment data information. The files can be created manually using a text
processor or generated automatically by third-party applications.

IMPORTANT! To guarantee successful import of the plate setup file into a
experiment, the file must contain all the elements described in the following section
and in the order that they appear.

File structure

The plate setup file consists of a header, which specifies the instrument model for
which the experiment is designed, and a sample setup section.

Section Description See...
' Defines the instrument model for which the “Plate setup file
Plate setup file . . : ”
experiment is designed and the dye used header” on
header .
as the passive reference. page 171

Defines the contents of a 96/384-well plate
Plate setup file body | or array card, including target, SNP assay,
sample, and task assignments.

“Plate setup file
body” on page 171
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Plate setup file header

The plate setup file begins with a header that consists of two lines. Each line starts
with an asterisk (*) and ends with a carriage return in the following pattern:

* <field name> = <field value>

The header must contain the lines shown in the following table.

Field Description Valid Values

The model of ViiA™ 7 System for which the

experiment is designed. ViiA 7

Instrument Type

® Thename of a
dye in the Dye
Library[', or
*  <blank> if the
consumable
does not
contain a
passive
reference.

The dye that the experiment will use as a

Passive Reference .
passive reference.

1 Custom dyes are allowed as long as they are in the Dye Library.

Note: The software automatically removes any leading and trailing white space
around the field name and field value.

Example:

* Instrument Type = ViiA 7
* Passive Reference = ROX

Plate setup file body

The body of a plate setup file contains either target information, which can be
imported into all experiments except genotyping, or SNP assay information. This
information can be imported into genotyping experiments only. The body consists of
three required elements (the header, the column header, and the body) that describe
the contents of a 96/384-well plate or array card. The sample setup column header
and body can appear in any order.

IMPORTANT! Observe the following guidelines when creating a plate setup file:

. Do not insert blank lines between the sample setup header and the column
header.

. Do not use illegal characters, including backslash (\), tab, asterisk (*), hard return,
soft return, brackets([ or ]), or comma (,).
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Sample setup header
The header contains the label that defines the beginning of the sample setup data.

Example:

[Sample Setup]

Sample setup column header

The column header contains the headings that define the positions of the data
columns in the sample setup body. The headings are separated by tab characters.
See “Plate setup data columns” on page 172 for a list of the data column headers.

Example:

Well Sample Name Sample Color Biogroup Name Biogroup Color Target Name..

Sample setup body

Contains the sample setup data where each row defines the contents of a single well
on the consumable, including the: well contents (sample, target, or SNP assay added
to the well), task assignments, and comments. If a well contains multiple assays
(multiplex PCR), the data for the additional assays are defined on separate lines by
repeating the well designation. See “Plate setup data columns” on page 172 for a list
of the data column headers.

Note: The sample setup data rows can occur in any order.

Example:

Well Sample Name Sample Color Biogroup Name Biogroup Color Target Name..
Liver cDNA “RGB (25,0,0)”

Liver cDNA “RGB (25,0,0)”

Liver c¢DNA “RGB (25,0,0)
Heart cDNA “RGB(0,25,0)”
Heart c¢cDNA “RGB(0,25,0)"”

”

O w N

Plate setup data columns

The following table lists the headings and columns that are present in the plate setup
file body of all experiment types followed by the columns that are specific to
genotyping experiments and non-genotyping experiments.

Column name Description Valid values

All experiments

The number of the well on the consumable, where
the well numbers start at 1 for well A1 (upper-left
corner) and increase from left to right and from top
to bottom.

Well <Positive integer (1 to 96/384)>I1]
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Column name

Description

Valid values

Sample Name

The name of the sample contained by the
associated well.

<100-character string>

Sample Color

(Optional) The RGB color of the associated
sample.

“RGB(<r>,<g>,<b>)"?

Biogroup Name

(Optional) The name of the associated biological
group.

<100-character string>

Biogroup Color

(Optional) The RGB color of the biological group.

“RGB(<r>,<g>,<b>)"12

Comments

(Optional) Additional text that describes the well.

“<1024-character string>"

All except genotyping

Target Name

The name of the target detected or amplified by
the assay in the associated well.

<100-character string>L!

Target Color

(Optional) The RGB color of the target.

“RGB(<r>,<g>,<b>)"12

associated well is not assigned the STANDARD
task, then the field is blank.

<

The task assignment of the target assay at the UNKNOWN | STANDARD | NTC

Task well 14 | ENDOGENOUS | IPC |
' BlockedIPC>

Reporter The reporter dye used by the associated target <dye name>")

assay.
Quencher The quencher dye used by the associated target <dye name>P)

assay.

(Optional) The quantity of standard present in the
Quantity given well expressed as a float or integer. If the <float or Integers

SNP Assay Name

The name of the SNP assay detected or amplified
by the assay in the associated well.

<100-character string>[®!

well.[4]

| PC_ALLELE BOTH>

Genotyping only
SNP Assay Color (Optional) SNP assay color in RGB “RGB(<r>,<g><b>)"1]
The task assignment of the SNP assay at the <UNKNOWN | NTC |
Task PC_ ALLELE 1 | PC_ALLELE 2

Allele1l Name

The name of the first allele detected by the SNP
assay.

<100-character string>[°!

Allele1 Color

The RGB color used to represent data for the first
allele.

“RGB(<r>,<g>,<b>)"12
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(continued)

Column name Description Valid values

The reporter dye used to label the probe for the

3,51
first allele. <dye name>

Allele1 Reporter

The quencher dye used to label the probe for the

[5]
first allele. <dye name>

Allele1 Quencher

The name of the second allele detected by the

- ing>1l
SNP assay. <100-character string>

Allele2 Name

The RGB color used to represent data for the

Allele2 Color
second allele.

“RGB(<r>,<g>,<b>)"12

The reporter dye used to label the probe for the

<dye name>[35]
second allele.

Allele2 Reporter

The quencher dye used to label the probe for the

<dye name>!
second allele. y

Allele2 Quencher

11 Cannot be blank.

2l Contains (ned, (b)lue, and (g)reen color values between 0 to 255. The field must be set within double quotes with no spaces between the values.
81 Can be empty if the Task field is empty. Otherwise, the field must contain a value

4 See the Applied Biosystems™ ViiA™ 7 Real-Time PCR System Getting Started Guide to determine the tasks applicable to your experiment.

Bl The dye must already exist in the Dye Library. The dye name must be 100 characters or less.

Examples
Quantitative PCR experiments

The following example shows a plate setup file created for a quantitative PCR
experiment to be run on a ViiA™ 7 System. The experiment evaluates the expression
of two targets (CCKAR and GH1) in three samples (cDNA from the liver, heart, and
brain). For both TagMan™ assays, the probes are labeled with the FAM™ reporter dye
and the non-fluorescent quencher (NFQ-MGB). Biological groups are not used in this
experiment.

* Instrument Type = ViiA 7

* Passive Reference = ROX

[Sample Setup]

Well Sample Name Sample Color Biogroup Name Biogroup Color Target Name Target
Color Task Reporter Quencher Quantity Comments

1 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
2 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
3 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
4 Heart cDNA “RGB(0,25,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
5 Heart cDNA “RGB(0,25,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
6 Heart cDNA “RGB(0,25,0)” CCKAR “RGB (98,25,0)” ENDOGENOUS FAM NFQ-MGB
7 Brain cDNA “RGB(0,0,25)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
8 Brain cDNA “RGB(0,0,25)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
9 Brain cDNA “RGB(0,0,25)” CCKAR “RGB (98,25,0)” ENDOGENOUS FAM NFQ-MGB
376 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
377 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
378 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
379 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
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380 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
381 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
382 Brain cDNA “RGB(0,0,25)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
383 Brain cDNA “RGB(0,0,25)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
384 Brain cDNA “RGB(0,0,25)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB

The following example shows a plate setup file for a multiplex version of the
experiment above, where the assays for the two targets (CCKAR and GH1 targets)
are added to the same well. For both TagMan™ assays, the probes are labeled with
the FAM™ reporter dye and the non-fluorescent quencher (NFQ-MGB).

* Instrument Type = ViiA 7

* Passive Reference = ROX

[Sample Setup]

Well Sample Name Sample Color Biogroup Name Biogroup Color Target Name Target
Color Task Reporter Quencher Quantity Comments

1 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB

1 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
2 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
2 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
3 Liver cDNA “RGB(25,0,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
3 Liver cDNA “RGB(25,0,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
4 Heart cDNA “RGB(0,25,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
4 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
5 Heart cDNA “RGB(0,25,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
5 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
6 Heart cDNA “RGB(0,25,0)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
6 Heart cDNA “RGB(0,25,0)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
7 Brain cDNA “RGB(0,0,25)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
7 Brain cDNA “RGB(0,0,25)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
8 Brain cDNA “RGB(0,0,25)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
8 Brain cDNA “RGB (0, O 25)' GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
9 Brain cDNA “RGB (0, 5)” CCKAR “RGB(98,25,0)” ENDOGENOUS FAM NFQ-MGB
9 Brain cDNA “RGB (0, 5)” GH1 “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB

Presence/absence experiments

The following example shows a plate setup file created for a presence/absence
experiment to be run on a ViiA™ 7 System. The experiment screens samples for the
presence of a pathogen (E. coli O157:H7). The detection assay uses FAM" and VIC™
dye-labeled TagMan™ probes to amplify a unique genomic sequence and an internal
positive control (IPC).

* Instrument Type = ViiA 7

* Passive Reference = ROX

[Sample Setup]

Well Sample Name Sample Color Biogroup Name Biogroup Color Target Name Target
Color Task Reporter Quencher Quantity Comments

1 Control “RGB(25,0,0)” E.coli “RGB(98,25,0)” NTC FAM NFQ-MGB

Control “RGB(25,0,0)” IPC “RGB(98,25,0)” NTC VIC NFQ-MGB
Control “RGB(25,0,0)” E.coli “RGB(98,25,0)” NTC FAM NFQ-MGB
Control “RGB(25,0,0)” IPC “RGB(98,25,0)” NTC VIC NFQ-MGB
Control “RGB(25,0,0)” E.coli “RGB(98,25,0)” NTC FAM NFQ-MGB

Control “RGB(25,0,0)” IPC “RGB(98,25,0)” NTC VIC NFQ-MGB

Pos Control “RGB(0,25,0)” E.coli “RGB(98,25,0)” IPC FAM NFQ-MGB
Pos Control “RGB (0,25,0)” IPC “RGB(98,25,0)” IPC VIC NFQ-MGB
Pos Control “RGB(0,25,0)” E.coli “RGB(98,25,0)” IPC FAM NFQ-MGB

s b wwbdhhN -
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5 Pos Control “RGB(0,25,0)” IPC “RGB(98,25,0)” IPC VIC NFQ-MGB

6 Pos Control “RGB(0,25,0)” E.coli “RGB(98,25,0)” IPC FAM NFQ-MGB

6 Pos Control “RGB(0,25,0)” IPC “RGB(98,25,0)” IPC VIC NFQ-MGB

7 Blocked IPC “RGB(0,0,25)” E.coli “RGB(98,25,0)” BlockedIPC FAM NFQ-MGB
7 Blocked IPC “RGB(0,0,25)” IPC “RGB(0,0,105)” BlockedIPC VIC NFQ-MGB

8 Blocked IPC “RGB(0,0,25)” E.coli “RGB(0,0,105)” BlockedIPC FAM NFQ-MGB
8 Blocked IPC “RGB(0,0,25)” IPC “RGB(0,0,105)” BlockedIPC VIC NFQ-MGB

9 Blocked IPC “RGB(0,0,25)” E.coli “RGB(0,0,105)” BlockedIPC FAM NFQ-MGB
9 )

Blocked IPC “RGB(0,0,25)” IPC “RGB(0,0,105)” BlockedIPC VIC NFQ-MGB
10 Sample0l “RGB(90,0,0)” E.coli “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
10 Sample0l “RGB(90,0,0)” IPC “RGB(0,0,105)” UNKNOWN VIC NFQ-MGB

11 Sample0l “RGB(90,0,0)” E.coli “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
11 Sample0l “RGB(90,0,0)” IPC “RGB(0,0,105)” UNKNOWN VIC NFQ-MGB

12 Sample0l “RGB(90,0,0)” E.coli “RGB(0,0,105)” UNKNOWN FAM NFQ-MGB
12 Sample0l “RGB(90,0,0)” IPC “RGB(0,0,105)” UNKNOWN VIC NFQ-MGB

Genotyping experiments

The following example shows a plate setup file created for a genotyping experiment
to be run on a ViiA"™ 7 System. The experiment screens samples for one SNP targets
(rs15934), using a set of allele-specific TagMan™ probes labeled with the FAM™ and
VIC™ reporter dyes and the non-fluorescent quencher (NFQ-MGB).

* Instrument Type = ViiA 7

* Passive Reference = Rox

[Sample Setup]

Well Sample Name Sample Color SNP Assay Name SNP Assay Color Task Allelel Name
Allelel Color Allelel Reporter Allelel Quencher Allele2 Name Allele2 Color
Allele2 Reporter Allele2 Quencher Comments

1 Neg Control “RGB(25,0,0)” SNP rsl15934 “RGB(0,75,0)” NTC G “RGB(0,0,50)” VIC NFQ-
MGB A “RGB(0,50,0)” FAM NFQ-MGB

2 Neg Control “RGB (25,0,0)” SNP rsl15934 “RGB(0,75,0)” NTC G “RGB(0,0,50)"” VIC NFQ-
MGB A “RGB(0,50,0)” FAM NFQ-MGB

3 Neg Control “RGB (25,0,0)” SNP rsl15934 “RGB(0,75,0)” NTC G “RGB(0,0,50)” VIC NFQ-
MGB A “RGB(0,50,0)” FAM NFQ-MGB

4 All Control “RGB(25,0,0)” SNP rsl1l5934 “RGB(0,75,0)” PC ALLELE 1 G “RGB(0,0,50)”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

5 All Control “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” PC ALLELE 1 G “RGB(0,0,50)"”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

6 All Control “RGB(25,0,0)” SNP rsl15934 “RGB(0,75,0)” PC ALLELE 1 G “RGB(0,0,50)"”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

7 Al2 Control “RGB(25,0,0)” SNP rsl5934 “RGB(0,75,0)” PC ALLELE 2 G “RGB(0,0,50)”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

8 Al2 Control “RGB(25,0,0)” SNP rsl15934 “RGB(0,75,0)” PC ALLELE 2 G “RGB(0,0,50)”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

9 Al2 Control “RGB(25,0,0)” SNP rsl15934 “RGB(0,75,0)” PC ALLELE 2 G “RGB(0,0,50)"”
VIC NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

10 SampleO0l “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

11 SampleO0l “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

12 SampleO0l “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

13 Sample02 “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

14 Sample02 “RGB(25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

15 Sample02 “RGB (25,0,0)” SNP rs15934 “RGB(0,75,0)” UNKNOWN G “RGB(0,0,50)” VIC
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NFQ-MGB A “RGB(0,50,0)” FAM NFQ-MGB

Sample file format

The QuantStudio™ Real-Time PCR Software can import sample files to populate
sample information into an open experiment. A sample file is a tab-delimited ASCII
text file (TXT) that contains sample/well designations and custom sample properties.
The files can be created manually using a text processor or generated automatically
by third-party applications.

IMPORTANT! To guarantee successful import, the file must contain all the elements
described in the following section and in the order that they appear.

Note: The command-line application (see “Software command-line application” on
page 161) does not import sample files. If you are using the application to create
experiments, use plate setup files to import sample information into the new
experiments (see “Plate setup file format” on page 170).

File structure
Sample file header row

The sample file begins with an optional header row that contains column headers for
well number (“Well”), sample name (“Sample Name”), and optional custom properties
names. The order of the columns is important and cannot be changed.

Sample file body

A body of rows, containing the sample data, follows the optional header row. Each
body row defines the sample information for a single well on the consumable,
including: well number, sample name, and any applicable custom fields. The body
can contain data for a subset of wells on the consumable, so the rows for empty
wells can be omitted from the file. The sample body rows can occur in any order.

Column name Description Valid values

The number of the well on the consumable,
where the well numbers start at 1 for well <Positive integer (1
A1 (upper-left corner) and increase from to 96/384)>

left to right and from top to bottom.

Well

The name of the sample contained by the <100-character
Sample Name . ]

associated well. string>
Custom1... (Optional) Additional text that describes the | <7024-character
Custom6 sample in the well. string>
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Example file

Well Sample Name Customl Custom2 Custom3 Custom4 Custom5 Custom6
21 Sample ltestl test2 test3 test4d testb testé6

22 Sample 2testl test2 test3 test4d testb testb6

23 Sample 3testl test3 test4d testb testo6

1 Sample 5S5testl test2 test3 testd4d testb test6

2 Sample 6testl test2 test3 testd testb testb

3 Sample 7testl test2 test3 test4d testb test6

4 Sample 8testl test2 test3 testd4d testb testb6

Bar code file format

The software command-line application can import bar code files to populate
experiment files (EDS) it generates with bar code information. A bar code file is a tab-
delimited ASCII text file (TXT) that contains a list of bar codes. The files can be
created manually using a text processor or generated automatically by third-party
applications.

IMPORTANT! To guarantee successful import, the file must contain all the elements
described in the following section and in the order that they appear.

File structure

The bar code file contains a list of bar codes, where each line defines a single bar
code terminated by a carriage return. The bar codes can occur in any order and
cannot contain starting or trailing white space.

Note: The software command-line application does not validate the bar codes.

Example file

HA996346102
IB894812348
DD834814679
EK209825848
AF092387348
FF225676243

Assay information file

The software command-line application can import data for Thermo Fisher Scientific
assays from assay information files (AIF). The AIF contains technical details about all
assays in the shipment. It includes information about assay concentrations; reporters
and quenchers used; part and lot numbers; and assay, vial, and plate ID numbers.
The file name includes the number from the bar code on the plate.
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Export formats and file specifications

Export formats

This section describes the export formats supported by the software. The information
provided in this appendix is intended for users who want to integrate the software
with third-party applications, including downstream analysis software and laboratory
information management system (LIMS) tools.

Note: The file specifications listed in this appendix are subject to change. For
updated information, review the software release notes available at the software
download page (thermofisher.com/qgpcrsoftware).

The software can export setup and results data from experiment files (EDS) in several
file formats that allow further downstream analysis. The export formats feature
standardized data structures and markup to maximize accessibility by downstream
applications.

The software supports the following export formats:

File format Description See...

A ViiA" 7-formatted text file that contains
setup and/or results data exported from an
experiment file (EDS).

“ViiA"™ 7 export

ViiA™ 7 export file format” on page 180

A legacy 7900-formatted text file that
contains setup and/or results data
exported from an experiment file (EDS).

“7900 export

7900 export file format” on page 199

A compressed XML file that contains setup
and/or results data exported from an
experiment file EDS) and parsed in Real-
time PCR Data Markup Language (RDML).
The file is stored as a compressed file
using the PKZIP archive format.

“RDML export

RDML export file format” on page 206

Export formats and the software API

The export formats can be used in combination with the software application
programming interface (API) to integrate the ViiA™ 7 System into a laboratory
information management system (LIMS) workflow.
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ViiA™ 7 export format

180

The software can export setup and results data from experiment files (EDS) to tab-
delimited text files (TXT) in a native ViiA" 7 System export format. Data exported in
the ViiA™ 7 export format can be opened by common spreadsheet applications, such
as Microsoft™ Excel ", or imported by laboratory information management system
(LIMS) applications or databases that have been configured to parse the file format.

File structure

The following table shows the data structure common to data exported in the ViiA™ 7
export format, regardless of experiment type. Each row represents one or more lines
of data in the exported file corresponding to a common functional group. Because
the ViiA™ 7 export format allows the user to customize and/or omit columns. The
columns and orders described below are the default configuration: all columns in
their natural order. Actual files may contain fewer columns if the user modified the

configuration.

such as the date and time of the run and
the dye used as the passive reference.

Section Description See...
Describes the qualities of the ViiA™ 7
Instrument used to run the experiment and - ”
. . . File header” on
File header several general experiment properties,

page 181

Sample setup data

Describes the configuration of samples on
the experiment consumable, including
sample location, target or SNP assay
properties, and task assignments.

“Sample setup data”
on page 182

Raw data

Contains the raw data collected by the
ViiA™ 7 Instrument during the experiment
run.

“Raw data” on
page 185

Amplification data

Contains the normalized data collected
during the cycling stage of PCR
amplification, which the software uses to
generate the amplification plot.

Note: Not applicable for
presence/absence, genotyping, or melting
curve experiments that are run without a
PCR (cycling) stage.

“Amplification data”
on page 186

Multicomponent
data

Contains the spectral data used by the
software to generate the multicomponent
plot that displays the contribution of each
dye over the duration of the PCR run.

“Multicomponent
data” on page 186

Results data

Contains the normalized, processed, and
analyzed data generated by the software.

“Results data” on
page 187
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The plate setup file begins with a header that describes the qualities of the ViiA™ 7
Instrument used to run the experiment and several other general experiment
properties. Each line starts with an asterisk (*) and ends with a carriage return in the

following pattern:

* <field name>

<field value>

Note: The software automatically removes any leading and trailing white space
around the field name and field value.

The header contains the lines listed in the following table.

Field Description Output
The model of the sample block installed to
Block Type the ViiA™ 7 Instrument at the time the 96/384-well or

experiment was run.

array card

Calibration Expired

Expiration status of the calibration.
Indicates whether the calibration of the
ViiA"™ 7 Instrument was current at the time
that the experiment was run.

Yes or No

Chemistry

The chemistry of the experiment.

<100-character
string>

Experiment File
Name

The path to the experiment file on the local
computer hard drive.

<filepath>

Experiment Name

The name of experiment entered into the
Experiment Name field.

<100-character
string>

Experiment Run End
Time

The date and time that the ViiA™ 7

Instrument finished running the experiment.

<date and time>

Experiment Type

The type of chemistry application for which
the experiment is designed.

Standard
Curve,
Presence/
Absence,
Relative
Standard
Curve, or DDCt
Quantification

Instrument Type

The model of the ViiA™ 7 Instrument that
ran the experiment.

viia™ 7

Passive Reference

The dye used as a passive reference (or
blank if the consumable did not contain
one).

<100-character
string>
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(continued)
Field Description Output
Signal Smoothing The smoothlng §ett|ng status for the .
on experiment. Indicates whether smoothing true or false
is turned on for the experiment.
Stage\Cycle where | The stage and cycle during the thermal ,

L . o T Stage <integer>,
Analysis is cycling protocol when the ViiA™ 7 Step <inteaers
performed Instrument collected data. P g
Calibration Date The date and time that the current <date and time>

background, ROI, uniformity, or pure dye
Cahpraﬁuon calibration was performed and when it will <date and time>
Expiration Date expire.
Instrument serial The serial number of the ViiA™ 7 Instrument <100-character
number that ran the experiment. string>
Quantification cycle | The method of quantification for the <100-character
method associated experiment. string>

Sample setup data

When selected as an export option, the software exports sample setup data after the
file header. The sample setup data describes the sample configuration on the
experiment consumable, including positions, sample names, task assignments,
assay information, and color coding.

The data consists of a column header followed by the sample data fields, where each
row contains the data for a single well separated by tab characters. If a well contains
more than one assay (target), the software lists the data for each additional assay on
separate rows, repeating the well number and sample information. The data included
in the sample setup data export varies depending on experiment type.
This section describes the following sample setup data formats:

* “Quantification and presence/absence experiments” on page 183

¢ “Genotyping experiments” on page 184
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Quantification and presence/absence experiments

The table below describes the sample setup data that can be exported from absolute
quantification, relative quantification, or presence/absence experiments. The body
can contain all or some of the data columns below depending on the export

configuration.

Note: For genotyping experiments, see“Genotyping experiments” on page 184

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!!

Sample Name

The name of the sample contained by the
well.

100-character string

Sample Color

The RGB color of the associated sample.

“RGB(<r>,<g>,<b>
)11[2]

Target Name

The name of one target in the well, if
applicable. If a well contains multiple
targets one row is used per target.

100-character string

Target Color

The RGB color of the associated SNP
assay.

“RGB(<r>,<g>,<r>
)2

Task

The task the target is used for in this well.

UNKNOWN,
STANDARD, IPC,
NTC, or
BlockedIPC

Reporter

The reporter dye that labels the probe for
the target assay.

100-character string

Quencher

The quencher dye that labels the probe for
the target assay.

100-character string

Quantity

Standard quantity (if applicable). This
column only appears for Standard Curve
and Relative Standard Curve experiments

Float or Integer

Comments

Additional text that describes the well.

1024-character
string

1" Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

' Contains (r)ed, (b)lue, and (g)reen color values, each between 0 to 255. The field is enclosed in double quotes
with no spaces between the values.
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Genotyping experiments

The table below describes the sample setup data that can be exported from a
genotyping experiment. The body can contain all or some of the data columns below
depending on the export configuration.

Note: For all other experiments, see“Quantification and presence/absence
experiments” on page 183.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!!

Sample Name

The name of the sample contained by the
well.

100-character string

Sample Color

The RGB color of the associated sample.

“RGB(<r>,<g>,<b>
)11[2]

SNP Assay Name

The name of the SNP assay applied to the
well. If the well contains multiple assays,
the data for each SNP assay are exported
in an additional row.

100-character string

SNP Assay Color

The RGB color of the associated SNP
assay.

“RGB(<r>,<g>,<b>
)”[2]

Task

The task assignment of the SNP assay at
the well.

UNKNOWN or NTC

Allele1l Name

The name of the first allele for the
associated SNP assay.

100-character string

Allele1 Color

The RGB color of the first allele for the
associated SNP assay.

“RGB(<r>,<g>,<b>
)11[2]

Allele1 Reporter

The reporter dye that labels the probe for
the first allele.

100-character string

Allele1 Quencher

The quencher dye that labels the probe for
the first allele.

100-character string

Allele2 Name

The name of the second allele for the
associated SNP assay.

100-character string

Allele2 Color

The RGB color of the second allele for the
associated SNP assay.

“RGB(<r>,<g>,<b>
)n[2]

Allele2 Reporter

The reporter dye that labels the probe for
the second allele.

100-character string
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(continued)

Column Description Output

The quencher dye that labels the probe for

Allele2 Quencher the second allele.

100-character string

1024-character

Comments Additional text that describes the well string

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

[l Contains (r)ed, (b)lue, and (g)reen color values, each between 0 to 255. The field is enclosed in double quotes
with no spaces between the values.

Raw data

The software can export the unprocessed raw data (R) collected by the ViiA™ 7
Instrument during the experiment run. The raw data consists of fluorescence readings
collected by the ViiA™ 7 Instrument that have not been normalized to the passive
reference.

The section begins with a column header followed by the raw data, where each row
contains the data for a single well separated by tab characters. Each line of raw data
consists of readings sorted by bin, where each bin represents an excitation/emission
filter pair that was selected during experiment setup. The bins are named for the
corresponding filter combination according to the following convention:

<excitation filter name>-<emission filter name>

Column Description Output

Integer (1 to

Well The number of the well on the consumable. 96/384)1

The cycle of the run during which the ViiA™

Cycle
y 7 Instrument recorded the fluorescence.

Integer

The raw fluorescence for the well measured
<Bin #> by the ViiA™ 7 Instrument for the Float
associated bin at the designated cycle.

[ Well numbers start at 1 for well A1 (upper-left comer) and increase from left to right and from top to bottom.
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Ampilification data

The software can export the processed amplification data used to generate the
amplification plot of a real-time PCR experiment. The amplification data (R,) are the
raw fluorescence readings collected by the ViiA™ 7 Instrument normalized to the
fluorescence from the passive reference. If available, the exported amplification data
also exports the baseline-compensated normalized fluorescence data (AR,)
calculated by the software.

The section begins with a column header followed by the amplification data, where
each row contains the data for a single well separated by tab characters. If a well
contains more than one assay (target), the software lists the data for each additional
assay on separate rows, repeating the well number and sample information.

instrument recorded the fluorescence.

Column Description Output
Well The number of the well on the consumable Integer (1 to
' 96/384)!]
Cycle The cycle of the run during which the Integer

Target Name

Genotyping experiments —The name of
the SNP assay assigned to the well and the
allele name.

<SNP assay
name>-<allele
name>

All other experiments—The name of the
target assigned to the well.

Name of the target

The raw fluorescence for the associated
well normalized to the fluorescence of the

associated well.

Rn . . Float
passive reference dye (reporter signal or
passive reference signal).

Delta Rn The baseline compensated R, value for the Float

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Multicomponent data

The software can export the data used to generate the multicomponent plot of a real-
time PCR experiment. The multicomponent data tracks the raw fluorescence of all
reporter dyes present on the reaction consumable throughout the duration of the

experiment run.

The section begins with a column header followed by the multicomponent data,
where each row contains the data for a single well separated by tab characters. The
multicomponent data contains a dye column for each dye present on the reaction
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consumable, including reporter dyes, quencher dyes (except non-fluorescent dyes),
and the passive reference.

the specified well and cycle.

Column Description Output
Well The number of the well on the consumable Integer (1 to
' 96/384)!]

The cycle of the run during which the ViiA™

Cycle 7 Instrument recorded the fluorescence Integer
data.
The raw fluorescence for the designated

<Dye name> dye measured by the ViiA™ 7 Instrument at Float

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Results data

The software can export the results data from an analyzed experiment file. The format
and content of the results data depends on the experiment type and the analysis

settings.

The section begins with a column header followed by the results data, where each
row contains the data for a single well separated by tab characters. If a well contains
more than one assay (target), the software lists the data for each additional assay on

separate rows, repeating the well number and sample information.

This section describes the following results data formats:

* “Standard curve, relative standard curve and comparative Ct experiments” on

page 188

* “Genotyping” on page 191

* “Melting curve” on page 192

* “Presence/absence” on page 194

* “Study data” on page 195

* “Technical replicate results” on page 190

* “Technical analysis result (study)” on page 197

* “BioGroup analysis results (study)” on page 198

* “Technical analysis result (study)” on page 197
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Standard curve, relative standard curve and comparative C;
experiments

The following table describes the results data exported from standard curve, relative
standard curve and comparative C; experiments. Because columns can be omitted
from the results, the exported file may contain a subset of the data columns below.

Column Description Output

Integer (1 to

Well The number of the well on the consumable. 96/384)1

The name of the sample contained by the

Sample Name
well.

100-character string

The name of the target assay added to the

Target Name
well.

100-character string

UNKNOWN, NTC,

Task The task assigned to the target in the well.
or STANDARD

The reporter dye that labels the probe for

Reporter the target assay.

100-character string

The quencher dye that labels the probe for

Quencher the target assay.

100-character string

The calculated threshold cycle (C;) for the

Ct target at the specified well.

Float

The average C; of the replicate wells for the

Gt Mean specified target/sample combination.

Float

The standard deviation of the average C; of

CtSD the replicate wells for the specified target.

Float

® Unknown wells—The calculated
quantity for the sample at the well.

Quantity Float

* Standard wells—The quantity
assigned to the standard at the well.

* Unknown wells—The average quantity
of the replicate wells for the
target/sample.

Quantity Mean Float

¢ Standard wells—The quantity
assigned to the replicate wells for the
target/sample.

The standard deviation of the average
Quantity SD quantity of the replicate wells for the Float
target/sample combination
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Column

Description

Output

Automatic Ct
Threshold

Whether the threshold was determined
automatically (true) or manually (false).

trueor false

Ct Threshold

The threshold cycle (Cy) for the sample at
the well

Float

Automatic Ct
Baseline

Whether the baseline was determined
automatically (true) or manually (false).

true or false

The first cycle used to calculate the

experiment.

Baseline Start . Integer
baseline.

Baseline End The Ie.lst cycle used to calculate the Integer
baseline.

Custom ... The cqntents of the custom text fields 1024-character
found in the Results table of the . :

Custom6 string (per field)

If analysis flags are present, results data is present in additional

trueor false

columns named for the associated flags.

1" Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Biological replicate results

The following table describes the results data exported from high resolution melting
curve experiments. Because columns can be omitted from the results, the exported
file may contain a subset of the data columns below.

Column Description Output

Biogroup Name The name of the biological replicate group. | 100-character string

The name of the target assay assigned to

Target Name the well.

100-character string

Task The task assigned to the target in the well. UNKNOWN or NTC

The relative quantity calculated for the
RQ replicate wells of the target/sample Float
combination.

The minimum relative quantity calculated
for the replicate wells of the target/sample

RQ Min combination. The lower limit of the Float
confidence interval.
The maximum relative quantity calculated

RQ Max for the replicate wells of the target/sample Float

combination. The upper limit of the
confidence interval.
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(continued)
Column Description Output
Ct Mean The a.l\./erage C; of the repllcatg We:IIs for the Float
specified target/sample combination.
Delta Ct Mean The aver?ge AC; of the replicate V\./ells. for Float
the specified target/sample combination.
The standard deviation of the AC; for the
replicate well. Depending on the analysis
Delta Ct SD settings, this column may by replaced with Float
“Delta Ct SE” (the standard error of the
AGy).
Delta Delta Gt The AAC.t yalue of the replicate wglls for Float
the specified target/sample combination.

Technical replicate results

The following table describes the results data exported from high resolution melting
curve experiments. Because columns can be omitted from the results, the exported
file may contain a subset of the data columns below.

Column Description Output

The name of the sample contained by the

Sample Name
well.

100-character string

The name of the target assay assigned to

Target Name the well.

100-character string

Task The task assigned to the target in the well. UNKNOWN or NTC

The relative quantity calculated for the
RQ replicate wells of the target/sample Float
combination.

The minimum relative quantity calculated
for the replicate wells of the target/sample
combination. The lower limit of the
confidence interval.

RQ Min Float

The maximum relative quantity calculated
for the replicate wells of the target/sample
combination. The upper limit of the
confidence interval.

RQ Max Float

The average C; of the replicate wells for the

Ct Mean specified target/sample combination.

Float

The average AC; of the replicate wells for

Deita Gt Mean the specified target/sample combination.

Float
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(continued)
Column Description Output

The standard deviation of the AC; for the
replicate well. Depending on the analysis

Delta Ct SD settings, this column may by replaced with Float
“Delta Ct SE” (the standard error of the
AGy).

Delta Delta Ct The AAC; value of the replicate wells for Float

the specified target/sample combination.

Genotyping

The following table describes the results data exported from genotyping experiments.
Because columns can be omitted from the results, the exported file may contain a
subset of the data columns below.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!"]

Sample Name

The name of the sample contained by the
well.

100-character string

SNP Assay Name

The name of the SNP assay added to the
well.

100-character string

Task

The task assigned to the target in the well.

UNKNOWN or NTC

Allele1 Rn

The raw fluorescence associated with the
allele 1 probe of the SNP assay at the well
normalized to the fluorescence of the
passive reference dye.

Float

Allele2 Rn

The raw fluorescence associated with the
allele 2 probe of the SNP assay at the well
normalized to the fluorescence of the
passive reference dye.

Float

Pass. Ref

The raw fluorescence of the passive
reference at the well.

Float

Quality(%)

The confidence of the automatic allele call.

Float (1 to 100)

Call

The allele call assigned to the sample at
the specified well.

Homozygous
<allele x/allele x>,
Heterozygous

<allele x/allele y>, or
Negative
Control (NC)

Method

The method used to call alleles.

Auto or Manual
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(continued)

Column

Description

Output

Allele1
Automatic Ct

Whether the allele 1 threshold was
determined automatically (true) or manually

true or false

Baseline End

baseline for allele 2.

Threshold (false).
Allelet The start cycle used to calculate the Eloat
Baseline Start baseline section of allele 1.
Allelet The end cycle used to calculate the Eloat
Baseline End baseline section of allele 1.
Allele2 Whether the allele 2 threshold was
Automatic Ct determined automatically (true) or manually | true or false
Threshold (false).
Allele2 The first cycle used to calculate the Float
Baseline Start baseline for allele 2.
Allele2 The last cycle used to calculate the

Float

Custom1...
Custom6

The contents of the custom text fields
found in the Results table of the
experiment.

1024-character
string (per field)

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Melting curve

The following table describes the results data exported from melting curve
experiments. Because columns can be omitted from the results, the exported file may
contain a subset of the data columns below.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!]

Sample Name

The name of the sample contained by the
well.

100-character string

Target Name

The name of the target assay assigned to
the well.

100-character string

Task The task assigned to the target in the well. UNKNOWN or NTC

Reporter The reporter dye that labels the probe for 100-character string
the target assay.

Quencher The quencher dye that labels the probe for 100-character string

the target assay.
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Column

Description

Output

Ct

The calculated threshold cycle (C;) for the
target at the specified well.

Float

Ct Mean

The average C; of the replicate wells for the
specified target/sample combination.

Float

CtSD

The standard deviation of the average C; of
the replicate wells for the specified target.

Float

Quantity

* Unknown wells—The calculated
quantity for the sample at the well.

* Standard wells—The quantity
assigned to the standard at the well.

Float

Quantity Mean

* Unknown wells—The average quantity
of the replicate wells for the
target/sample.

* Standard wells—The quantity
assigned to the replicate wells for the
target/sample.

Float

Quantity SD

The standard deviation of the average
quantity of the replicate wells for the
target/sample.

Float

Automatic Ct
Threshold

Whether the threshold was determined
automatically (true) or manually (false).

trueor false

Ct Threshold

The threshold cycle (Cy) for the sample at
the well.

Float

Automatic Ct
Baseline

Whether the baseline was determined
automatically (true) or manually (false).

true or false

The first cycle used to calculate the

experiment.

Baseline Start ) Integer
baseline.

Baseline End The Igst cycle used to calculate the Integer
baseline.
The first, second, and third melting

Tm1... Tm3 temperatures (T,,) calculated in degrees Float
Celsius.

Comments Additional text that describes the well. 1024;::;Cter

Custom ... The cqntents of the custom text fields 1024-character
found in the Results table of the . .

Custom6 string (per field)

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.
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Presence/absence

The following table describes the results data exported from presence/absence
experiments. Because columns can be omitted from the results, the exported file may
contain a subset of the data columns below.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!"]

Sample Name

The name of the sample contained by the
well.

100-character string

Target Name

The name of the target assay assigned to
the well.

100-character string

Task The task assigned to the target in the well. UNKNOWN or NTC
Reporter The reporter dye that labels the probe for 100-character string
the target assay.
Quencher The quencher dye that labels the probe for 100-character string
the target assay.
The raw fluorescence for the associated
Rn well normalized to the fluorescence of the Float
passive reference dye.
The averaged normalized fluorescence (R)
Rn Mean for thg associated replicate wells that Float
contain the same target/sample
combination.
The standard deviation of the normalized
Rn SD fluorescence (Ry) for the lassomated Float
replicate wells that contain the same
target/sample combination.
Threshold Value The.c.:alculated value of the threshold for a Float
positive call.
Negative
Control,
. Block IP
The presence/absence call assigned to the ocked <
Call sample at the specified well Control, IEC
P P ' railed,
Positive, or
Negative
Comments Additional text that describes the well 1024-character

string
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Column

Description

Output

Automatic Ct
Threshold

Indicates whether the threshold was
determined automatically (true) or manually
(false).

trueor false

Ct Threshold

The threshold cycle (Cy) for the sample at
the well.

Float

Automatic Ct
Baseline

Indicates whether the baseline was
determined automatically (true) or manually
(false).

true or false

The first cycle used to calculate the

experiment.

Baseline Start . Float
baseline.

Baseline End The |8..St cycle used to calculate the Float
baseline.

Customi .. The cgntents of the custom text fields 1024-character
found in the Results table of the . \

Custom6 string (per field)

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Study data

The following table describes the results data exported from a study of relative
quantification experiments. Because columns can be omitted from the results, the
exported file may contain a subset of the data columns below.

Column

Description

Output

Experiment Name

The name of the of the experiment.

100-character string

Well

The number of the well on the consumable.

Integer (1 to
96/384)!"]

Omitted

Whether the well was omitted from the
analysis (true) or included (false).

trueor false

Sample

The name of the sample contained by the
well.

100-character string

Target

The name of the target assay assigned to
the well.

100-character string

Task

The task assigned to the target in the well.

UNKNOWN or NTC

Reporter

The reporter dye that labels the probe for
the target assay.

100-character string

Quencher

The quencher dye that labels the probe for
the target assay.

100-character string
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(continued)

Column

Description

Output

RQ

The relative quantity calculated for the
replicate wells of the target/sample
combination.

Float

RQ Min

The minimum relative quantity calculated
for the replicate wells of the target/sample
combination. The lower limit of the
confidence interval.

Float

RQ Max

The maximum relative quantity calculated
for the replicate wells of the target/sample
combination. The upper limit of the
confidence interval.

Float

Ct

The calculated threshold cycle (C;) for the
target at the specified well.

Float

Ct Mean

The average C; of the replicate wells for the
specified target/sample combination.

Float

Delta Ct

The AC; value of the replicate wells for the
specified target/sample combination.

Float

Delta Ct Mean

The average AC; of the replicate wells for
the specified target/sample combination.

Float

Delta Ct SD

The standard deviation of the AC; for the
replicate well. Depending on the analysis
settings, this column may by replaced with
“Delta Ct SE” (the standard error of the
AGy).

Float

Delta Delta Ct

The AAG; value of the replicate wells for
the specified target/sample combination.

Float

Automatic Ct
Threshold

Indicates whether the threshold was
determined automatically (true) or manually
(false).

true or false

Ct Threshold

The threshold cycle (Cy) for the sample at
the well.

Float

Automatic Ct
Baseline

Whether the baseline was determined
automatically (true) or manually (false).

true or false

Baseline Start

The first cycle used to calculate the
baseline.

Float
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(continued)
Column Description Output
Baseline End The Ia.lst cycle used to calculate the Float
baseline.
The calculated efficiency of the target
Efficiency assay for the specified target/sample Float (1 to 100)
combination.

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Technical analysis result (study)

The following table describes the results data exported from high resolution melting
curve experiments. Because columns can be omitted from the results, the exported
file may contain a subset of the data columns below.

Column Description Output
Sample Name ;I'vr; name of the sample contained by the 100-character string
Target Name The name of the target assay assigned to 100-character string
the well.

Task The task assigned to the target in the well. UNKNOWN or NTC

. Indicates whether the well was omitted

Omitted . . trueor false
from the analysis (true) or included (false).
The relative quantity calculated for the

RQ replicate wells of the target/sample Float
combination.
The minimum relative quantity calculated

. for the replicate wells of the target/sample

RQ Min combination. The lower limit of the Float
confidence interval.
The maximum relative quantity calculated

RQ Max for thg repllcate wells of t.hel target/sample Float
combination. The upper limit of the
confidence interval.

Ct Mean The gyerage C; of the repllcatg we.tlls for the Float
specified target/sample combination.

Delta Ct Mean The avergge AC,; of the replicate V\I/ells. for Float
the specified target/sample combination.
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(continued)
Column Description Output

The standard deviation of the AC; for the
replicate well. Depending on the analysis

Delta Ct SD settings, this column may by replaced with Float
“Delta Ct SE” (the standard error of the
AGy).

Delta Delta Ct The AAC; value of the replicate wells for Float

the specified target/sample combination.

BioGroup analysis results (study)

The following table describes the results data exported from high resolution melting
curve experiments. Because columns can be omitted from the results, the exported
file may contain a subset of the data columns below.

Column

Description

Output

Biogroup Name

The name of the biological replicate group.

100-character string

The name of the target assay assigned to

Target the well. 100-character string
Task The task assigned to the target in the well. UNKNOWN or NTC
Omitted Indicates whether the well was omitted true of false

from the analysis (true) or included (false).

# Tech Replicates

The number of technical replicates in the
associated biological replicate group.

Integer

RQ

The relative quantity calculated for the
replicate wells of the target/sample
combination.

Float

RQ Min

The minimum relative quantity calculated
for the replicate wells of the target/sample
combination. The lower limit of the
confidence interval.

Float

RQ Max

The maximum relative quantity calculated
for the replicate wells of the target/sample
combination. The upper limit of the
confidence interval.

Float

Ct Mean

The average C; of the replicate wells for the
specified target/sample combination.

Float

Delta Ct Mean

The average AC; of the replicate wells for
the specified target/sample combination.

Float
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(continued)
Column Description Output
The standard deviation of the AC; for the
replicate well. Depending on the analysis
Delta Ct SD settings, this column may by replaced with Float
“Delta Ct SE” (the standard error of the
AGy).

The AAC; value of the replicate wells for

Deita Delta Ct the specified target/sample combination.

Float

7900 export format

The software can export setup and results data from experiment files (EDS) to tab-
delimited text files (TXT) in a legacy export format of the Applied Biosystems™
7900HT Real-Time PCR System. The 7900 export format features a standardized
data structure and markup to maximize accessibility by downstream applications.
Data exported in the ViiA™ 7 export format can be opened by common spreadsheet
applications, such as Microsoft™ Excel™, or imported by laboratory information
management system (LIMS) applications that have been configured to parse the file
format.

Note: Due to the very different nature of the ViiA™ 7 Instrument some export types
are not available.

Note: Column customization (sorting and omission) is not available. Only multiple
tab-delimited text files are supported.
Exportable files

The following table shows the data files that the spftware can export in the 7900
export format. Each row represents a single exportable data file.

File Description See...

Describes the configuration of samples on
the experiment consumable, including “Setup file” on
sample location, target or SNP assay page 200

properties, and task assignments.

Setup file

Contains the spectral data used by the
software to generate the multicomponent “Multicomponent
plot that displays the contribution of each file” on page 202
dye over the duration of the PCR run.

Multicomponent file

Contains the normalized, processed, and “Results file” on

Resullts file analyzed data generated by the software. page 203
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Setup file

When setup file is selected as an export option, the software exports sample setup
data to a stand-alone file. The sample setup file describes the sample configuration
on the experiment consumable, including sample and assay data, positions, and task
assignments.

File header

The file begins with several lines, shown in the following table, that describe the
experiment file and the ViiA™ 7 Instrument for which it is designed.

Category Component Output
. . Defines the version of Setup File format

File Version Integer
used to generate the document.

Plate Size Defines the number of wells in the plate Inteqer
modeled by the file (for example, 96/384). 9
Defines the ID of the Assay Plate. Normally .

Plate ID this is a bar code printed on the plate. 100-character string

***% Setup File Version <version number>
*** Qutput Plate Size <number of wells>
*** Qutput Plate ID <plate id>

Assay (detector) data

The assay data describes the qualities of the target assays present on the
consumable. (In the context of the 7900HT System, target assays are referred to as
“detectors.”) The section consists of multiple lines that define the total target assays
followed by a column header and tab-separated data. The first line defines the total
number of target assays on the consumable formatted as follows:

*** Number of Detectors <number of assays>
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The column header defines the columns of exported data followed by one or more
lines, where each row defines the properties of a single assay separated by tab

characters.

Column

Description

Output

Detector

The name of one target in the well, if
applicable. If a well contains multiple
targets one row is used per target.

100-character string

Reporter

The reporter dye that labels the probe for
the target assay.

100-character string

Quencher

The quencher dye that labels the probe for
the target assay.

100-character string

Description

The standard.

1024-character
string

Comments

The additional text that describes the well.

1024-character
string

Well data

After the assay data, the software exports the well data that describes the
configuration of samples and assays on the experiment consumable. The table below
describes the well data that can be exported from absolute quantification, relative
quantification, or presence/absence experiments. If a well contains more than one
assay, the software lists the setup data for each additional assay in additional
columns to the right of the existing data.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!]

Sample Name

The name of the sample contained by the
well.

100-character string

Detector Name

The name of one target assay applied to
the well, if applicable.

100-character string

Task

Task the target is used for in this well.

UNKNOWN,
STANDARD, or NTC

Quantity

The standard quantity (if applicable). This
column only appears for Standard Curve
and Relative Standard Curve experiments

Float or Integer

[ Well numbers start at 1 for well A1 (upper-left comer) and increase from left to right and from top to bottom.
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Multicomponent file

The software can export the data used to generate the multicomponent plot of a real-
time PCR experiment. The multicomponent data tracks the raw fluorescence of all
reporter dyes present on the reaction consumable throughout the duration of the
experiment run.

The file begins with a line that names the export format (SDS 2.3) and the type of
data contained by the file (multicomponent). A column header occurs next followed
by the multicomponent data, where each row contains the data for a single well
separated by tab characters. The multicomponent data contains a dye column for
each dye present on the reaction consumable, including reporter dyes, quencher
dyes (except non-fluorescent dyes), and the passive reference.

Column Description Output

Integer (1 to

Well The number of the well on the consumable. 96/384)1

Time The time in milliseconds after the start of Inteqer
the run when the reading was taken. 9

The temperature (°C) of the sample when
Temp the ViiA™ 7 Instrument recorded the Integer
fluorescence data.

The cycle of the run during which the ViiA™
Cycle 7 Instrument recorded the fluorescence Integer
data.

The raw fluorescence for the designated
<Dye name> dye measured by the ViiA™ 7 Instrument at Float
the specified well and cycle.

[ Well numbers start at 1 for well A1 (upper-left comer) and increase from left to right and from top to bottom.
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Results file

When selected as an export option, the software exports sample setup data to a
stand-alone file. The sample setup file describes the sample configuration on the
experiment consumable, including sample and assay data, positions, and task
assignments.

File header

The file begins with a line that names the export format (SDS 2.3) and the type of
data contained by the file (Std Results). The following lines, listed in the table below,
describe the qualities of the ViiA™ 7 Instrument and several other general experiment

properties.
Field Description Output
. The path to the experiment file on the )
Filename . < filename>
local computer hard drive.
The plate identifier entered into the < 100-character
PlatelD . . .
bar code filed of the experiment. string>
Standard
Curve,
Presence/
. L Absence,
Assay Type Thg type of cher@stry .appllc'atlon for Relative
which the experiment is designed.
Standard
Curve, or DDCt
Quantificatio
n
The date and time that the ViiA™ 7
Run Datetime Instrument finished running the < date and time>
experiment.
The user logged into the software at < 100-character
Operator . . .
the time the experiment was run. string>
ThermalCycleParams The thermal cycling profile for the 96/384-well or
experiment. array card

The software can export the results data from an analyzed experiment file. The format
and content of the results data depends on the experiment type and the analysis
settings.

The section begins with a column header followed by the results data, where each
row contains the data for a single well separated by tab characters. If a well contains
more than one assay (target), the software lists the data for each additional assay on
separate rows, repeating the well number and sample information.
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This section describes the following results data formats:

® “Standard curve, relative standard curve and comparative Ct experiments” on

page 204

* “Genotyping experiments” on page 205

Standard curve, relative standard curve and comparative C;

experiments

The following table describes the results data exported from standard curve, relative
standard curve and comparative C; experiments.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!]

Sample Name

The name of the sample contained by the
well.

100-character string

Detector Name

The name of the target assay added to the
well.

100-character string

The reporter dye that labels the probe for

specified target/sample combination.

Reporter the target assay. 100-character string
Task The task assigned to the target in the well. UNKNOWN,  NTC, or
STANDARD
Gt The calculated thrle.shold cycle (Cy) for the Float
target at the specified well.
* Unknown wells—The calculated
quantity for the sample at the well.
Quantity ® Standard wells—The quantity Float
assigned to the standard at the well.
¢ Unknown wells—The average quantity
of the replicate wells for the
target/sample.
Quantity Mean * Standard wells—The quantity Float
assigned to the replicate wells for the
target/sample.
The standard deviation of the average
Quantity SD quantity of the replicate wells for the Float
target/sample combination.
Ct Median The r.n.edlan C; of the repllcate. we!ls for the Float
specified target/sample combination.
Ct Mean The average C; of the replicate wells for the Float
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Column

Description

Output

CtSD

The standard deviation of the average C; of
the replicate wells for the specified target.

Float

Automatic Ct
Baseline

Indicates whether the baseline was
determined automatically (true) or manually
(false).

TRUE or FALSE

Baseline Start

The first cycle used to calculate the
baseline.

Integer

Baseline End

The last cycle used to calculate the
baseline.

Integer

Automatic Ct
Threshold

Indicates whether the threshold was
determined automatically (true) or manually
(false).

TRUE or FALSE

Ct Threshold

The threshold cycle (Cy) for the sample at
the well

Float

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

Genotyping experiments

The following table describes the results data exported from genotyping experiments.

Column

Description

Output

Well

The number of the well on the consumable.

Integer (1 to
96/384)!!

Sample Name

The name of the sample contained by the
well.

100-character string

SNP Assay Name

The name of the SNP assay added to the
well.

100-character string

The raw fluorescence associated with the
allele 1 probe of the SNP assay at the well

AlleleT Rn normalized to the fluorescence of the Float
passive reference dye.
The raw fluorescence associated with the

Allele? Rn allele 2 probe of the SNP assay at the well Float

normalized to the fluorescence of the
passive reference dye.
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(continued)
Column Description Output
Homozygous
<allele x/allele x>,
The allele call assigned to the sample at Heterozygous <allele
Call o
the specified well. x/allele y>, or
Negative
Control (NC)
Quality(%) The confidence of the automatic allele call. Float (1 to 100)
Method The method used to call alleles. Auto or Manual
Task The task assigned to the target in the well. UNKNOWN or NTC
Pass. Ref The raw fluorescence of passive reference Float
at the well.

1 Well numbers start at 1 for well A1 (upper-left corner) and increase from left to right and from top to bottom.

RDML export format

206

The software can export data from real-time quantitative PCR experiments as well-
formed Real-time PCR Data Markup Language (RDML), a structured extensible
markup language (XML) standard for quantitative PCR (qPCR) data. In combination
with the Minimal Information (MIQPCR) guidelines, the RDML element structure
describes all aspects of a gPCR experiment, including setup, analysis, and data
interpretation. The exported RDML data is saved as a flat text file that can be used to
transfer gPCR data between the software and third-party applications.

IMPORTANT! The RDML export format is available only for standard curve, gene
expression, and relative standard curve experiments.

For more information

The RDML standard is maintained by the RDML consortium, an organization that
consists of key developer groups and a member community. For more information on
the RDML format, visit the RDM organization website (www.rdml.org). The website
features free data management tools, including an on-line RDML file generator and
RDML software libraries.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the
user documentation may result in personal injury or damage to the instrument or
device. Ensure that anyone using this product has received instructions in general
safety practices for laboratories and the safety information provided in this
document.

. Before using an instrument or device, read and understand the safety information
provided in the user documentation provided by the manufacturer of the
instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets
(SDSs) and use appropriate personal protective equipment (gloves, gowns, eye
protection, and so on). To obtain SDSs, see the “Documentation and Support”
section in this document.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or
convey important safety information. In this document, the hazard symbol is used
along with one of the following user attention words.

* CAUTION!—Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe
practices.

* WARNING!—Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

* DANGER!—Indicates an imminently hazardous situation that, if not avoided, will
result in death or serious injury.

Standard safety symbols

Symbol and description

A CAUTION! Risk of danger. Consult the manual for further safety information.

A CAUTION! Risk of electrical shock.
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(continued)

Symbol and description

CAUTION! Hot surface.

CAUTION! Potential biohazard.

CAUTION! Ultraviolet light.

Symbole et description

MISE EN GARDE ! Risque de danger. Consulter le manuel pour d’autres
renseignements de sécurite.

>

MISE EN GARDE ! Risque de choc électrique.

MISE EN GARDE ! Surface chaude.

MISE EN GARDE ! Danger biologique potentiel.

BB P

MISE EN GARDE ! Rayonnement ultraviolet.

B
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Additional safety symbols

Symbol and description

é CAUTION! Moving parts.

CAUTION! Moving parts.

& CAUTION! Laser radiation.

Symbole et description

é MISE EN GARDE ! Parties mobiles.

MISE EN GARDE ! Parties mobiles.

& MISE EN GARDE ! Laser radiation.
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Location of safety labels

Label and location
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Control and connection symbols

Symbols and
descriptions

On (Power)

Off (Power)

Protective conductor terminal (main ground)

J_ Earth (ground) terminal
N

Alternating current

Direct current

Conformity symbols

Conformity mark Description
c UI. us Indicates conformity with safety requirements for Canada and U.S.A.
c € Indicates conformity with European Union requirements for safety
and electromagnetic compatibility.
& Indicates conformity with Australian standards for electromagnetic
compatibility.

Indicates conformity with China RoHS, Environmental Friendly Use
Period 25 Years.

Indicates conformity with the WEEE Directive 2012/19/EU.

A CAUTION! To minimize negative environmental impact from
disposal of electronic waste, do not dispose of electronic waste
in unsorted municipal waste. Follow local municipal waste
ordinances for proper disposal provision and contact customer
service for information about responsible disposal options.

B
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Safety information for instruments not manufactured by Thermo
Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed
or built by Thermo Fisher Scientific. Consult the manufacturer's documentation for
the information needed for the safe use of these products.

Instrument safety

General

CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels, you may be exposed to serious hazards including, but
not limited to, severe electrical shock.

Physical injury

CAUTION! Moving and Lifting Injury. The instrument is to be moved and
positioned only by the personnel or vendor specified in the applicable site
preparation guide. Improper lifting can cause painful and permanent back injury.

Things to consider before lifting or moving the instrument or accessories:
. Depending on the weight, moving or lifting may require two or more persons.

. If you decide to lift or move the instrument after it has been installed, do not
attempt to do so without the assistance of others, the use of appropriate moving
equipment, and proper lifting techniques.

. Ensure you have a secure, comfortable grip on the instrument or accessory.

. Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

. Do not lift an object and twist your torso at the same time. Keep your spine in a
good neutral position while lifting with your legs.

. Participants should coordinate lift and move intentions with each other before
lifting and carrying.

. For smaller packages, rather than lifting the object from the packing box, carefully
tilt the box on its side and hold it stationary while someone else slides the contents
out of the box.

‘ CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands clear
of moving parts while operating the instrument. Disconnect power before servicing.
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Electrical safety

WARNING! Fuse Installation. Before installing the instrument, verify that the fuses
are properly installed and the fuse voltage matches the supply voltage. Replace fuses
only with the type and rating specified for the unit. Improper fuses can damage the
instrument wiring system and cause a fire.

WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

. Plug the system into a properly grounded receptacle with adequate current
capacity.

. Ensure the electrical supply is of suitable voltage.

. Never operate the instrument with the ground disconnected. Grounding continuity
is required for safe operation of the instrument.

AVERTISSEMENT ! Veiller a utiliser une alimentation électrique appropriée.
Pour garantir le fonctionnement de I'instrument en toute sécurité :

. Brancher le systeme sur une prise électrique correctement mise a la terre et de
puissance adéquate.
. S’assurer que la tension électrique est convenable.

. Ne jamais utiliser I'instrument alors que le dispositif de mise a la terre est
déconnecté. La continuité de la mise a la terre est impérative pour le
fonctionnement de I'instrument en toute sécurité.

WARNING! Power Supply Line Cords. Use properly configured and approved line
cords for the power supply in your facility.

AVERTISSEMENT ! Cordons d’alimentation électrique. Utiliser des cordons
d’alimentation adaptés et approuvés pour raccorder I'instrument au circuit électrique
du site.

WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.

AVERTISSEMENT ! Déconnecter I’'alimentation. Pour déconnecter entierement
I’alimentation, détacher ou débrancher le cordon d’alimentation. Placer I'instrument
de maniére a ce que le cordon d’alimentation soit accessible.
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Cleaning and decontamination

CAUTION! Cleaning and Decontamination. Use only the cleaning and
decontamination methods that are specified in the manufacturer user documentation.
It is the responsibility of the operator (or other responsible person) to ensure that the
following requirements are met:

. No decontamination or cleaning agents are used that can react with parts of the
equipment or with material that is contained in the equipment. Use of such agents
could cause a HAZARD condition.

. The instrument is properly decontaminated a) if hazardous material is spilled onto
or into the equipment, and/or b) before the instrument is serviced at your facility or
is sent for repair, maintenance, trade-in, disposal, or termination of a loan. Request
decontamination forms from customer service.

. Before using any cleaning or decontamination methods (except methods that are
recommended by the manufacturer), confirm with the manufacturer that the
proposed method will not damage the equipment.

MISE EN GARDE ! Nettoyage et décontamination. Utiliser uniquement les
méthodes de nettoyage et de décontamination indiquées dans la documentation du
fabricant destinée aux utilisateurs. L'opérateur (ou toute autre personne responsable)
est tenu d’assurer le respect des exigences suivantes:

. Ne pas utiliser d’agents de nettoyage ou de décontamination susceptibles de
réagir avec certaines parties de I'appareil ou avec les matiéres qu’il contient et de
constituer, de ce fait, un DANGER.

. L’instrument doit étre correctement décontaminé a) si des substances
dangereuses sont renversées sur ou a I'intérieur de I’équipement, et/ou b) avant de
le faire réviser sur site ou de I'’envoyer a des fins de réparation, de maintenance, de
revente, d’élimination ou a I’expiration d’une période de prét (des informations sur
les formes de décontamination peuvent étre demandées auprés du Service
clientele).

. Avant d’utiliser une méthode de nettoyage ou de décontamination (autre que
celles recommandées par le fabricant), les utilisateurs doivent vérifier aupres de
celui-ci qu’elle ne risque pas d’endommager I'appareil.

Instrument component and accessory disposal

To minimize negative environmental impact from disposal of electronic waste, do not
dispose of electronic waste in unsorted municipal waste. Follow local municipal
waste ordinances for proper disposal provision and contact customer service for
information about responsible disposal options.
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Laser safety—barcode scanner

The optional barcode scanners included with the ViiA™ 7 Real-Time PCR System are
categorized as Class 2 (ll) lasers.

Class 2 (ll) lasers are low-power, visible-light lasers that can damage the eyes. Never
look directly into the laser beam. The scanner is designed to prevent human access
to harmful levels of laser light during normal operation, user maintenance, or during
prescribed service operations.

The following table lists laser safety symbols and alerts that may be present on the
instrument.

Alert

& CAUTION! LASER HAZARD, Bar Code Scanner. The bar code scanner included
with the instrument system is a Class 2 laser. To avoid damage to eyes, do not
stare directly into the beam or point into another person's eyes.

Alerte

& MISE EN GARDE ! RISQUE LIE AU RAYONNEMENT LASER, Lecteur de code-
barres. Le lecteur de code-barres inclut dans l'instrument est un appareil laser de
classe 2. Pour éviter toute Iésion oculaire, ne regardez pas directement le faisceau
et ne le dirigez pas vers les yeux d'une autre personne.

Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These
hazards are caused by potential risk factors that include but are not limited to
repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

* Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the following standards and
requirements for safety and electromagnetic compatibility.

Safety standards

Reference Description

EU Directive 2014/35/EU European Union “Low Voltage Directive”

IEC 61010-1 Safety requirements for electrical equipment for measurement, control, and laboratory

EN 61010-1 use — Part 1: General requirements

UL 61010-1

CAN/CSA C22.2 No.

61010-1

IEC 61010-2-010 Safety requirements for electrical equipment for measurement, control and laboratory

EN 61010-2-010 use — Part 2-010: Particular requirements for laboratory equipment for the heating of
materials

IEC 61010-2-081 Safety requirements for electrical equipment for measurement, control and laboratory

use — Part 2-081: Particular requirements for automatic and semi-automatic laboratory

EN 61010-2-081 , )
equipment for analysis and other purposes

EMC standards

Reference Description

EU Directive 2014/30/EU European Union “EMC Directive”

EN 61326-1 Electrical Equipment for Measurement, Control and Laboratory Use — EMC

IEC 61326-1 Requirements — Part 1: General Requirements

FCC Part 18 (47 CFR) U.S. Standard “Industrial, Scientific, and Medical Equipment”

AS/NZS CISPR 11 Limits and Methods of Measurement of Electromagnetic Disturbance Characteristics
of Industrial, Scientific, and Medical (ISM) Radiofrequency Equipment

ICES-001, Issue 4 Industrial, Scientific and Medical (ISM) Radio Frequency Generators
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Environmental design standards

Reference Description
Directive 2012/19/EU European Union “WEEE Directive” —Waste electrical and electronic equipment
Directive 2011/65/EU European Union “RoHS Directive” —Restriction of hazardous substances in electrical

and electronic equipment

SJ/T 11364-2014

“China RoHS” Standard—Marking for the Restricted Use of Hazardous Substances in
Electronic and Electrical Products

For instrument specific certificates, visit our customer resource page at
www.thermofisher.com/us/en/home/technical-resources/rohs-certificates.html.
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WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure
laboratory personnel read and practice the general safety guidelines for chemical
usage, storage, and waste provided below. Consult the relevant SDS for specific
precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. To obtain SDSs, see the "Documentation and Support" section in this
document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling,
and disposal limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION
DE PRODUITS CHIMIQUES. Pour minimiser les risques, veiller a ce que le
personnel du laboratoire lise attentivement et mette en ceuvre les consignes de
sécurité générales relatives a I'utilisation et au stockage des produits chimiques et a
la gestion des déchets qui en découlent, décrites ci-dessous. Consulter également la
FDS appropriée pour connaitre les précautions et instructions particulieres a
respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le
fabricant avant de stocker, de manipuler ou d’utiliser les matériaux dangereux ou
les produits chimiques. Pour obtenir les FDS, se reporter a la section
« Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de
protection appropriés lors de la manipulation des produits chimiques (par
exemple : lunettes de slreté, gants ou vétements de protection).
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. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de
produits chimiques ouverts. lls ne doivent étre utilisés qu’avec une ventilation
adéquate (par exemple, sorbonne).

. Veérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques.
En cas de fuite ou d’écoulement d’un produit, respecter les directives de
nettoyage du fabricant recommandées dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient
primaire contient les déchets immédiats, le récipient secondaire contient les fuites
et les écoulements du récipient primaire. Les deux récipients doivent étre
compatibles avec les matériaux mis au rebut et conformes aux exigences locales,
nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le
couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les
applications, les réactifs et les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et
éliminés en respectant toutes les réglementations locales, nationales et/ou
communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif
exigent parfois une manipulation spéciale, et des limitations peuvent s’appliquer a
leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the
instrument is potentially hazardous. Follow the guidelines noted in the preceding
General Chemical Handling warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste
bottles can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position.

Applied Biosystems™ VIIA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, Networking, and Security 219



Appendix F Safety

Biological hazard safety

Biological hazard safety
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WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities with the
appropriate safety equipment (for example, physical containment devices). Safety
equipment can also include items for personal protection, such as gloves, coats,
gowns, shoe covers, boots, respirators, face shields, safety glasses, or goggles.
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially biohazardous materials.
Follow all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in laboratory
environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and

Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112,
Revised December 2009; found at:

https://www.cdc.gov/labs/pdf/
CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2009-P.pdf

. Occupational Safety and Health Standards, Bloodborne Pathogens

(29 CFR§1910.1030), found at:
osha.gov/laws-regs/regulations/standardnumber/1910/1910.1030

Your company’s or institution’s Biosafety Program protocols for working with or
handling potentially infectious materials.

. Additional information about biohazard guidelines is available at: cdc.gov
. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,

WHO/CDS/CSR/LY0/2004.11; found at:
www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document Pub. No.
Applied Biosystems™ ViiA"™ 7 Real-Time PCR System Site Preparation Guide 4445302
Applied Biosystems™ ViiA™ 7 Real-Time PCR System Getting Started Guide 4441434

QuantStudio™ Real-Time PCR Software v1.6.1

Applied Biosystems™ ViiA™ 7 Real-Time PCR System Quick Reference Guide MANO0018831

QuantStudio™ Real-Time PCR Software v1.4

Applied Biosystems™ ViiA™ 7 Real-Time PCR System User Guide: Calibration, Maintenance, 4442661
Networking, and Security

Applied Biosystems™ ViiA™ 7 Real-Time PCR System Quick Reference Guide 4448987

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.

Worldwide contact telephone numbers

Product support information
- Product FAQs

— Software, patches, and updates

— Training for many applications and instruments

Order and web support

Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.
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Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale at
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you
have any questions, please contact Life Technologies at www.thermofisher.com/

support.
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Glossary
AlF

AIX

allele

amplicon

amplification

amplification
efficiency (EFF
%)

amplification
plot

amplification
stage

Glossary

See “assay information file (AIF)” on page 224.

XML version of the assay information file. See also “assay information file (AIF)” on
page 224.

In a diploid organism, one of two DNA sequences found at the same locus (for
example, a particular gene), but located on homologous chromosomes. Two
corresponding alleles may have the identical sequence, or they may differ somewhat,
often at one or more single-base sites (SNPs).

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR amplifies the target. Fluorescence data
collected during amplification are displayed in an amplification plot, and the data are
used to calculate results.

Note: Only quantitative real-time PCR experiments, not end-point experiments, take
amplification data into account.

Calculation of the efficiency of the PCR amplification in an experiment. EFF% is
calculated using the slope of the regression line in the standard curve. A slope close
to -3.32 indicates optimal, 100% PCR amplification efficiency.

Display of data collected during the cycling stage of PCR amplification. The
amplification plot can be viewed as:

* Baseline-corrected normalized reporter (ARn) vs. cycle
* Normalized reporter (Rn) vs. cycle
* Threshold cycle (Cy) vs. well

Part of the instrument run in which PCR amplifies the target. The amplification stage,
called a cycling stage in the thermal profile, consists of denaturing, primer annealing,
and extension steps that are repeated. Fluorescence data collected during the
extension stage are displayed in an amplification plot, and the data are used to
calculate results. With TagMan™ chemistry, the last two steps of a PCR stage are
typically combined.
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assay

Assay ID

assay
information file
(AIF)

background
calibration

baseline

baseline-
corrected
normalized
reporter (ARN)

baseline
threshold
algorithm

biological
replicates

See also “cycling stage” on page 225.

In a PCR reaction mix, two target-specific primers or two primers and a probe used
to amplify a target.

Identifier assigned by Thermo Fisher Scientific to TagMan™ assays.

Tab-delimited data file on a CD shipped with each assay order. The AIF contains
technical details about all assays in the shipment. It includes information about assay
concentrations, reporters and quenchers used,, part and lot numbers, and assay,
vial, and plate ID numbers. The file name includes the number from the bar code on
the plate.

Type of calibration in which the instrument performs reads of a background plate,
averages the spectra recorded during the run, and extracts the resulting spectral
component to a calibration file. The software then uses the calibration file during
subsequent runs to remove the background fluorescence from the run data.

In the ampilification plot, a cycle-to-cycle range that defines background
fluorescence. This range can be set manually on an assay-by-assay basis, or
automatically to set each individual well.

The magnitude of normalized fluorescence signal generated by the reporter. In
experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs Cycle amplification plot, ARn is calculated at each cycle
as:

ARn (cycle) = Rn (cycle) - Rn (baseline), where Rn = normalized reporter

See also “normalized reporter (Rn)” on page 228.

Expression estimation algorithm (C;) which subtracts a baseline component and sets
a fluorescent threshold in the exponential region for gene quantification.

Reactions that contain identical components and volumes, but evaluate separate
samples of the same biological source (for example, samples from three different
mice of the same strain, or separate extractions of the same cell line or tissue
sample).

When an experiments uses biological replicate groups in a gene expression study,
the values displayed in the Biological Replicates tab are calculated by combining the
results of the separate biological samples and treating this collection as a single
population (that is, as one sample). For AC; computations (normalizing by the
endogenous control) in a singleplex experiment, the software treats separate
biological samples as unpaired data when computing variability estimates of the
single biological replicate. Individual contributions of the separate biological samples
to the single biological replicate results are observed in the Technical Replicates tab.
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custom dye

cycle threshold

cycling stage

delta Rn (ARn)

dye calibration

Dye Library

EFF%

error
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See also “technical replicates” on page 234.

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks ampilification of the internal positive control (IPC). In the software, also the
name of the task for the IPC target in wells that contain IPC blocking agent. See also
“negative control (NC)” on page 228.

See “reference sample” on page 230.
See “reagents” on page 230.
See “threshold cycle (Ct)” on page 235.

Dye that is not precalibrated for an instrument. Custom dyes that fall within the
emission wavelength range of the instrument can be added and adapted for use in
experiments on the ViiA™ 7 Instrument. To use a custom dye, add the dye to the Dye
Library and perform a dye calibration.

See “threshold cycle (Ct)” on page 235.

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage.

See also “amplification stage” on page 223.

See “baseline-corrected normalized reporter (ARn)” on page 224.

Type of calibration in which the software collects spectral data from a series of dye
standards and stores the spectral information for the dye standards in a pure spectra
calibration file. This file is used during experiment runs to characterize and distinguish
the individual contribution of each dye in the total fluorescence collected by the
instrument.

In the software, a collection of dyes to use in experiments. Custom dyes can be
added to the library, but system dyes cannot be removed. Before using a dye, make
sure that the dye calibration is current in the Instrument Console.

See “amplification efficiency (EFF%)” on page 223.

The standard error of the slope of the regression line in the standard curve.

The error can be used to calculate a confidence interval (Cl) for the slope. Because
the “amplification efficiency (EFF%)” on page 223 is calculated from the slope,
knowing the error allows a Cl for the amplification efficiency to be calculated.
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experiment Refers to the entire process of performing a run, including setup, run, and analysis.
You can perform the following types of experiments:

¢ Quantification - Standard curve

¢ Quantification - Relative standard curve
¢ Quantification - Comparative C; (AACy)
* Melt Curve

¢ Genotyping

* Presence/absence

experiment The Thermo Fisher Scientific name for the electronic records that comprise all

document information about a particular plate or array card consumable, including metadata
(name, bar code, comments), plate setup (well contents, assay definitions), run
method (thermal cycling protocol), run results, analysis protocol, analysis results,
audit records, and other plate-specific data. Experiment documents have the suffixes
EDS (experiment document single), EDT (template), and EDM (multiple).

experiment Entered during experiment setup, the name that is used to identify the experiment.
name

Experiment A software feature that allows you to set up an experiment according to your
Setup experiment design. Experiment Setup provides you with maximum flexibility in the

design and setup of your experiment.

experiment type The type of experiment to perform:
¢ Standard curve

¢ Comparative C; (AAGy)
¢ Relative standard curve
* Genotyping

* Presence/absence

* Melt curve

The experiment type that you select affects setup, run, and analysis.
export A software feature that allows you to export experiment setup files, experiment

results, instrument information, and security and auditing settings to spreadsheet,
presentation, or text files. You can edit the default location of the exported file.

filter Dye excitation and emission filter combination that you select for an experiment. The
ViiA™ 7 System includes a six-color filter set that supports FAM™, NED™, ROX™,
SYBR™ Green, TAMRA™, and VIC™ dyes.
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IPC
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melt curve stage
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A quality control (QC) indicator which, when applied by the software to a well during
analysis, indicates a possible issue with that reaction. For example, a flag may be
issued if no amplification is detected in a well. Flags indicating potential problems are
displayed in the Quality Control tab of the plate layout, well table, and QC Summary
screens.

Oligonucleotide that flanks the 5’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

In the thermal profile, the stage that holds the temperature constant for a defined
period of time. A stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a
reaction.

A gene that is involved in basic cellular functions and that may be constitutively
expressed. Housekeeping genes may be candidates for use as endogenous controls;
however, their constancy should always be validated experimentally.

A software feature that allows you to import plate setup information or security
settings before an experiment run. You can also import information into some
libraries in the system.

A software feature that allows you to view information about instruments on the
network. In the Instrument Console, you can monitor the status of any instrument on
the network; view calibration, maintenance, and instrument properties for a selected
instrument; and open and close the instrument drawer.

A software feature that allows you to view information about instrument available on
the network. In the Instrument Manager, you can monitor the status of an instrument;
monitor amplification plots and temperature plots in real time; view the calibration
status, perform calibrations and manage files on the instrument, including
downloading completed experiments to your computer.

In presence/absence experiments, a short synthetic DNA template that is added to
PCR reactions. The IPC can be used to distinguish between true negative results (the
target is absent in the samples) and negative results caused by PCR inhibitors,
incorrect assay setup, or reagent or instrument failure.

See “internal positive control (IPC)” on page 227.

See “negative control (NC)” on page 228

In the thermal profile, a stage with a temperature increment to generate a melt curve.
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melting
temperature

(Tm)

melting
transition region

negative control
(NC)

no template
control (NTC)

nonfluorescent
quencher-minor
groove binder
(NFQ-MGB)

normalization
calibration

normalized
quantity

normalized
quantity mean

normalized
quantity SE

normalized
reporter (Rn)

omit well

outlier

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA
is dissociated into single-stranded DNA. In a melt curve experiment, the melt curve
plot displays the melting temperature.

In Melt Curve experiments, the region before and after the “melting temperature (Tm)”
on page 227.

The task for targets or SNP assays in wells that contain water or buffer instead of
sample. No amplification of the target should occur in negative control wells.
Previously called no template control (NTC).

See “negative control (NC)” on page 228.

Molecules that are attached to the 3’ end of TagMan'™ probes. When the probe is
intact, the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting
fluorescence signal. Because the NFQ does not fluoresce, it produces lower
background signals, resulting in improved precision in quantification. The minor
groove binder (MGB) increases the melting temperature (T,,) of the probe without
increasing its length, allowing for the design of shorter probes.

Type of calibration in which the software collects data from the normalization
standards, then stores it in a normalization calibration file. This file is used in
comparisons of data from multiple instruments within a study.

Either the C; Avg. of the target gene minus the C; Avg. of the endogenous control
(Comparative C; experiments), or the Q Avg. of the target divided by the Q Avg. of the
endogenous control (Relative Standard Curve experiments).

The relative standard curve equivalent of the AC; mean value found in Comparative
C; experiments (computed as the geometric mean).

The relative standard curve equivalent of the AC; SE value found in Comparative C;
experiments (computed as the geometric standard error of the mean).

Fluorescence signal from the reporter dye normalized to the fluorescence signal of
the passive reference dye (usually ROX™ dye on Thermo Fisher Scientific
instruments).

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.
You can add wells back in to the analysis; no information is permanently discarded.

A measurement (such as a C;) that deviates significantly from the measurement of the
other replicates for that same sample.
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A dye that produces fluorescence signal independent of PCR amplification, and that
is added to each reaction at a constant concentration. Because the passive reference
signal should be consistent across all wells, it is used to normalize the reporter dye
signal to account for non-PCR related fluorescence fluctuations caused by minor
well-to-well differences in volume. Normalization to the passive reference signal
generally results in data with noticeably high precision among technical replicates.

An illustration of the grid of wells and assigned content in the reaction plate. The
number of rows and columns in the grid depends on the sample block that you use.

In the software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be
printed, included in a report, exported, and saved as a slide for a presentation.

A file (TXT, CSV, XML, or SDS) that contains setup information such as the well
number, sample name, sample color, target name, dyes, and other reaction plate
contents.

One standard in a standard curve. The standard quantity for each point in a standard
curve is calculated based on the starting quantity and serial factor.

In genotyping and presence/absence experiments, a DNA sample with a known
genotype, homozygous or heterozygous.

In the software, the task for the SNP assay in wells that contain a sample with a
known genotype.

PCR reaction component that contains the forward primer and reverse primer
designed to amplify the target.

PCR reaction component that contains the primers designed to amplify the target
and a TagMan" probe designed to detect ampilification of the target.

Fluorescent compound used to calibrate the instrument. See “system dye” on
page 234.

The fractional PCR cycle used for quantification, according to the “Real-time PCR
Data Markup Language (RDML)” on page 230 data standard. C; and C are the
algorithm-specific calculations of Cg.

In quantification experiments, the amount of target in the samples. Absolute quantity
can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the
fold-difference between normalized quantity of target in the sample and normalized
quantity of target in the reference sample.
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qguencher

R? value

raw data plot

reaction mix

reagents

real-time PCR

Real-time PCR
Data Markup
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(RDML)

reference

reference
sample

refSNP 1D

A molecule attached to the 3’ end of TagMan™ probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan™ reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the
guencher. With SYBR™ Green reagents, no probe (and therefore no quencher) is
used.

Regression coefficient calculated from the regression line in the standard curve. An
important quality value, the R? value indicates the closeness of fit between the
standard curve regression line and the individual C; data points from the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points.

A plot of raw fluorescent signal as detected through each emission filter, used to view
raw data for individual wells and at individual cycles.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called a “PCR cocktail”.

The PCR reaction components used to amplify the target and to detect amplification.

Process of collecting fluorescence data during PCR. Data from the real-time PCR are
used to calculate results for quantification experiments or to troubleshoot results for
genotyping or presence/absence experiments.

A reporting format that is compliant with the Minimum Information for Publication for
Quantitative Real Time Experiments (MIQE) guidelines.

In an HRM experiment, the melt curve selected by a user in the difference plot to use
as a basis for comparison. The software displays the aligned data as the difference in
fluorescence between the reference curve and the other melt curves.

In relative standard curve and Comparative C; (AAC;) experiments, the sample used
as the basis for relative quantification results. Also called the calibrator.

The reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search
thermofisher.com for an TagMan™ SNP Genotyping Assay. Also called an rs
number.
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Type of calibration in which the software maps the positions of the wells on the
sample block of the instrument. The software uses the ROI calibration data to
associate increases in fluorescence during a run with specific wells of the plate. A
calibration image for each individual filter must be generated to account for minor
differences in the optical path.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality
of results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Ci=mlog (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also “regression coefficients” on page 231.

An action that the software performs during analysis to remove one or more wells
from further analysis if a specific flag is applied to the well.

An experimental method to determine relative quantities. This method compensates
for target and endogenous control efficiency differences within each run. In all
experiments, unknown samples and dilution series of template (such as cDNA) are
amplified. Following a run, the instrument software interpolates relative quantities for
each unknown sample from the appropriate dilution curve, then normalizes the data
for each sample (or set of replicates) as follows: target QAvg. + endogenous control
QAvg.

A user-defined biological grouping. A replicate group may be a set of identical
reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

A fluorescent dye used to detect amplification. With TagMan™ reagents, the reporter
dye is attached to the 5’ end. With SYBR™ Green reagents, the reporter dye is
SYBR"™ Green dye. SYBR™ and HRM-specific dyes are DNA-binding dyes.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA.

See “normalized reporter (Rn)” on page 228.
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ROX™ dye

rs number

run method

sample

sample
definition file

security,
auditing and
eSignature

serial factor

slope

stage

A dye supplied by Thermo Fisher Scientific and precalibrated on the instrument.
ROX™ dye is used as the passive reference.

See “refSNP ID” on page 230.

Definition of the reaction volume and the thermal profile for the instrument run. The
run method specifies the temperature, time, ramp, and data collection points for all
steps and stages of the instrument run.

The biological tissue or specimen that you are testing for a target gene.

A tab-delimited file (TXT or CSV) that contains the following setup information: well
number, sample name, and custom sample properties.

An optional software module that provides:

* System Security — Controls user access to the software. A default Administrator
user account is provided, and you can define additional user accounts and
permissions.

* Auditing — Tracks changes made to library items, actions performed by users,
and changes to the Security and Audit settings. The software automatically
audits some actions silently. You can select other items for auditing and specify
the audit mode. Provides reports for audited library items, Security and Audit
changes, and actions.

* Electronic Signature (eSignature) — Controls whether users are permitted,
prompted, or required to provide a user name and password when accessing
certain software features. You can select which features are controlled and the
number of signatures required for access. When authorized persons use this
feature, they are creating a legally binding signature.

In the software, a numeric value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard
curve is defined with a serial factor of 1:10 or 10X, the difference between any 2
adjacent points in the curve is 10-fold.

Regression coefficient calculated from the regression line in the standard curve. The
slope indicates the PCR amplification efficiency for the assay. A slope of -3.32
indicates 100% amplification efficiency.

See also “amplification efficiency (EFF%)” on page 223 and “regression line” on
page 231.

In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling
stage (also called amplification stage), and hold stage.
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A sample that you dilute and amplify along with unknown samples. This dilution
series can contain known starting quantities of the target of interest (absolute
standard curve) or it can be of known dilution factor (relative standard curve).
Following the run, the software interpolates the C; values of the unknowns to this
curve, yielding either specific quantities of the target (for absolute curves) or relative
quantities (for relative dilution curves).

See also “standard curve” on page 233.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C; values from the standard reactions plotted
against standard quantities.

* A set of standards containing a range of known quantities. Results from the
standard curve reactions are used to generate the standard curve. The standard
curve is defined by the number of points in the dilution series, the number of
standard replicates, the starting quantity, and the serial factor.

Method for determining absolute target quantity in samples. With the standard curve
method, the software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate
the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples.

See also “standard” on page 232 and “standard curve” on page 233.

In standard curve and relative standard curve experiments, a set of standards
containing a range of known quantities. The standard dilution series is prepared by
serially diluting standards. For example, the standard stock is used to prepare the
first dilution point, the first dilution point is used to prepare the second dilution point,
and so on. In the software, the volumes needed to prepare a standard dilution series
are calculated by the number of dilution points, the number of standard replicates,
the starting quantity, the serial factor, and the standard concentration in the stock.
See also “standard curve” on page 233.

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of
target in the standard. In the software, the units for standard quantity can be for
mass, copy number, viral load, or other units for measuring the quantity of target.
Standard quantity can also refer to dilution factor.

When defining a standard curve in the software, the highest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set
the ramp rate (ramp increment for melt curve steps), hold temperature, and hold time
(duration).You can turn data collection on or off for the ramp or the hold parts of the
step. For cycling stages, a step is also defined by the AutoDelta status.

PCR reaction components that consist of two primers designed to amplify the target
and SYBR™ Green dye to facilitate detection of the PCR product.
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system dye Dye supplied by Thermo Fisher Scientific and precalibrated on the ViiA™ 7 System.

Before you use system dyes in your experiments, make sure the system dye
calibration is current in the Instrument Console.
The system dyes are:

e FAM" dye

* JOE" dye

* ROX"dye

* NED" dye

e SYBR" Green dye

e TAMRA" dye

e VIC" dye
Taql\/lanTM PCR reactTiMon components that consist of primers designed to amplify the target and
reagents a TagMan ~ probe designed to detect amplification of the target.
target The nucleic acid sequence to amplify and detect.
target color In the software, a color assigned to a target to identify the target in the plate layout

and analysis plots.

task In the software, the type of reaction performed in the well for the target or SNP assay.
Available tasks:

* Unknown

* Negative Control

e Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

* |PC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

technical Wells containing identical reaction components, including sample; important for
replicates evaluating precision.

temperature p|ot In the software, a display of temperatures for the instrument cover and instrument
block during the instrument run.

temp|ate The type of nucleic acid to add to the PCR reaction.

temp|ate file A user-created file that contains experiment setup information (experiment type,
sample names, target name, and thermal conditions) to be used as a starting point
for new experiment setup. Template files have an EDT extension.
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Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the instrument run.

* |n amplification plots, the level of fluorescence above the baseline and within the
exponential growth region. For the Baseline Threshold algorithm, the threshold
can be determined automatically or can be set manually.

* In presence/absence experiments, the level of fluorescence above which the
software assigns a presence call.

The PCR cycle number at which the fluorescence meets the “threshold” on page 235
in the “amplification plot” on page 223.

Instrument display that you touch to control the instrument.

Type of calibration in which the software measures sample block uniformity. The
calibration generates data that compensate for the physical effects of the ViiA™ 7
System filters on data collected during an experiment.

In the software, the task for the target or SNP assay in wells that contain the sample
being tested. In quantification experiments, the task for the target in wells that
contain a sample with unknown target quantities. In genotyping experiments, the task
for the SNP assay in wells that contain a sample with an unknown genotype. In
presence/absence experiments, the task for the target in wells that contain a sample
in which the presence of the target is not known. In melt curve experiments, the task
for the target in wells that contain a sample with an unknown melt curve profile.

In the standard curve, the value of y where the regression line crosses the y-axis. The
y-intercept indicates the expected threshold cycle (C;) for a sample with quantity
equal to 1.
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